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1

Introduction

This document covers the Thermo Scientific™ Insight Pro™ software for running our 
Evolution™ Series UV-Visible spectrophotometers, including operation, biological 
applications, data security, and performance verification.

Overview

The Evolution UV-visible spectrophotometers integrate advanced hardware features with the 
power and flexibility of a wide range of Smart Accessories™. This group of spectrophotometers 
includes:

• Evolution One Series

• Evolution Pro

All instrument models include our Insight Pro software for data collection and analysis. The 
software recognizes which instrument model is connected to the instrument computer and 
displays only the software features and options that are available for that instrument. For a list 
of sampling and other accessories available for these instruments, see the Accessories section of 
the documentation media.

The Insight Pro software provides five modes of operation:

• Fixed, to measure the light passing through the sample at one or more wavelengths.

• Scan, to measure the light that passes through the sample over a range of wavelengths.

• Quant, to set up and perform quantitative analyses of sample data.

• Live Display, for quick measurements and simplified data collections in Fixed or 
Scan mode.

• Kinetics, used to make time-based kinetic measurements on samples for continuous 
absorbance monitoring at user-defined intervals.
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Setting Up the Instrument

All Evolution spectrophotometers can be run from a Windows®-compatible computer 
connected to the instrument.

About This Document

Organization

This document has the following main sections:

Conventions Used in this Document

Note  Spectrophotometers contain precise optical components. Handle your instrument 
carefully. Before using the system, review the Site Preparation and Safety information and 
operating precautions.

Section Description

Introduction Overview of the instrument and this document plus 
information about registering your instrument, contacting us, 
and the system warranty.

Insight Pro Software Complete instructions for using software features other than 
biological applications and Performance Verification (see below).

Insight Pro Bio 
Applications

Instructions for customizing and using the Bio applications for 
measuring biological macromolecules including nucleic acids 
and proteins.

Performance Verification Instructions for setting up and running tests to check the 
performance of the instrument.

Security Optional software that adds features for digitally signing files 
and verifying digital signatures.

CAUTION  Indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury.

NOTICE    Follow instructions with this label to avoid damaging the system hardware or 
losing data.

Note  Contains helpful supplementary information.

Tip  Provides helpful information that can make a task easier.
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2

Insight Pro Software

There are two default views of the Insight Pro window (the Home page):

The Insight Pro Window - Classic View
The Insight Pro Window - Bio Methods

The Insight Pro Window - Classic View
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Applications
These are available in the Classic View of the Insight Pro window.

Fixed

Scan

Quant

Live Display

The Fixed application measures the light passing through the 
sample at one or more wavelengths. To work with this application, 
click Fixed in the Insight Pro Classic Window.

The Scan application measures the light that passes through the 
sample over a range of wavelengths. To work with this application, 
click Scan in the Insight Pro Classic Window.

Use the Quant application to set up and perform quantitative 
analyses of sample data for Fixed or Scan applications. To work 
with this application, click Quant in the Insight Pro Classic 
Window.

Use the Live Display application for quick measurements and 
simplified data collections in Fixed or Scan mode. To work with 
this application, click Live Display in the Insight Pro Classic 
Window.
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Kinetics

The Insight Pro Window - Bio Methods

Use the Kinetics application to make time- and temperature-based 
kinetics measurements. To work with this application, click 
Kinetics in the Insight Pro Classic Window.
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Insight Pro Window - Bottom Ribbon

The bottom ribbon is the same in Classic and Bio Methods view.

Settings Page

Clicking on an Application icon opens the settings page containing parameters for that 
application. Live Display opens directly without a settings screen. The settings screen can also 
be opened from the application display screen by clicking .

Feature Description

Experiment parameters can be saved as templates for later use. 
To use a template, double click it's row in the templates table.

Stores records of experiments you have run. To access the data 
from a past experiment, double click its row in the history table.

Run performance verification tests from Thermo Scientific, 
USP 2019, and EP lists. 
If the Evolution Pro instrument is used, there are additional 
performance verification tests available from the JP list.

Perform wavelength and accessory calibrations, as well as 
beam alignment.

The Settings feature on the Insight Pro window includes 
Applications, Reports, Preferences, Data, and Formulas & 
Units. Formulas & Units include Default Formulas, Default 
Units, and Custom Calibration Equations.

Launches the Insight Pro User Guide.

Feature Description

Settings for calculating additional results, overlaying data, 
and beam reflection correction.

Data mode, integration time, bandwidth,  reference 
wavelength correction, and other instrument settings.
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Settings for accessories, such as a temperature controller.

Define the number of samples in a sample group, create new 
sample groups, set a correction factor, and more.

Available in Scan only. Settings for finding peaks, such as 
search sensitivity, maximum number of peaks, and 
wavelength range.

Available in Quant only. Define what type of standard curve 
to create, or run a single standard.

Available in Quant only. Define the standards for a run, 
including concentrations and replicates.

Cancels operation.

Resets to default values.

Continues to Application.

The Kebab Menu (three vertical dots) opens Save Settings as 
Template option:

Feature Description
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Application Window

The Application window contains features for the current applications.

Action Buttons

These buttons appear at the top of the Application window:

App Button Description

All Apps Measures the blank for the application.

Starts sample data acquisition, displaying prompts for 
confirming samples information, loading samples, saving data 
or performing other actions. Available only after a blank 
measurement for some applications. May measure single or 
multiple samples, depending on the application settings.

Stops data acquisition.

Opens the Settings screen for the selected App.

Defines settings for peak picking and value 
level crossings.
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Other Application Features

Calculate Rate Constants- Calculates rate 
constants automatically at the end of the 
experiment. See the Rate Calculations tab in 
Settings 

Calculate Rate- Enter the starting and ending 
times of the rate vector, the rate scaling factor, 
and the order of the reaction.

Displays the Data as a curve.

Displays the Standard Curve(s).

The Run Chart plots the concentration of the 
measured component versus sample number.

App Button Description

Feature Description

Overlay data To overlay spectrum hold down Shift or Ctrl and select multiple spectra 
(or sample points). Available for Fixed and Scan applications only.

Format Cells Right click a cell and select Format Cell to select the number of decimal 
places that are displayed in the spreadsheet.

Advanced 
Calculations

For selecting predefined formulas for additional data processing, with the 
results appearing in a calculations table at the bottom of the right pane. 
Options include basic math and statistics. The formulas can be applied 
to specific samples and columns of data in the sample measurements 
table or to selected rows and columns in the calculations table for the 
current experiment or template. Calculations are applied to all 
subsequently acquired data. Custom calculations are saved with the 
experiment or template. Available for all applications except DNA 
Melting.

To import data from a .xlsx file, select Import from the  menu.
Note that only the first sheet from the .xlsx file will be imported.
The following .xlsx objects are not supported and will not be imported: 
3D Charts, Shapes, Images, Charts, and Symbols.

To delete the contents of a cell in the calculations table, right-click the 
cell and choose Delete.
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Advanced 
Calculations 
(continued)

To define calculations based on the samples table

1. Click  (the Advanced Calculation icon).

2. The Data tab displays the same columns and data shown on the 
Measurements tab. Changes made to selected columns on the 
Measurements tab are reflected in the Data tab. Any additional 
sample measurements will be added to the Data tab as well. All data 
displayed in the Data tab are read-only, and cannot be edited.

3. To copy data, select the desired cells and press CTRL+C, or right 
click the area and select Copy.

4. To paste data into the Calculation tab, select the desired cells and 
press CTRL+V, or right click the area and select Paste.

5. To access the Function Wizard, select a cell and click the fx button. 
The Function Wizard dialog will appear. Supported formulas will be 
displayed.

6. Select the desired formula. A text field will appear to the right of the 
fx button with the selected formula entered. To specify a data range, 
input a colon and cell range (e.g., A2:A5 or A1:AN) or commas for 
individual cells (e.g., A1,A3,A5). Please refer to the description of 
each formula.

Feature Description
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Configuring the Insight Pro Window

The Insight Pro Window can be configured to display the application buttons you use most 
frequently. Select Edit Custom Groups from the menu button in the upper right of the 
Insight Pro Window.

Controls will appear, allowing you to name a custom group and select which applications to 
include in the group.
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Data Display

All data acquired with the current experiment are listed in the sample measurements table. To 
view data, click the sample ID in the table. To display data from multiple samples as they are 
measured, select Overlay data in the navigation pane.

The sample IDs appear at the top of the data display, with the selected spectrum (or sample 
points) and sample ID. To turn off the sample IDs, click  on the right side of sample ID in 
the top data display.

To enlarge a region, select the Selection tool from the view finder, draw a box around the 
desired region, and click inside the box. Click  to reveal the view finder which contains 
several tools for manipulating the displayed spectrum. Which tools appear depends on the 
application being used.

If the results table is closed, click  to open it. Click  to close.

To expand the data display vertically, drag .

Sample ID

Drag to expand vertically
(Five gray dots)

Click to use view finderSample measurements table

Results table

Close results table
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The Sample ID readout at the right of the display shows the name of the sample being 
measured (or to be measured). The results table below the Sample ID shows the results of 
analysis operations (Peak Pick and Value Level Crossings for Scan data) and whether sample 
points fall within specified control limits (for Fixed data).

Right-click the display to access these features (if available for the current data type):

Feature Description

Copy To Clipboard Copies the plotted data as it is currently displayed to the 
Windows® Clipboard.

Autoscale Adjusts the vertical scale of each spectrum for optimal viewing. 
Double-clicking the display has the same effect.

Set Scale For setting minimum and maximum values for the axes. To set 
them automatically, select Autoscale.

Auto Arrange Labels Positions labels for easier reading.

Sample Legend Specifies whether to display sample IDs near the upper-left corner 
of the pane.

Sample Labels Specifies whether to display spectra with annotations (see 
“Annotate” below) and labels, such as those showing absorbance 
values for specific wavelengths.

Line Type Specifies whether to display scan spectra using solid lines or 
individual data points.
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Annotate Provides features for adding annotation to displayed data. (Added 
annotation is displayed only for the selected data.) See Working 
With Labels for information about manipulating added labels. 
Right-click an edge of an added ellipse, rectangle or image to access 
ways to manipulate or delete the object. The availability of features 
depends on the current application.

More:

Attach to Curve displays the X value of the pointer location as a 
label attached to a scan spectrum by a line.

Free Standing Text adds an editable label at the pointer location. 
Its position is not affected by zooming in and out.

Ellipse draws an ellipse. To move it, drag its top edge. To resize it, 
drag a side or bottom edge. Its position, size and shape are affected 
by zooming in and out.

Rectangle draws a rectangle. To move it, drag its top edge. To 
resize it, drag a side or bottom edge or a corner. Its position, size 
and shape are affected by zooming in and out.

Image displays a dialog box for locating and selecting an image to 
add to the display. To move the image, drag its top edge. To resize 
it, drag the bottom edge or a corner. Its position and size are 
affected by zooming in and out.

Floating Image works the same as Image (see above), except the 
image position and size are not affected by zooming.

Tool Value displays the measurement made by the Peak/valley 
measurement tool or peak area tool as a label attached to the 
spectrum by a line.

Feature Description
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Working With Labels

Some operations place labels on the displayed data. Here is an example:

To show or hide labels

Right-click the pane, point to Sample Labels and choose ON or OFF.

To move a label

Drag it to the new position.

More Display Options 
(Fixed only)

Specifies how to display fixed sample data and control limits:

Connect points (in Spectrum) draws connecting lines between 
sample points.

Show annotations displays X and Y values of sample points.

Show X grid draws light vertical lines through sample points, 
making it easier to see their X values.

Show Y grid draws light horizontal lines through sample points, 
making it easier to see their Y values.

If Use control limits is selected on the Instrument Tab for Fixed, 
Show limit lines displays the control limit lines for each measured 
wavelength.

Feature Description
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To rotate a label

Right-click it, point to Rotate and choose an orientation.

To move a label in front of or behind annotation

Right-click it and choose Send to Front or Send to Back. Click here for information about 
adding annotation.

Measuring Samples

Each application (except Live Display) opens to a settings screen, from which various 
parameters for the sample run can be changed. Click the Continue button to proceed to the 
Display screen, from which the samples, and blank, can be run (see Action Buttons). The 
settings screen can be opened again from the Display screen by clicking the  icon.

See Setting Application Parameters for information about setting parameters that affect data 
acquisition, including those for controlling sampling accessories. For information about 
sampling accessories for the Evolution Series instruments, refer to the user guide for the 
accessory.

Measurement Results 

Below the data display in some applications is a table of sample measurement results. To 
display a spectrum, click its row in the table.

To measure data again, simply re-run the sample group in the Fixed or Scan application.

Data are automatically stored as an experiment in a designated folder with digital 
signature authentication.

Any Peak Pick or Value Level results appear in the results table to the right of the data display.

Instrument Status Monitors

To view, print, or export a report, click  at the top of the Display 
screen, then click the Report icon in the resulting dialog box. If you are 
using a security version, a screen will appear to sign. Once the signature 
is verified the screen will confirm a successful login. Click OK.

Various instrument status monitors may appear above the data 
display. They show information such as the current wavelength or 
readouts from installed accessories. You can double-click some status 
monitors to set operation parameters such as channel assignment.
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Thermo Software IQ
Thermo Software IQ performs Installation Qualification (IQ) for the software. IQ verifies 
that the correct software files were installed and can also be used to verify that these files have 
not been changed, deleted, or overwritten since they were installed. (For more information, 
see the Thermo Software IQ user guide available through the Help menu of the software.)

To start Thermo Software IQ

1. Click Start on the Windows taskbar.

2. Choose All Programs (or Programs) > Thermo > Thermo Software IQ.

Update installer to support database

1. Update Insight Pro software to version 2.6.

2. Import password management to encrypt the database account.

Saving new data or loading existing data as an experiment, templates, PV report, samples, 
and standards requires digital signature to verify authenticity.

3. Add a prerequisite to install and configure the database.

To specify the items to monitor, click this icon.

If the system is operating normally, a green check mark appears on the Instrument 
Status icon at the bottom of the Insight Pro window.

Gray dots appear briefly on the icon when the system is busy performing an 
operation.

If a system problem occurs, a red exclamation mark may appear on the icon. 
Click it to see information about the problem.
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Operation

Acquiring Data using Live Display

Use Live Display for quick measurements and simplified data collections in Fixed or Scan 
mode. The data can be displayed in absorbance or % transmittance units. The results can be 
stored in a temporary location and printed on demand.

These features are available in Live Display:

Feature Description

Selects the absorbance display mode.

Data currently displayed in % transmittance are changed to absorbance.

Selects the % transmittance display mode.

Data currently displayed in % transmittance are changed to absorbance.

Selects the single wavelength data acquisition mode for the next 
measurement.

Use the right and left arrows in the lower left of the screen to select 
the wavelength. 

Selects the full scan data acquisition mode for the next measurement.

Use the left set of right and left arrows at the bottom of the screen to 
select the starting wavelength for the scan; use the right set of arrows to 
select the ending wavelength.

Records the currently displayed measurement in the computer’s internal 
memory. Data from subsequent measurements are appended. The 
memory location is cleared automatically when you exit Live Display (or 
choose Clear).

Pressing Store while in Fixed mode stores the measurement result along 
with the wavelength used and the display mode settings (Abs or %T).

Pressing Store while in Scan mode stores a snapshot of the spectrum. If 
the spectral cursor tool is selected, it also stores the current X and Y 
coordinates of the cross hair. 

Clears all information from Live Display’s associated memory location 
for storing analysis results. See Store.
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Note  Insight Pro Security softwares requires you to save data each time you collect it as a part 
of data integrity enforcement measures. When running Insight Pro Security, you cannot 
disable this feature, and you will be prompted to save regularly. Select OK to accept the 
default filenames when prompted to save. Enter the digital signature to authenticate new data 
stored after every measurement, or when importing existing data as an experiment, template, 
or PV report to or from the database.

Starts sample data acquisition with Live Display. Available only after a 
blank measurement.

Pressing Measure while in Fixed mode collects the data at the selected 
wavelength using a bandwidth of 1 nm and an integration time of 
0.5 sec. After you press Measure, the Measure button is disabled and the 
software automatically takes a measurement every 2 seconds until you 
press Stop or Scan or exit Live Display (or after 5 minutes of inactivity).

Pressing Measure while in Scan mode collects data at all wavelengths 
between the designated starting and ending wavelength using a 
bandwidth of 1 nm, an integration time of 0.05 sec, and a data interval 
of 1.00 nm. The selection and spectral cursor tools are available in Scan 
mode.

Measures the blank for the selected application (Fixed or Scan).

Stops data acquisition.

Prints a copy of the information from Live Display’s associated 
temporary results file using the default printer. Available whenever stored 
measurements exist. See Store.

The selection tool is available in Scan mode only, by clicking the View 
Finder icon. Use it to zoom in the spectrum. To zoom in, draw a box and 
click inside it. (Double-click anywhere in the data display to zoom out.)

The spectral cursor tool is available in Scan mode only, by clicking the 
View Finder icon. Use it to view the X and Y values of a point in 
a spectrum.

To view the X and Y values of a point, select the spectral cursor tool and 
click the data display. Cross hairs appear. The X and Y coordinates of 
their intersection with the spectrum appear below the data pane. To 
move the cross hairs, drag across the pane or use the left and right arrow 
keys on the keyboard.

Feature Description
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Performing Fixed Measurements

Fixed measurements are based on the selected experiment. Measurements can be appended to 
an opened experiment or saved in a new experiment.

1. From the Insight Pro Classic Window, click Fixed.

2. A settings screen will appear (see Settings for Fixed Applications). After configuring the 
sample run with the desired settings, click the Continue button.

3. Load a blank into the instrument, then click the  button to measure it.

4. Once the blank is measured, the  will become available. Click it to run the 
first sample.

More:

If Sample averaging in the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

5. Follow any instructions that appear, such as to install a specified sample.

The Data Display shows the acquired data (a fixed data point) for the sample selected in 
the table. (Right-click the data to access commands for customizing the display, including 
adding annotation.)

The table contains the columns of information specified in Reports. Examples include 
sample identification, user name, and the results of replicate, duplicate or triplicate 
measurements and their average values.

To measure data again, click the Samples tab in the Fixed or Scan application. Select the 
sample group and follow the measurement procedure.

Note  Change Fixed experiment settings as desired before making sample measurements. 
All Fixed measurements are saved in an experiment that includes the data acquisition 
settings. See Setting Application Parameters for information about unlocking settings.

Note  Run settings can be changed later, from the Display screen.
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Performing Scan Measurements

Scan measurements can be appended to an opened experiment or saved in a new experiment.

To perform a scan measurement

1. From the Insight Pro Classic Window, click Scan.

2. The settings page will appear. Change the settings as desired. Settings can be accessed later 
by clicking .

3. Click Continue.

4. Load a sample blank to measure the baseline.

5. Click . After the blank has been acquired, the  button will become active.

6. Place the first sample into the instrument, and click  to measure the sample.

See Manage samples during measurement.

The Data Display shows the acquired data (a scan spectrum) for the sample selected in 
the table. (Right-click the data to access commands for customizing the display, including 
adding annotation.)

The table contains the columns of information specified in Reports. Examples include 
sample identification, user name, date and time, and integration time.
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Performing a Quantitative Analysis

Quantifying Samples Without Using Standards

Follow steps in the database support section. Omit step 6 (procedure for 
measuring standards).

1. From the Insight Pro Classic Window, click Quant. The settings page will appear. Change 
the settings as desired. Settings can be accessed later, using .

2. Load the sample to use to measure the blank.

3. Click .

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

Follow step 4 from the database support section.

4. If only one sample will be measured, install it.

5. Click .

6. Follow any instructions that appear, such as to install a specified sample.

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use control limits was selected on the Samples tab, horizontal limit lines 
show whether the concentrations are within the specified limits:

To copy this plot, right-click and choose Copy to Clipboard.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation.) See Data Display for more information.



 2 Insight Pro Software
Operation

Thermo Scientific Insight Pro Software User Guide 29

The table contains the columns of information specified in Reports. Examples include 
sample identification, user name, and the results of replicate, duplicate or triplicate 
measurements and their standard deviation.

To measure a sample again, right-click its row in the sample measurements table and 
choose Remeasure (if available).

Quantifying Samples Using Standards

To quantify samples using standards

1. From the Insight Pro Classic Window, click Quant. The settings page will appear. Change 
the settings as desired. Settings can be accessed later, using .

2. Click Continue.

3. Place a blank solution into the instrument, and click  to run it. After the blank has 
been acquired,  will become active.

More:

If Standard averaging on the Standards tab in Settings was set to Duplicate, “D” at the 
end of a standard name in the Confirm Standards List box indicates the second 
measurement to be made of the standard. If Sample averaging was set to Triplicate, “D” 
and “T” at the end of standard names indicate the second and third measurements to be 
made, respectively.

See Manage standards during measurement for more information on use of standards. 

If Calculate from weight/volume was selected on the Standards tab, enter the weight and 
volume for each standard in the table.

The Standard Curve(s) tab displays the resulting standard curve (or curves). Specify the 
standards to use for the curve (or curves) by selecting Yes or No in the Use column in the 
table. These selections can always be changed. After each change, the standard curve is 
updated automatically.

Note  Select Measure single standard, Standard curve, Standard curve with two 
wavelengths or Advanced standard curve on the Type tab for this procedure.



2 Insight Pro Software
Operation

30 Insight Pro Software User Guide Thermo Scientific

More:

The table contains the columns of information specified in Reports. Examples include 
sample identification, user name, and the results of replicate, duplicate or triplicate 
measurements and their standard deviation.

You can choose to not use a standard in the standard curve by un-checking the Use 
Standard check box. A blue check mark indicates whether or not the standard will be 
used in the curve.

To permanently remove an acquired standard from the analysis, right-click it and choose 
Delete selected samples. Its information is crossed out but not removed from the table.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
standard selected in the table. To access commands for customizing the display, including 
adding annotation, right-click the data. See Data Display for more information.

4. Click 

5. Follow the instructions that appear. The instructions that appear are dependent on the 
current settings for the features on the Samples tab in Settings.

6. When samples information appears, modify it if desired.

More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end 
of a sample name in the Confirm Sample List box indicates the second measurement to 
be made of the sample. If Sample averaging was set to Triplicate, “D” and “T” at the end 
of sample names indicate the second and third measurements to be made, respectively.

Follow step 4 from the database support section.

The sample measurements table contains the columns of information specified on the 
Reportable Data tab in Reports. If Sample averaging was set to Duplicate, “D” at the end 
of a sample name indicates the second measurement. If Sample averaging was set to 
Triplicate, “D” and “T” indicate the second and third measurements, respectively.

If you receive a prompt that states that the standard curve is not valid, 
try...

• Selecting a different curve fit type.

• Remeasuring a standard using the correct standard material (select 
the listed standard, right-click the table and choose Remeasure).

• Changing the setting of Minimum r2 on the Standards tab and 
acquire the standards again in a new experiment.

Note  After a calibration curve is used to measure a sample, the curve can no longer be 
edited. However, you can open a new experiment based on the existing calibration 
data and then edit the curve before you begin acquiring new sample data.
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The Standard Curve(s) tab shows graphically the relationship between the standard curve, 
measured spectral intensity and calculated concentration for the selected sample: A 
horizontal line connects the sample spectral intensity value on the Y-axis to the standard 

curve. A vertical line connects that point to the sample concentration value on the X-axis. 
The information at the top shows the measured wavelength, the equation for the standard 
curve and the calculated r2 value, which indicates how well the standard curve fits the 
standard data points (1.0 is a perfect fit).

The Run Chart tab plots the concentration of the measured component versus sample 
number. (If there are two analysis wavelengths, the concentration value is the average of 
the values for those wavelengths.) If Use control limits was selected on the Samples tab, 
horizontal limit lines show whether the concentrations are within the specified limits:

To measure a sample again, right-click its row in the sample measurements table and 
choose Remeasure (if available).

To copy the data on the Standard Curve(s) tab or Run Chart tab, right-click the plot and 
choose Copy to Clipboard.

Note  If there are two analysis wavelengths, the lines appear for each of the two 
standard curves.
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Performing a Kinetics Measurement

Performing a Fixed-Rate Measurement 

Kinetics measurements can be made at one wavelength or at up to 40 wavelengths in the same 
experiment. This includes multicell measurements, which allows running a fixed-wavelength 
measurement on several samples simultaneously using a sample changer. 

Measurements are taken at specified intervals of time. Temperature-based measurements also 
record temperature and control the temperature setting and ramp rate for the duration of the 
experiment. Multiple stages can be programmed for time and temperature-based 
measurements.

The Time Status icon automatically appears above the data display during kinetics 
measurements.

To perform a fixed-rate measurement

1. Make sure Single wavelength or Multiple wavelength is selected on the Type Tab for 
Kinetics in Settings.

2. Click Continue.

3. Load the sample to use to measure the zero or blank.

4. Click .

5. Click .

If necessary, the  button can be used to remeasure the zero sample.

6. When samples information appears, modify it if desired.

See Manage samples during measurement. 

Enter values in any special columns that were specified on the Samples tab in Settings. 
These values may appear in the kinetics data report.

7. Click Continue.
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8. Follow the instructions that appear.

Each row in the sample measurements table on the Data tab shows the measurement 
results for one sample measured at a specified wavelength. Each plot on the tab shows a 
sample’s spectral intensity measured at a particular wavelength over time.

To extend the collection time for the current sample measurement (without interrupting 
the data collection), click  and enter the amount of time to extend the measurement. 
If you are collecting data in multiple stages, only the current stage is affected.

Scroll bars are provided if plots are out of view.

Right-click within the spectrum window to access features for changing the scale or 
adding annotation. See Data Display for more information.

The sample measurements table contains the columns of information specified in the 
Reported Columns pane of the Reportable Data tab in Reports.
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9. To perform rate calculations or modify existing rate calculations on the data in a plot, 
double-click it or select Analyze (menu) < Modify Rate Curve.

Modifying a Rate Curve 

Time-based single and multiple wavelength rate measurements can include a rate curve. To 
specify rate calculations, set up a fixed rate experiment and then select the Rate Calculations 
tab in Settings.

If Calculate rate constants automatically at end of data acquisition is selected on the Rate 
Calculations tab, after data collection completes, the rate calculations will appear in the 
sample measurements table along with the other sample data. To perform rate calculations or 
modify existing rate calculations on the data in a plot, double-click it or select Analyze > 
Modify Rate Curve. A window displays the plot and a table containing the default rate 
calculation values based on the Rate Calculations tab.

These operations are available from the Modify Rate Curve window.

• If desired, add or change sets of rate calculation values for the displayed data. Each set 
represents a curve that describes the rate behavior over the specified time period.

To delete a row from the table, right-click it and choose Delete Selected Row. To delete 
all the information from the table, right-click it and choose Clear Table.

• If desired, use the vertical markers on the rate curve to adjust the data range used for 
rate calculations.

Note  The features to set up rate calculations are available for time-based single and 
multiple wavelength rate measurements only. To calculate rate curves for 
temperature-based data (temperature and time are recorded), display the data with 
time on the X-axis and then double-click the data display or select Analyze < 
Modifying a Rate Curve.

Note  To calculate rate curves for temperature-based data (temperature and time are 
recorded), display the data with time on the X-axis and then double-click the data 
display or select Analyze (menu) < Modifying a Rate Curve.
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• Click Update to generate kinetic rate models, each of which appears as a line across 
the data.

Specify how to apply the lines and then click Accept.

The window closes, the lines appear across the specified plots, and the sample 
measurements table is updated with information about the model lines.

Performing a Scanning Rate Measurement

Rate measurements can be made on several samples simultaneously using a sample changer or 
run in a sequential, manual mode.

To perform a scanning Rate measurement

1. Make sure Scan data acquisition is selected on the Type tab in Settings in Kinetics.

2. Click Continue.

3. Load the sample to use to measure the zero.

4. Click .

5. Click .

6. If necessary, the  button can be used to remeasure the zero sample.

7. When samples information appears, modify it if desired.

See Manage baseline correction groups and Manage baseline correction groups. 

Enter values in any special columns that were specified on the Samples tab in Settings. 
These values may appear in the rate data report.

This option... Applies the lines to...

Selected plot only The selected data only.

All plots with this wavelength only All plots for the current wavelength.

All plots All plots.
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8. Click Continue.

9. Follow the instructions that appear.

Each grid on the Data tab displays all the spectra acquired for a particular sample.

A scroll bar is provided if spectra are out of view.

Right-click within the spectrum window to access features for changing the scale or 
adding annotation. See Data Display for more information.

A sample measurements table appears below the spectra.
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Adding Custom Calculations

Calculations can be applied to the results from individual samples or standards, results from a 
group of samples, or between two or more sample results. Depending on your needs, use this 
table as a guide to the appropriate feature for adding custom calculations.

This feature... Located here... Allows you to...

Use correction 
factor

Samples tab Specify a multiplication factor for each sample 
result. Can be used to correct for sample properties 
and preparation steps such as a sample dilution that 
affects the measured result.

The correction factors and corrected results are 
displayed in the sample measurements table. If a 
report is generated that includes the samples table, 
the report will also include the correction factors and 
corrected results.

Standards tab Specify a multiplication factor for each standard. 
The corrected concentration values are used to create 
the calibration curve. Can be used to correct for 
standard properties (percent purity, water content, 
etc.) or preparation steps that affect the measured 
result such as a dilution. Available for Standard 
Curve, Standard Curve With Two Wavelengths, and 
Advanced Standard Curve Quant types only.

The correction factors and corrected concentration 
values are displayed in the standards table. If a report 
is generated that includes information about the 
standards, the report will also include the correction 
factors and corrected concentrations.
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Operations and Functions

The tables below describe the operations and functions usable in equations specified on the 
Measurement tab for Fixed, Scan, and Quant. Arithmetic operations (including functions) are 
performed first, followed by comparison operations, and finally logical operations.

Arithmetic Operations

Calculate 
additional results

Measurement 
tab

Apply pre- or user-defined formulas to all sample 
measurements taken with the experiment or 
template. Available for Fixed, Scan and Quant 
applications only. For descriptions of the operations 
and functions usable in user-defined equations, see 
Operations and Functions.

After the measurement, the calculated values and 
their labels are displayed in the sample 
measurements table below the data display. If a 
report is generated that includes the samples table, 
the report will also include the calculated values and 
labels.

Advanced 
Calculations

Navigation 
pane during a 
measurement

Apply predefined formulas to any measurement 
result or results for any sample or to other 
calculation results. Predefined formulas include 
basic math and statistics. Available for all 
applications except DNA Melting.

The calculated values and any labels that are entered 
are displayed in the calculations table which appears 
below the sample measurements table. If a report is 
generated that includes the calculations table, the 
report will also include the calculated values 
and labels.

This feature... Located here... Allows you to...

Note  The operators, arguments and functions are not case-sensitive.

Operator Description Example Returned by Example Operation

+ Addition 2 + 6 + 4 12

- Subtraction 25 - 4 21

* Multiplication 25 * 4 100

/ Division 25 / 4 6.25

- Negation -4 + 25 21
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Comparison Operations

Logical Operations

The following equation functions produce a value based on one or more arguments you 
supply.

Example Function Arguments

mod Modulo division (returns 
remainder)

16 mod 5 1

& Text addition “abc” & “def” “abcdef”

Operator Description Example Result

>= Greater than or equal (3 + 2) >= 4 true

<= Less than or equal (3 + 2) <= 5 true

=, == Equals (2 + 2) = 4 true

!=, <> Does not equal (2 + 2) != 5 true

< Less than 5 < 4 false

> Greater than 5 > 4 true

true The value “true” (5 > 4) = true true

false The value “false” (5 > 4) = false false

Operator Description Example Result

AND If both sides of the AND are true, result is true 5 > 4 AND 2 = 3 false

OR If either side of the OR is true, result is true 5 > 4 OR 2 = 3 true

Argument Description

<number>, <angle>, <length>, 
<value>, <power>, <start>, <len>

An expression that yields a number.

<list> Any expression that yields a list of numbers.

<text>, <sub> An expression that yields a text.

Operator Description Example Returned by Example Operation
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Arithmetic Functions

Logarithmic Functions

Trigonometric Functions

Function Returned or Performed by Function

abs(<number>) Absolute value of a number.

ceiling(<number>) Smallest integer greater than or equal to <number>. 
Example:

Ceiling(2.2) is 3.0

floor(<number>) Largest integer less than or equal to <number>.
Example:

Floor(2.7) is 2.0

random() Random fractional number between 0 and 1.

round(<number>) Rounds a double value to the nearest integer value.

sqrt(<number>) Square root of a number.

truncate(<number>) Truncated number. Everything to the right of the decimal point 
is removed, leaving only the integer portion of the number. The 
returned value is not rounded.

Function Returned by Function

exp(<number>) Result of the constant e (2.7182818) raised to the power of the 
specified number (e^<number>).

ln(<number>) Natural logarithm (base e logarithm) of a number.

log10(<number>)

log(<number>)

Base 10 logarithm of a specified number.

pow(<value>, <power>) Value raised to the power. Example:

pow(2,3) is 8.0

Note  For functions acos and asin, <number> is an expression that yields a number in the 
range -1 to 1.

Note  The formula for converting degrees to radians is radians = degrees * (pi/180).
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Statistical Functions

Text Functions

Function Returned by Function

acos(<number>) Arccosine of a number in radians.

asin(<number>) Arcsine of a number in radians.

atan(<number>) Arctangent of a number in radians.

atan2(<number1>,<number2>) Arctangent of <number1> divided by <number2> in 
radians. The signs of both arguments are used to 
determine the quadrant of the returned value.

cos(<angle>) Cosine of an angle measured in radians.

cosh(<angle>) Hyperbolic cosine of an angle measured in radians.

pi() Ratio of the circumference of a circle to its diameter.

sin(<angle>) Sine of an angle measured in radians.

sinh(<angle>) Hyperbolic sine of an angle measured in radians.

tan(<angle>) Tangent of an angle measured in radians.

tanh(<angle>) Hyperbolic tangent of an angle measured in radians.

Function Returned by Function

average(<list>) Average of a list of numbers (sum divided by the number of items).

max(<list>) Highest value from two or more numbers.

min(<list>) Lowest value from two or more numbers.

sum(<list>) Sum of a list of numbers.

Std. Dev. Square root of variance, which is determined by taking the average of the 
squared differences of the values from their average value.

% RSD Absolute value of the coefficient of variation expressed as a percentage 
(100*((standard deviation of array X)/(average of array X))).

Function Returned by Function

FindTextIndex(<search>, 
<text>)

Index of the first occurrence of the <search> text in the 
specified text. If the text is not found, a -1 is returned.

Lowercase(<text>) Copy of the text converted to lower case using the casing rules 
of the current culture.

PassFail(<expression>) “Pass” in the language of the current culture if the expression 
evaluates to true; otherwise, “Fail”.
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Measurement Functions

Quote Text containing the quote (“) character.

Return Text containing a carriage return.

TextLength(<text>) Number of characters, including spaces, in the specified text. 
A CRLF is counted as two characters.

ExtractText(<text>, <start>, 
<len>)

Portion of the specified text. The extracted text starts at the 
specified <start> index and has a specified length.

Tab Text containing the tab character.

ToNumber(<text>) Numeric representation of the text.

ToText(<number>) Text representation of the number.

Function Returned or Performed by Function

Y(location) Y-axis value at the given location.

Y(location, baseline) Y-axis value at the given location with a one-point baseline.

Y(location, baseline1, 
baseline2)

Y-axis value at the given location with a two-point baseline.

Area(start, end) Area between two spectral limits.

Area(start, end, baseline) Area between two spectral limits using a one-point baseline.

Area(start, end, 
baseline1, baseline2)

Area between two spectral limits using a two-point baseline.

PMin(start, end) Minimum Y-axis value between two spectral limits.

PMax(start, end) Maximum Y-axis value between two spectral limits.

PMax(start, end, 
baseline)

Corrects the spectrum with a one-point baseline and then report 
the maximum Y-axis value between two spectral limits.

PMax(start, end, 
baseline1, baseline2)

Corrects the spectrum with a two-point baseline and then report 
the maximum Y-axis value between two spectral limits.

PLoc(start, end) Location (X-axis value) at which the maximum Y-axis value 
occurs between two spectral limits.

PLoc(start, end, 
baseline)

Corrects the spectrum with a one-point baseline and then report 
the location (X-axis value) at which the maximum Y-axis value 
occurs between two spectral limits.

PLoc(start, end, 
baseline1, baseline2)

Corrects the spectrum with a two-point baseline and then report 
the location (X-axis value) at which the maximum Y-axis value 
occurs between two spectral limits.

Function Returned by Function
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Using the Palette Tools and View Finder

Using the Selection Tool

Use the selection tool (if present) to zoom in or move the spectrum.

To zoom in, draw a box and click inside it. To move the spectrum, drag it up or down.

Using the Spectral Cursor Tool

Use the spectral cursor tool (if present) to view the X and Y values of a point in a spectrum.

To view the X and Y values of a point

1. Select the spectral cursor tool.

PWidth(start, end, 
percent)

Determines the peak width between two spectral limits. Report 
the width at which the peak reaches a specified percentage of the 
peak maximum.

Pavg(start, end) Determines the average value of the spectrum between two 
spectral limits.

Pcut(start, end, percent) Determines the location (X-axis value) of the cut-on or cut-off 
point in the specified spectral region. For example, for a region 
with increasing Y value, a cut-on point occurs where the increase 
reaches the specified percentage of total increase across the 
region. Here is an example showing a cut-on point with 
“percent” set to 60:

Function Returned or Performed by Function

Note  To display the palette, click .

Note  To display the palette, click .
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2. Click the data display.

Cross hairs appear. The X and Y coordinates of their intersection with the spectrum 
appear below the palette.

To move the cross hairs, drag across the pane or use the left and right arrow keys on the 
keyboard.

To remove the cross hairs from the display, select another tool such as the selection tool.

Using the Peak/Valley Measurement Tool

Use the peak/valley measurement tool (if present) to measure the height of a peak or depth of 
a valley from a specified baseline.

To measure a peak or valley

1. Select the peak/valley measurement tool.

2. Click the data display.

A vertical line appears. The X and Y coordinates of its intersection with the spectrum 
appear below the palette.

3. Drag the line by its diamond-shaped handle to the peak or valley to measure.

4. Drag the triangular baseline handles to the desired baseline endpoints.

The height or depth of the peak or valley appears below the palette.

To annotate the spectrum with the measured value, right-click the spectrum, point to 
Annotate and choose Tool Value. See Working With Labels.

To remove the vertical line and baseline from the display, select another tool such as the 
selection tool.

Using the Peak Area Tool

Use the peak area tool (if present) to measure the corrected area of a peak. This area is 
bordered by the spectrum, two vertical lines and a baseline.

To measure a peak

1. Select the peak area tool.

Note  To display the palette, click .

Note  To display the palette, click .
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2. Click the data display.

Two vertical lines appear (see the illustration below). Their X values define the limits of 
the region to measure and appear in the Region readout.

3. Drag the lines by their triangular handles to the desired locations.

4. Drag the triangular baseline handles (see the illustration below) to the desired baseline 
endpoints.

The X values of the endpoints appear in the Baseline readout. The defined area is shaded, 
and its measurement appears in the Corrected area readout. Here is an example showing 
the region limits and baseline endpoints adjusted to measure the corrected area of a peak:

To annotate the spectrum with the measured area, right-click the spectrum, point to 
Annotate and choose Tool Value. See Working With Labels.

To remove the vertical lines and baseline from the display, select another tool such as the 
selection tool.

Using the Region-Threshold Tool

For data analysis operations such as locating peaks, use the region-threshold tool (if present) 
to limit the wavelength region.

Drag the vertical lines in the data display or drag horizontally between them to move both at 
once.

Note  To display the palette, click .
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Using the View Finder

For data analysis operations such as locating peaks, use the view finder (if present) to adjust 
the data display.

The currently displayed region is indicated by the region markers, the bold vertical lines.

To expand horizontally

To expand vertically

To expand or contract vertically while keeping the top or bottom of spectra in place

To display a different region of the same size

There are three ways to do this: 

• To move the spectrum to the right, click and hold the right arrow of the X axis button.

To roll to the left, click and hold the left arrow.

To change the display limits by moving the region markers

Drag a region marker left or right.

To display the entire spectrum 

Click the center button of either the X axis or Y axis button.

Note  To display the view finder, click .

Click and hold the top arrow of the X axis button. To contract 
horizontally, click and hold the bottom arrow.

Click and hold the top arrow of the Y axis button. To contract vertically, 
click and hold the bottom arrow.

To expand vertically while keeping the bottom of the spectra in place, 
click and hold the left arrow of the Y axis button.

To contract vertically while keeping the bottom of the spectra in place, 
click and hold the right arrow of the Y axis button.
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Setting Application Parameters

The tabs (and their features) depend on the application.

Settings for Fixed Applications

The follow tabs of settings are available:
Measurement Tab for Fixed
Instrument Tab for Fixed
Accessories Tab for Fixed
Samples Tab for Fixed

Change Fixed experiment settings as desired before making sample measurements. All Fixed 
measurements are saved in an experiment that includes the data acquisition settings.

Measurement Tab for Fixed

These settings are available:

To set parameters that determine how data will be acquired or quantified with the 
current application, click the settings icon.

To set data acquisition parameters for a Fixed experiment, click the settings icon.

Click the settings icon in Fixed to display the Measurement tab.

Feature Description

Name (if present) User group name followed by the name of the template of settings.
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Instrument Tab for Fixed

Description 
(optional)

Optional description of the template.

Calculate 
Additional Results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. (See “Operations and 
Functions” for definitions.) All functions are not case-sensitive. 
Spaces are not allowed between a function name and “(”. After adding 
formulas, edit their information in the formula table as desired. To 
delete a table row, right-click it and choose Delete Row. Some 
information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

Select a formula from the preset list, then click the Use for 
Additional Results button.

Hold down the Ctrl or Shift keys on the keyboard while making 
multiple selections. The available formulas depend on the Formulas 
& Units tab settings in Options.

To define a formula

1. Click the Equation Builder tab.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it from the drop-down menu and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click the Use for Additional Results button.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available formulas depend on the Formulas & Units tab 
settings.

Click the settings icon in Fixed to display the Instrument tab.

Feature Description
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These settings are available:

Feature Description

Data mode Y-axis format for acquired data. Available options include 
Absorbance, % Transmittance, % Reflectance, Log(1/R) and 
Log(Abs).

Integration time How long the system acquires and averages data at each measured 
wavelength. Increasing the integration time improves the 
signal-to-noise ratio.

Bandwidth Depending on the type of instrument used, the available options 
may include:

• Numerical bandwidth options. Available bandwidth options 
depend on the instrument model. A larger spectral bandwidth 
increases the amount of energy that passes through the sample. 
Increasing the bandwidth can improve the signal-to-noise 
ratio; however, a larger spectral bandwidth decreases the ability 
to resolve closely spaced spectral features.

• Materials, Fiber and Micro. These AFBG (Application 
Focused Beam Geometry) options match the optical 
configuration to the application for optimized use of 
associated accessories.

• Blocked. Blocks the beam completely.
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Result Mode Determines how results are calculated and displayed:

Normal displays the results in the units specified in the Data mode 
setting (see above).

Peak Height calculates the peak height with respect to a sloping 
baseline defined by two wavelengths adjacent to the center peak:

The lowest of the three measured wavelengths defines the start of 
the sloping baseline, the middle wavelength defines the peak 
location, and the highest wavelength defines the end point of the 
sloping baseline.

Wavelength 1 + Wavelength 2 adds the Y values at the two 
measured wavelengths.

Wavelength 1 - Wavelength 2 subtracts the Y value at the second 
measured wavelength from the Y value at the first.

Wavelength 1 * Wavelength 2 multiplies the Y value at the second 
measured wavelength times the Y value at the first.

Wavelength 1 / Wavelength 2 divides the Y value at the first 
measured wavelength by the Y value at the second.

Reference Wavelength 
Correction

If available and selected, subtracts the background intensity at the 
specified reference wavelength from the sample intensity at all 
measured wavelengths. The reference wavelength value appears in 
red in the Wavelength Summary table.

Feature Description
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Accessories Tab for Fixed

The status of accessories can be monitored during measurements.

Samples Tab for Fixed

Wavelength Summary Wavelengths at which measurements will be made, plus the 
corresponding control limits if specified (see above). The number 
of required wavelengths depends on the setting of Result mode (see 
above). To enter or change the value in a table cell, click it and 
type. To order the list by wavelength, lower control limit or upper 
control limit, click the appropriate column heading.

Use Control Limits If available and selected, specifies control limits for each 
wavelength in the table. Enter the desired upper and lower limits 
for each wavelength in the table, using the appropriate unit for the 
selected data mode.

When the measurement is completed, the limits are listed in the 
table to the right of the display. Limit lines can also be added to the 
data display by right-clicking in the display area, choosing More 
Display Options, and selecting Show Limit Lines. The lines 
indicate whether each measured data point is within specifications.

Click the settings icon in Fixed to display the Accessories tab. The available 
parameters depend on the installed accessories.

Click the settings icon in Fixed to display the Samples tab.

Feature Description
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These settings are available:

Settings for Scan Applications

Feature Description

Samples Group Lists samples by their names and descriptions, up to a maximum 
of 1000. To change a sample name, click its cell and edit the text. 
To enter or change text in a table cell, click it and type. To order 
the list by sample name or description, click the appropriate 
column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Click the  icon to load a previously saved sample group.

Base Name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample 
spectra using the base name “dye” would be dye1, dye2 and 
dye3.

Samples Number of samples for the experiment.

Averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select 
Replicate and set Number of replicates to the total number of 
measurements. To average values from two or three different 
samples, select Duplicate or Triplicate, respectively.

Use Correction Factor If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the 
measured result. Enter the desired factor for each sample in the 
table, or click the toggle for Apply Factor to All Samples.

Samples Table From the Samples tab, enter the number of samples to be 
measured, including names and descriptions. Up to1,000 
samples can be entered. Samples can also be loaded from a 
Microsoft Excel spreadsheet.

To set data acquisition parameters for a Scan experiment, click the settings icon.
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The follow tabs of settings are available:
Measurement Tab for Scan
Instrument Tab for Scan
Accessories Tab for Scan
Samples Tab for Scan
Peak Pick Tab for Scan

Measurement Tab for Scan

These settings are available:

Click the settings icon in Scan to display the Measurement tab.

Feature Description

Name (if present) User group name followed by the name of the template of settings.

Description 
(optional)

Optional description of the template.
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Calculate 
Additional Results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. (See “Operations and 
Functions” for definitions.) All functions are not case-sensitive. 
Spaces are not allowed between a function name and “(”. After adding 
formulas, edit their information in the formula table as desired. To 
delete a table row, right-click it and choose Delete Row. Some 
information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

Select a formula from the preset list, then click the Use for 
Additional Results button.

Hold down the Ctrl or Shift keys on the keyboard while making 
multiple selections. The available formulas depend on the Formulas 
& Units tab settings in Options.

To define a formula

1. Click the Equation Builder tab.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it from the drop-down menu and enter values for the variables.

The available formulas depend on the Formulas & Units tab 
settings in Options.

3. Click the Use for Additional Results button.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available formulas depend on the Formulas & Units tab 
settings.

Feature Description
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Baseline Correction 
Type

For defining a baseline correction for the raw data. These options are 
available:

• 100%T baseline. Standard baseline correction. The data may be 
acquired using an empty holder or using solvent.

• 0%T or 0%R baseline. Corrects for any inherent variations in 
the electronic zero line of the instrument.

More:

This can be more of a factor at lower light energy levels present in 
a DRA (Diffuse Reflectance Accessory) and when working at 
high absorbance levels.

For more information, see ASTM method E903. The calculation 
in transmission performed in the instrument is:

 or 

Requires a previously acquired 100%T baseline.

• Standard reference correction with 0%R or 0%T baseline. 
Applies a 100%T baseline correction and a zero line correction 
(0%R baseline) to a sample measured with a reflectance accessory 
that is not absolute (for example, a Diffuse Reflectance 
Accessory). Displays a table for entering a correction value for 
each measured wavelength.

More:

The software multiplies the scan result at each data point by the 
corresponding value in the table (explained below). To delete the 
information from the table, click Clear Table.

The calculation in reflectance performed in the instrument is:

Requires a previously acquired 100%T baseline.

Feature Description

S - 0%T
100%T - 0%T
---------------------------------- S - 0%R

100%R - 0%R
-----------------------------------

S - 0%R
100%T - 0%R
---------------------------------- Std. Ref.×
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Select Standard reference correction with 0%R or 0%T baseline to display 
additional features.

Instrument Tab for Scan

These settings are available:

Sphere reflection 
spectra correction

Correct single beam substitution error allows the ratioed spectrum 
acquired with the single-beam sphere to be corrected as if it were 
acquired with a double-beam instrument (where the baseline is 
collected in the integrating sphere). Requires that Data mode on the 
Instrument tab be set to Absorbance, % Transmittance, 
% Reflectance or Log(1/R).

Click the settings icon in Scan to display the Instrument tab.

Feature Description

Data mode Y-axis format for acquired data. Available options include 
Absorbance, % Transmittance, % Reflectance, Kubelka-Munk, 
Log(1/R), Log(Abs), Abs*Factor, and Intensity.

For Abs*Factor, set Factor to a value by which to multiply measured 
absorbance values.

Derivative Select the desired derivative order for acquired data (if available for 
the selected data mode).

Smooth Select the desired degree of smoothing (if available for the selected 
data mode and Derivative setting). Smoothing reduces noise in the 
data but can also remove some spectral features such as small peaks, 
valleys and shoulders. For more information, see About Smoothing.

Start wavelength 
and End wavelength

Starting and ending values of the wavelength range for acquiring data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can improve the 
signal-to-noise ratio; however, a larger spectral bandwidth decreases 
the ability to resolve closely spaced spectral features, especially in 
scanning measurements.

Feature Description
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Accessories Tab for Scan

The status of accessories can be monitored during measurements.

Samples Tab for Scan

These settings are available:

Integration time How long the system acquires and averages data at each data interval. 
Increasing the integration time improves the signal-to-noise ratio but 
reduces the scan speed.

Data interval Difference in wavelength between two consecutive data points.

Scan speed Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time Estimated duration of data acquisition. Increases as integration time 
increases and as the data interval decreases. Varies inversely with scan 
speed.

Click the settings icon in Scan to display the Accessories tab. The available 
parameters depend on the installed accessories.

Click the settings icon in Scan to display the Samples tab.

Feature Description

Samples Group Lists samples by their names and descriptions, up to a maximum 
of 1000. To change a sample name, click its cell and edit the text. 
To enter or change text in a table cell, click it and type. To order 
the list by sample name or description, click the appropriate 
column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Click the  icon to load a previously saved sample group.

Base Name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample 
spectra using the base name “dye” would be dye1, dye2 and 
dye3.

Samples Number of samples for the experiment.

Feature Description
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Peak Pick Tab for Scan

These settings are available:

Settings for Quant Applications

The follow tabs of settings are available:
Type Tab for Quant
Measurement Tab for Quant
Instrument Tab for Quant
Accessories Tab for Quant
Standards Tab for Quant
Samples Tab for Quant

Averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select 
Replicate and set Number of replicates to the total number of 
measurements. To average values from two or three different 
samples, select Duplicate or Triplicate, respectively.

Use Correction Factor If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the 
measured result. Enter the desired factor for each sample in the 
table, or click the toggle for Apply Factor to All Samples.

When setting up a Scan experiment, click the settings icon to display the 
Peak Pick tab.

Feature Description

Result Data analysis operation to perform automatically after sample measurement.

Select Off to not perform any operation.

The parameters for a selected operation appear to the right. See Finding Peaks in 
Scan Data or Finding Value Level Crossings in Scan Data for information on 
setting them and how results are displayed.

Feature Description

To set parameters that define a Quant template, click the settings icon.

Note  Change Quant settings only before sample measurements. All Quant measurements 
saved in an experiment must be made with the same settings. See Setting Application 
Parameters for information about unlocking settings.
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Type Tab for Quant

These settings are available:

Measurement Tab for Quant

Click the settings icon in Quant to display the Type tab.

Feature Description

Name (if present) User group name followed by the name of the template of settings.

Description 
(optional)

Optional description of the template.

Quant Type Type of quantitative analysis (see the table below). An image 
representing the selected type appears to the right. The required tabs also 
appear (click the Reset action button to step through them).

Pathlength Distance the light travels through the sample.

Quant Type How the Type Calculates Sample Concentration

Manually entered 
factor

Uses the equation C = K * A, where C is the concentration of the 
analyte in the selected units, K is the entered factor, and A is the 
absorbance.

Measure single 
standard

Divides the sample absorbance value by the average absorbance value 
of a single standard. This is in effect a “Standard curve” quantification 
(see below) with just one standard.

Standard curve Uses a simple standard curve based on the absorbance of a set of 
standards at a specified wavelength.

Standard curve with 
two wavelengths

Takes the average of values determined by each of two standard curves 
associated with the specified wavelengths.

Advanced standard 
curve

Uses a standard curve generated from a specified equation.

Click the settings icon in Quant to display the Measurement tab. The available 
features depend on the Quant Type setting on the Type tab. The features for each 
type are described in tables below.
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These settings are available:

Manually entered factor

Feature Description

Analysis wavelength(s) Wavelength(s) to use for the quantitative analysis.

Correction Baseline correction to apply to raw data. Available options:

• Single point. Enter a wavelength value to define the 
endpoint for the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the 
specified baseline point and calculating the absorbance 
value on the drawn baseline at the specified analytical 
wavelength. The software subtracts the calculated baseline 
absorbance value from the measured absorbance value and 
reports the corrected absorbance.

• Sloping baseline. Enter two wavelength values to define 
the endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value 
from the measured absorbance value and reports the 
corrected absorbance.

• None Uses uncorrected data.

Component name Component to quantify.

Unit Component concentration unit. The available units depend on 
the Formulas & Units tab settings in Options.

Use user-defined factor Calculates component concentration using the entered factor 
(K in the equation C = K *A), with the selected unit.

Use extinction coefficient Calculates component concentration with absorbance (A) equal 
to

where ε is the entered extinction coefficient (a constant 
dependent on the component and wavelength), c is 
concentration in the selected unit, and  is 1 cm 
(the pathlength).

cε
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Molecular weight Molecular weight of the component. Available only if the units 
specified on this tab are different and require this value for a 
conversion.

Calculate Additional 
Results

For selecting or defining formulas for additional data 
processing, with the results appearing in the analysis report. The 
formulas are written in a form similar to that used in a 
command script language, with constants, mathematical 
functions, etc. (See “Operations and Functions” for definitions.) 
All functions are not case-sensitive. Spaces are not allowed 
between a function name and “(”. After adding formulas, edit 
their information in the formula table as desired. To delete a 
table row, right-click it and choose Delete Row. Some 
information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

Select a formula from the preset list, then click the Use for 
Additional Results button.

Hold down the Ctrl or Shift keys on the keyboard while making 
multiple selections. The available formulas depend on the 
Formulas & Units tab settings in Options.

To define a formula

1. Click the Equation Builder tab.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, 
select it from the drop-down menu and enter values for the 
variables.

The available formulas depend on the Formulas & Units 
tab settings in Options.

3. Click the Use for Additional Results button.

4. For selected provided formulas, enter a name and 
concentration unit in the table.

The available formulas depend on the Formulas & Units 
tab settings.

Feature Description
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Measure single standard

Standard curve

Standard curve with two wavelengths

Feature Description

Analysis wavelength(s) Wavelength(s) to use for the quantitative analysis.

Correction See Correction above.

Component name Component to quantify.

Unit Component concentration unit. The available units depend on 
the Formulas & Units tab settings in Options.

Standard concentration Concentration of the single standard.

Std averaging Whether and how to average concentration values from multiple 
measurements of the same standard or from multiple standards 
prepared under the same conditions. To average multiple 
measurements of the same standard, select Replicate and set 
Number of replicates to the total number of measurements. To 
average values from two or three similar standards, select 
Duplicate or Triplicate, respectively.

Calculate additional 
results

See Calculate additional results above.

Feature Description

Analysis wavelength(s) Wavelength(s) to use for the quantitative analysis.

Correction See Correction above.

Component name Component to quantify.

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

See Calculate additional results above.

Feature Description

Analysis wavelengths Wavelengths to use for the quantitative analysis.

Correction See Correction above.

Component name Component to quantify.

Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings.

Calculate additional 
results

See Calculate additional results above.
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Advanced standard curve

Feature Description

Standard Curve Equation Equation used to quantify samples, written in a form similar to 
that used in a command script language, with constants, 
mathematical functions, etc. (See Operations and Functions for 
definitions of operations and functions.) All functions are not 
case-sensitive. Spaces are not allowed between a function name 
and “(”.

For this Quant type the equation defines the value for the Y-axis 
of the calibration curve.

Instructions:

Instructions:

To add one or more predefined formulas

Select a formula from the preset list, then click the Use for 
Additional Results button.

Hold down the Ctrl or Shift keys on the keyboard while making 
multiple selections. The available formulas depend on the 
Formulas & Units tab settings in Options.

To define a formula

1. Click the Equation Builder tab.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, 
select it from the drop-down menu and enter values for the 
variables.

The available formulas depend on the Formulas & Units 
tab settings in Options.

3. Click the Use for Additional Results button.

4. For selected provided formulas, enter a name and 
concentration unit in the table.

The available formulas depend on the Formulas & Units 
tab settings.

Component name Component to quantify.
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Instrument Tab for Quant

These settings are available:

Unit Component concentration unit. The available units depend on 
the Formulas & Units tab settings in Options.

Calculate additional 
results

See Calculate additional results above.

Click the settings icon in Quant to display the Instrument tab.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data mode Y-axis format for acquired data. Available options include 
Absorbance and % Transmittance.

For Abs*Factor (Scan only), set Factor to a value by which to 
multiply measured absorbance values.

Smooth (Scan only) Select the desired degree of smoothing (if available for the 
selected data mode and Derivative setting). Smoothing reduces 
noise in the data but can also remove some spectral features 
such as small peaks, valleys and shoulders. See About 
Smoothing.

Derivative (Scan only) Select the desired derivative order for acquired data (if available 
for the selected data mode).

Start wavelength and End 
wavelength (Scan only)

Starting and ending values of the wavelength range for 
acquiring data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration time How long the system acquires and averages data at each data 
interval (for Scan) or at each measured wavelength (for Fixed). 
Increasing the integration time improves the signal-to-noise 
ratio but reduces the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Feature Description
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Accessories Tab for Quant

The status of accessories can be monitored during measurements.

Standards Tab for Quant

These settings are available:

Estimated time (Scan 
only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Wavelength Summary 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.

Click the settings icon in Quant to display the Accessories tab. The available 
parameters depend on the installed accessories.

To display the Standards tab, click the settings icon in Quant and then set Quant 
Type to Standard curve, Standard curve with two wavelengths, or Advanced 
standard curve.

Feature Description

Curve fit type Type of equation used to create the standard curve from standard 
concentration values.

Standard averaging Whether and how to average concentration values from multiple 
measurements of the same standard or from multiple standards 
prepared under the same conditions. To average multiple 
measurements of the same standard, select Replicate and set Number 
of replicates to the total number of measurements. To average values 
from two or three similar standards, select Duplicate or Triplicate, 
respectively.

Minimum r2 The r2 value indicates how well the standard curve fits the standard 
data points, with 1.0 a perfect fit. If Minimum r2 is selected, samples 
can be quantified only after that value is achieved for the standard 
curve.

Calculate from 
weight/volume

If available for the current unit, calculates concentration when the 
weight and volume of material used to prepare each standard is 
known. Enter the weight and volume for each standard in the 
appropriate table cells, or enter it later as part of running an analysis.

Feature Description
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Samples Tab for Quant

These settings are available:

Use correction 
factor

If available and selected, specifies a multiplication factor for each 
standard. Can be used to correct for standard properties (percent 
purity, water content, etc.) or preparation steps that affect the 
measured result such as a dilution.

When this option is selected, two columns are added to the standards 
table: Correction Factor and Corrected Concentration. In the 
Correction Factor column, enter the desired factor for each standard 
in the table. The values in the Corrected Concentration column are 
used to create the calibration curve. If a report is generated that 
includes information about the standards, the report will also include 
the correction factors and corrected concentrations.

Standards Table Contains concentration and other information about the standards. 
To add information from a .csv (comma separated values) file or .tsv 
(tab separated values) file, click Import Standards. To save the 
information in a .csv file or .tsv file, click Export Standards.

Click the settings icon in Quant to display the Samples tab.

Feature Description

Samples Group Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Click the  icon to load a previously saved sample group.

Samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Feature Description
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Settings for Kinetics Applications

The follow tabs of settings are available:
Type Tab for Kinetics
Measurement Tab for Kinetics
Instrument Tab for Kinetics
Accessories Tab for Kinetics
Samples Tab for Kinetics
Rate Calculations Tab for Kinetics

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use sample 
correction factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table.

Use weight/volume 
correction

If available for the current unit, corrects sample concentrations using 
the entered target weight and volume:

corrected concentration = measured concentration * (actual weight / 
target weight) * (target volume / actual volume)

Use control limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Feature Description

To set parameters for the current Kinetics experiment, click the settings icon.
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Type Tab for Kinetics

These settings are available:

Click the settings icon in Kinetics to display the Type tab.

Feature Description

Name (if present) User group name followed by the name of the template of settings.

Description Description of the template.

Rate Type Type of rate measurement to perform (see the table below). An image 
representing the selected type appears to the right. The required tabs 
also appear (click the Reset action button to step through them).

Mode These options are available:

Time. Performs rate measurements based on elapsed time.

Temperature. Performs rate measurements based on elapsed time and 
also records temperature settings. Available for fixed rate experiments 
only.

Rate Type How the Type Collects Data

Single wavelength For each sample, measures a specified wavelength at specified intervals 
of time.

Multiple 
wavelengths

For each sample, measures multiple specified wavelengths at specified 
intervals of time.

Scan data 
acquisition

For each sample, measures a range of wavelengths at specified 
intervals of time.
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Measurement Tab for Kinetics

These settings are available:

Click the settings icon in Kinetics to display the Measurement tab.

Feature Description

Integration Time How long the system acquires and averages data to obtain each data 
point at each measured wavelength. Available for single and multicell 
experiments only. (To set integration time for scan rate experiments, 
see Instrument Tab for Kinetics.)

Dwell Time How long the sample remains in the light beam. Available for single 
and multicell experiments only.

Use this setting to vary the number of data points collected per cell 
per cycle. Dwell time is always a multiple of integration time (see 
above). Dwell time can be very useful when performing multicell 
rate measurements. This is because the cell changer accessory will 
position a cell in the light beam for a specified period of time (dwell 
time), rather than moving back and forth between cells and 
increasing the time between measurements (when no sample is in 
the light beam).

For example, if the integration time is 0.1 second and dwell time is 
0.5 second, five data points will be recorded for each cell before the 
cell changer moves to the next cell. For fairly fast reactions, multiple 
samples can be measured, with over ten times as many data points 
acquired within a short time. This can improve the accuracy of rate 
calculations for faster multicell rate measurements.

Stages Defines the number of measurement stages over which the frequency 
of data acquisition can be determined. For example, if a reaction has 
two components, the first component could be fast and require a 
high data density. The second component could be much slower and 
longer lived, therefore requiring a lower data density. Defining 
multiple stages enables the use of the proper data density over a 
given period of time.

Available for single and multiple wavelength experiments only.

Temp Units Determines the temperature unit used in the stages table (see below).

Time Units Determines the time unit used in the stages table (see below).



2 Insight Pro Software
Operation

70 Insight Pro Software User Guide Thermo Scientific

Stages table Available for single and multiple wavelength experiments only.

For time-based experiments:

Defines for each stage the start time, end time and interval (how 
frequently a measurement is made). For example, using an interval 
of 10 seconds would measure the sample every 10 seconds from the 
start time to the end time. In a multicell experiment the interval 
setting is the measurement interval for each sample.

For temperature-based experiments:

Defines for each stage the end temperature, ramp rate, hold type, 
hold time, interval and whether data collection will occur.

Target Temp. Enter a target temperature between 0.00 °C (32.00 °F 
or 273.15 °K) and 110.00 °C (230.00 °F or 383.15 °K).

Ramp Rate. Enter a ramp rate from 0.40 to 20.00 °C/min 
(0.72 to 36.00 °F/min or 0.40 to 20.00 °K/min) up or down.

Hold Type. Specify a hold time at the target temperature before 
continuing to the next stage. Time holds for a specified time (see 
Hold Time below). Prompt holds until the operator responds to a 
message in the software. Trigger waits for an external trigger. 
Choosing Start in the trigger prompt will override the trigger.

Hold Time. When Hold Type is set to Time, enter the length of 
time to hold at the target temperature before continuing to the 
next stage.

Interval. Specifies how frequently a measurement is made. Must be 
equal to or greater than the specified Integration Time and less than 
the stage duration. Disabled when Collect Data (see below) is set 
to No.

Collect Data. Specifies whether to collect data during each stage.

Cycle time 
(Scan only)

Time between each measurement cycle. Available for scan 
experiments only.

Duration (Scan only) Length of the experiment, calculated by multiplying the cycle time 
by the number of cycles (see above). Available for scan experiments 
only.

Cycles (Scan only) Number of measurement cycles. Available for scan experiments only.

Feature Description
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Instrument Tab for Kinetics

These settings are available:

Click the settings icon in Kinetics to display the Instrument tab.

Feature Description

Data Mode Y-axis format for acquired data. Available options include 
Absorbance and % Transmittance.

For Abs*Factor (Scan only), set Factor to a value by which to 
multiply measured absorbance values.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can improve 
the signal-to-noise ratio; however, a larger spectral bandwidth 
decreases the ability to resolve closely spaced spectral features, 
especially in scanning measurements.

Derivative (Scan only) Select the desired derivative order for acquired data. Available for 
scan experiments only.

Smooth (Scan only) Select the desired degree of smoothing. Smoothing reduces noise in 
the data but can also remove some spectral features such as small 
peaks, valleys and shoulders. For more information, see About 
Smoothing. Available for scan experiments only.

Start wavelength and 
End wavelength 
(Scan only)

Starting and ending values of the wavelength range for acquiring 
data. Available for scan experiments only.

Integration Time 
(Scan only)

How long the system acquires and averages data at each data 
interval. Increasing the integration time improves the 
signal-to-noise ratio but reduces the scan speed. Available for scan 
experiments only.

Data interval 
(Scan only)

Difference in wavelength between two consecutive data points. 
Available for scan experiments only.

Scan speed 
(Scan only)

Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases. Available 
for scan experiments only.

Estimated time 
(Scan only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed. Available for scan experiments only.

Monitor Wavelength
(Scan only)

When using Scan Data Acquisition type in the Kinetics 
Application, choose wavelengths to monitor with each time point 
for measurements.
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Accessories Tab for Kinetics

The status of accessories can be monitored during measurements.

Samples Tab for Kinetics

These settings are available:

Reference WL 
(wavelength) 
Correction

When selected, automatically acquires a reference measurement at a 
specified wavelength each time a sample measurement is taken. The 
reference measurement is then subtracted from the corresponding 
sample measurement to produce a corrected measurement result. 
Only the corrected results are reported.

Use the Reference wavelength box to specify a wavelength for the 
reference measurement.

Available for single and multiple wavelength experiments only.

Wavelength Summary Wavelengths to monitor during the reaction. Available for single 
and multiple wavelength experiments only.

Click the settings icon in Kinetics to display the Accessories tab. The available 
parameters depend on the installed accessories.

Click the settings icon in Kinetics to display the Samples tab.

Feature Description

Samples Group Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column 
heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Click the  icon to load a previously saved sample group.

Samples Number of samples for the experiment.

Feature Description
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Base Name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Samples table Lists samples by their names and descriptions, up to a maximum 
of 1000.

To change a sample name, click its cell and edit the text. To enter or 
change text in a table cell, click it and type. To order the list by 
sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names 
are incremented.

Feature Description
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Rate Calculations Tab for Kinetics

These settings are available:

Click the settings icon in Kinetics to display the Rate Calculations tab (for 
time-based single and multiple wavelength experiments only).

Feature Description

Calculate rate constants 
automatically at end of 
data acquisition

Calculates rate constants automatically at the end of the 
experiment. When this option is selected, the rate curve appears in 
the data display and the rate settings and calculations appear in 
the sample measurements table after the measurement is 
completed. To modify the rate curve, double-click the data 
display or choose Analyze > Modify Rate Curve.

When this option is cleared and rate calculations have been 
entered, use the Modify Rate Curve window to view, modify, 
update and accept the rate calculations settings. After you accept 
the settings, the window closes and the rate curve appears in the 
data display and the rate settings and calculations appear in the 
sample measurements table. See Performing a Kinetics 
Measurement for more information.

Calculate Rate For each measurement stage, enter the starting and ending times 
of the rate vector, the rate scaling factor, and the order of the 
reaction. The factor is a constant that is multiplied by a calculated 
kinetics parameter to give physical significance to the 
measurement.

To enter different settings for individual wavelengths, select 
Specify settings for individual wavelengths (available only if 
Rate Type on the Type tab is set to Multiple wavelengths). In the 
Wavelength column, select or type the desired wavelength for each 
row of settings. The available wavelengths are those entered on the 
Instrument tab.

To delete a row of information from the table, right-click the row 
and choose Delete Selected Row. To delete all the information 
from the table, right-click it and choose Clear Table.
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Configuring a Report

A report contains a table of sample data and other specified information. Reports can be saved 
and printed or the sample data can be exported.

To configure a report

1. Open an experiment or measure a sample.

2. Click Report.

The sample data that were measured and archived in the opened experiment are displayed 
on the Samples tab.

3. Select the sample results to include by clicking a row in the table.

Use “Shift + click” or “Ctrl + Click” to select additional rows.

4. To specify the columns to include and their order, click the Reportable Data tab.

5. To specify the items to include in printed reports for this experiment, click the 
Layout tab.

6. To print the report, click the Print action button.

Note  See the Report Master Page tab in Options to define global settings for all reports 
including headers and footers and a logo or other image.

Note  To specify that all items in printed reports span the full width of each page, 
select Fit To Width in the navigation pane. See Layout tab for more information 
about formatting options for printed report.
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Exporting Data

You can export acquired data and associated measurement results from any opened report or 
configure Insight Pro to export all data and results automatically.

Exporting Data from a Report

Acquired data and associated measurement results can be manually saved in a specified format 
and location.

To export acquired data and measurement results

1. Open an experiment or measure a sample.

2. Click Report.

3. Select the sample data to be exported by clicking a row in the table.

Use Shift + Click or Ctrl + Click to select additional rows.

4. Click the Export action button.

5. Select a location for the exported file.

6. Type a file name for the exported data in the File name box.

7. Set Save as type to the desired file format (several formats for exporting reports and 
spectra are available).

8. Click Save.

The information is saved in a file in the specified format, file name and location.

Exporting Data Automatically

Insight Pro software can be configured to automatically save all acquired data in a specified 
format and location.

To configure Insight Pro to export all acquired data

1. From the Insight Pro window, go to .

2. Click the Data tab.

Contents

• Exporting Data from a Report

• Exporting Data Automatically
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3. In the Convert Data group, select Auto Export.

4. Select an available format.

5. To select the location for the exported data, type a new path or use Browse.

The results for each measured sample are saved in a separate file in the specified format 
and location. The filename includes the sample and experiment name and the date 
and time.

Managing Data

• To view previously recorded data, click  on the Insight Pro window. 
History contains past Experiments and PV Reports.

• To import data, click  from the History screen and the Import Experiments screen 
will pop up.

• To create and manage templates, click  on the Insight Pro window.

Locking method templates

To lock a method template, hover over its entry in the templates list until a lock icon appears, 
then click the lock icon.
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A dialog box will appear, prompting for a password. Enter your password, then click OK.

When the template is locked, the lock icon will become grey.
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To unlock a method template, click the grey lock icon. A dialog box will appear, prompting 
for a password. Enter the password, then click OK.

Contents

• Reports
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Reports 

A report contains a table of sample data and other specified information.

These action buttons appear in Reports:

The Export formats include:

To configure or view the report after opening an experiment or measuring 
a sample, click Report.

Button Description

Opens Page Setup dialogue box. Specifies paper size, orientation, 
and margins for printing.

Prints the current report on the specified printer.

Saves the specified spectral data or sample measurement results in 
the specified format (see the table below).

Format Description

Report, Excel XML 
Spreadsheet (*.xml)

Can be opened in Excel®. Only the columns selected on the 
Reportable Data tab are saved and only for the rows selected on 
the Samples tab. Configure those tabs to include the desired 
information before exporting.

For Kinetics applications, the data is displayed with one column 
per spectrum, and one sample per sheet. 

Report, Tab Separated 
Values (*.tsv)

Can be opened in Notepad or Excel. Only the columns selected 
on the Reportable Data tab are saved and only for the rows 
selected on the Samples tab. Configure those tabs to include the 
desired information before exporting.

Report, Comma 
Separated Values (*.csv)

Can be opened in Notepad or Excel. Only the columns selected 
on the Reportable Data tab are saved and only for the rows 
selected on the Samples tab. Configure those tabs to include the 
desired information before exporting.

Spectrum, Excel XML 
Spreadsheet (*.xml)

Can be opened in Excel. Saves absorbance values along with the 
corresponding wavelengths only for the rows selected on the 
Samples tab. If multiple sample rows are selected, the 
corresponding absorbance values for each wavelength are saved 
onto separate worksheets within one Excel file.
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If the computer is not mapped to recognize that .xml files should be opened with Excel, open 
the exported file from within Excel.

These tabs appear in the Reports screen:

The Layout tab includes:

Spectrum, Tab Separated 
Values (*.tsv)

Saves absorbance values along with the corresponding 
wavelengths for the rows selected on the Samples tab in a format 
that can be opened in Notepad or Excel. If multiple sample rows 
are selected, the corresponding absorbance values for each 
wavelength are saved sequentially in one column.

Spectrum, Comma 
Separated Values (*.csv)

Saves absorbance values along with the corresponding 
wavelengths for the rows selected on the Samples tab in a format 
that can be opened in Notepad or Excel. If multiple sample rows 
are selected, the corresponding absorbance values for each 
wavelength are saved sequentially in one column.

Spectra, New Workbook 
(*iwbk)

Saves the settings and information about any samples, standards 
and advanced calculations for the selected application to a new 
Insight Pro experiment.

Spectrum 3D, Excel 
XML Spreadsheet (*.xml)

Saves absorbance values along with the corresponding time and 
wavelengths for the rows selected on the samples tab in a format 
that can be opened in Excel. Only available in Scan Rate 
applications.

Tab Description

Includes or excludes the sample table from the printed report.

Specifies the items to include in printed reports (see the 
table below).

Feature Description

Header/Footer Includes a header and footer in the printout.

Header Items Title and subtitle to appear in the header. Use the Font buttons to specify 
their fonts.

Settings info Includes a table of experiment settings in printed reports including the 
name, serial number and settings for any accessories that were used. Use the 
Font button to specify the font for the information.

Samples table Includes a table of sample measurement information for the rows selected 
on the Reports > Samples tab in printed reports. Use the Font button to 
specify the font for the information.

Format Description
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Results/ 
Calculations 
table

This option adds the following if available to printed reports:

• Results table, which appears to the right of the data display below the 
Sample ID readout. The results table shows the results of analysis 
operations and whether sample points fall within specified control 
limits.

• Calculations table, which appears below the sample measurements 
table when Advanced Calculations is selected in the navigation pane 
(available for all applications except DNA Melting).

Use the Font button to specify the font for the information.

Standards For Quant applications that include standards, includes a table and graph 
of information for the standards in printed reports. Use the Font button to 
specify the font for the information.

X-Y pairs For Kinetics applications, includes a table of x-y data for each sample row 
selected on the Samples tab in printed reports. For each sample, one X-Y 
pair is logged for each wavelength, sampling interval and stage. Use the 
Font button to specify the font for the information.

Graphs Includes sample spectra and other data plots in printed reports. Data can 
be placed in individual graphs or overlaid on one graph.

• Select Overlay to print data plots overlaid. (Note that this is the only 
setting that allows tables and graphs to be printed on the same page.)

• Select Separate to print each data plot in a separate graph, with the 
specified number of graphs on a page.

Color 
Calculations

Includes Color Calculations data in printed reports.

Report notes Includes a Report Notes box in printed reports. To add text to the Report 
Notes box, click Edit. Use the Font button to specify the font for the 
information.

Page Setup Specifies the paper size, orientation and other printing attributes.

Fit to page 
width

Changes the layout of all included items so they fill the page width. 
(Column headings may be truncated.)

Note  We recommend first defining a master page in Settings > Reports from the Insight 
Pro window.

Feature Description
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Math and Analysis Operations

Smoothing Scan Data

There are two ways to smooth data. Use Smooth in the Instrument tab to reduce noise in 
wavelength scan data. This feature is available in Scan and Scan Kinetics applications. Or, 
select Smooth from the Math drop-down.

The smoothing algorithm uses the Savitzky-Golay method. For more information, see About 
Smoothing.

To smooth data using the slider in Peak Pick

1. Click Analyze.

2. From the Peak Pick tab, click the Smooth Spectrum toggle button. Specify the degree of 
smoothing (number of points in the smoothing formula) by dragging the slider:

The Auto box is checked by default. To specify the degree of smoothing, uncheck the 
box, and use the slider.

To smooth data using the Math drop-down

1. Choose Math (drop-down) > Smooth.

The selected spectrum appears on the top right.

The sample spectra are listed on the left. To add others:

a. Click 

b. Select a sample from the list. To select multiple samples, hold down Shift or Ctrl. 
Selected spectra appear in the lower-right pane.

c. Click OK. 

2. To convert more than one spectrum, select them from the sample list. All selected samples 
will have their spectra overlaid in the display. To remove a spectrum from the conversion, 
click its entry in the list again.

3. Select the polynomial order.

4. Specify the number of points by dragging the slider:
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5. To perform a math operation on the converted result, click Operate on Result and 
choose an operation. Otherwise, go to the next step.

6. To save the result in the current experiment, click Store Result and select Experiment.

The data are added to the list and are available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate that the data are not saved.

About Smoothing

The smoothing feature of Insight Pro software uses a Savitzky-Golay algorithm modified to 
reduce high frequency breakthrough; that is, to reduce noise in the spectrum. The algorithm 
is based on performing a least-squares linear regression fit of a polynomial of order k over at 
least k+1 data points around each point in the spectrum.

Converting Scan Data to a Derivative

Use Derivative in the Math menu to convert scan data to the first, second, third or fourth 
derivative. This feature is available in Scan and Kinetics applications.

To convert scan data to a derivative

1. Choose Math (drop-down) > Derivative.

The selected spectrum appears on the top right.

The sample spectra are listed on the left. To add others:

a. Click 

b. Select a sample from the list. To select multiple samples, hold down Shift or Ctrl. 
Selected spectra appear in the lower-right pane.

c. Click OK. 

2. To convert more than one spectrum, select them from the sample list. All selected samples 
will have their spectra overlaid in the display. To remove a spectrum from the conversion, 
click its entry in the list again.

3. Select the derivative order.

4. Select the polynomial order of the derivative formula.

5. Specify the number of points in the derivative formula by dragging the slider:
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6. To perform a math operation on the converted result, click Operate on Result and 
choose an operation. Otherwise, go to the next step.

7. To save the result in the current experiment, click Store Result and select Experiment.

The data are added to the list and are available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate that the data are not saved.

Converting Scan Data to Other Units

Use Convert Spectra in the Math menu to convert scan data to another Y-axis format.

To convert scan data to another format

1. Choose Math (drop-down) > Convert Spectra.

The selected spectrum appears on the top right.

The sample spectra are listed on the left. To add others:

a. Click 

b. Select a sample from the list. To select multiple samples, hold down Shift or Ctrl. 
Selected spectra appear in the lower-right pane.

c. Click OK. 

2. To convert more than one spectrum, select them from the sample list. All selected samples 
will have their spectra overlaid in the display. To remove a spectrum from the conversion, 
click its entry in the list again.

3. Select the desired Y-axis format from the drop-down below the spectrum display.

4. To perform a math operation on the converted result, click Operate on Result and 
choose an operation. Otherwise, go to the next step.

5. To save the result in the current experiment, click Store Result and select Experiment.
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The data are added to the list and are available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate that the data are not saved.

Adding Two Scan Spectra

Use Add in the Math menu to add two scan spectra.

To add two scan spectra

1. Choose Math (drop-down) > Add.

The sample spectra are listed on the left. To add others:

a. Click 

b. Select a sample from the list. To select multiple samples, hold down Shift or Ctrl. 
Selected spectra appear in the lower-right pane.

c. Click OK.

2. Select the first and second spectra by clicking the circled numbers that appear when 
hovering over the sample entries in the table.

3. To multiply the second spectrum by a factor other than 1, drag the slider or use Factor.

Type a value in the Factor text field or use its up and down arrow buttons. Use 
Increment to set the amount of change these buttons make to the factor when clicked. 
For example, with Factor set to 1.000 and Increment set to 0.500, clicking the Factor up 
arrow button changes the factor to 1.500.

4. To perform a math operation on the addition result, click Operate on Result and choose 
an operation. Otherwise, go to the next step.

5. To save the result in the current experiment, click Store Result and select Experiment.

The data are added to the list and are available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate that the data are not saved.

Normalizing Scan Data

Use Normalize in the Math menu to adjust the Y scale of a scan spectrum so that a selected 
data point has the desired Y value.



 2 Insight Pro Software
Operation

Thermo Scientific Insight Pro Software User Guide 87

To normalize scan data

1. Choose Math (drop-down) > Normalize.

The sample spectra are listed on the left. To add others:

a. Click 

b. Select a sample from the list. To select multiple samples, hold down Shift or Ctrl. 
Selected spectra appear in the lower-right pane.

c. Click OK.

2. Select the desired Y value for the data point specified in the next step.

3. Select the wavelength of the data point.

4. To perform a math operation on the normalized result, click Operate on Result and 
choose an operation. Otherwise, go to the next step.

5. To save the result in the current experiment, click Store Result and select Experiment.

The data are added to the list and are available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate that the data are not saved.

Subtracting a Scan Spectrum

Use Subtract in the Math menu to subtract a scan spectrum from another.

To subtract a scan spectrum

1. Choose Math (drop-down) > Subtract.

The sample spectra are listed on the left. To add others:

a. Click 

b. Select a sample from the list. To select multiple samples, hold down Shift or Ctrl. 
Selected spectra appear in the lower-right pane.

c. Click OK.

2. Select the first and second spectra by clicking the circled numbers that appear when 
hovering over the sample entries in the table.

3. To multiply the second spectrum by a factor other than 1, drag the slider or use Factor.
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Type a value in the Factor text box or use its up and down arrow buttons. Use Increment 
to set the amount of change these buttons make to the factor when clicked. For example, 
with Factor set to 1.000 and Increment set to 0.500, clicking the Factor up arrow button 
changes the factor to 1.500.

4. To perform a math operation on the subtraction result, click Operate on Result and 
choose an operation. Otherwise, go to the next step.

5. To save the result in the current experiment, click Store Result and select Experiment.

The data are added to the list and are available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate that the data are not saved.

Ratioing Two Scan Spectra

Use Ratio in the Math menu to divide a scan spectrum by another.

To ratio two scan spectra

1. Choose Math (drop-down) > Ratio.

The sample spectra are listed on the left. To add others:

a. Click 

b. Select a sample from the list. To select multiple samples, hold down Shift or Ctrl. 
Selected spectra appear in the lower-right pane.

c. Click OK.

2. Select the first and second spectra by clicking the circled numbers that appear when 
hovering over the sample entries in the table.

3. To multiply the second spectrum by a factor other than 1, drag the slider or use Factor.

Type a value in the Factor text box or use its up and down arrow buttons. Use Increment 
to set the amount of change these buttons make to the factor when clicked. For example, 
with Factor set to 1.000 and Increment set to 0.500, clicking the Factor up arrow button 
changes the factor to 1.500.

4. To perform a math operation on the division result, click Operate on Result and choose 
an operation. Otherwise, go to the next step.

5. To save the result in the current experiment, click Store Result and select Experiment.
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The data are added to the list and are available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate that the data are not saved.

Averaging Scan Spectra

Use Average in the Math menu to find the average of two or more scan spectra.

To use Average

1. Choose Math (drop-down) > Average.

The selected spectrum appears on the top right.

The sample spectra are listed on the left. To add others:

a. Click 

b. Select a sample from the list. To select multiple samples, hold down Shift or Ctrl. 
Selected spectra appear in the lower-right pane.

c. Click OK. 

2. To convert more than one spectrum, select them from the sample list. All selected samples 
will have their spectra overlaid in the display. To remove a spectrum from the conversion, 
click its entry in the list again.

3. To perform a math operation on the result, click Operate on Result and choose an 
operation. Otherwise, go to the next step.

4. To save the result in the current experiment, click Store Result and select Experiment.

The data are added to the list and are available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate that the data are not saved.

Adding, Subtracting, Multiplying or Dividing Scan Data by a Factor

Use Factor in the Math menu to add a constant to the Y value of scan data, subtract a 
constant, multiply by a constant or divide by a constant.

To use Factor

1. Choose Math (drop-down) > Factor.

The selected spectrum appears on the top right.

The sample spectra are listed on the left. To add others:

a. Click 
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b. Select a sample from the list. To select multiple samples, hold down Shift or Ctrl. 
Selected spectra appear in the lower-right pane.

c. Click OK. 

2. To convert more than one spectrum, select them from the sample list. All selected samples 
will have their spectra overlaid in the display. To remove a spectrum from the conversion, 
click its entry in the list again.

3. Select the arithmetic operation to perform on the Y value of every data point.

4. Specify the factor: type a value, click the up and down arrow buttons, or drag the slider.

5. To perform a math operation on the result, click Operate on Result and choose an 
operation. Otherwise, go to the next step.

6. To save the result in the current experiment, click Store Result and select Experiment.

The data are added to the list and are available for operations.

To add the result to the list without saving it, click Temporary. Asterisks at the beginning 
of a spectrum name indicate that the data are not saved.

Color Calculations

Use Color Calculations in the Math menu to run preset color calculations on you sample 
data and generate tabular and graphical results.

Available Color Calculations:
• Tristimulus (XYZ)
• Chromaticity Coordinates (xyY)
• CIE L*a*b*

• Color Difference (deltaE*)
• CIE L*C*h*
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To use Color Calculations

1. Choose Math (drop-down) > Color Calculations.

The sample IDs are listed on the left. Select a sample(s) from the list. 

2. Color Evaluation profiles are listed on the right, Click to select groups or expand groups 
to select specific profiles.

3. Thickness corrections can be included by selecting the following icon . This will 
open the following window:

4. Enter the Desired Thickness and Reflectance or Refractive Index percentage. Click Apply 
to apply the correction. A green thickness correction icon indicates that thickness 
correction is applied. Disable thickness correction from the same settings window.

5. Click Calculate. Results of the calculation are shown in a results table.

6. To print the color graph, from the Data Handling dropdown, select the graph option. 

The graph is generated and displayed in a print preview. 
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Finding Peaks in Scan Data

Use Peak Pick in the Analyze menu to find peaks, valleys, zero crossings, or maximum and 
minimum values in a spectrum or region.

To locate peaks

1. Choose Analyze > Peak Pick.

2. Set the parameters and adjust the data display as desired.

Note  Peaks can be found automatically after data acquisition. See Measurement Tab for 
Scan.

Parameter Description

Find Specifies whether to find peaks, valleys, both peaks and 
valleys, or maximum and minimum Y values.

Max number (of peaks, 
valleys, or peaks and valleys)

Maximum number of items to find.

Sort By Order for labeling and listing found items in the Peak 
Pick results table.

Sensitivity How readily small peaks or valleys are found. To 
optimize the sensitivity, select Auto. To set it manually, 
deselect Auto and drag the slider.

Wavelength Range Wavelength range in which to find items. To use the 
entire range, select Full. To limit the range, deselect Full 
and type the desired limits or use the region-threshold 
tool:

Use threshold Specifies whether to find only those peaks whose Y values 
are greater than or equal to a specified value, the 
threshold. (For % transmittance, the software finds 
valleys less than or equal to the threshold.) To optimize 
the threshold value, select Auto. To set it manually, 
deselect Auto and set Threshold by typing a value or 
dragging the horizontal line in the data display.

Smooth spectrum Specifies whether or not to smooth the data before 
finding peaks or valleys. This tends to reduce the number 
of small peaks, valleys and shoulders. (For more 
information, see About Smoothing.) The (blue) 
smoothed spectrum is overlaid on the original. To 
optimize the degree of smoothing, select Auto. To adjust 
it manually, deselect Auto and drag the slider.



 2 Insight Pro Software
Operation

Thermo Scientific Insight Pro Software User Guide 93

To adjust the data display, use the view finder. To zoom in or move the spectrum, use the 
selection tool:

The results appear in the data display pane and the table below it:

The found peaks have labels, and the peak results are listed at the right.

The settings are saved in the experiment and will be used for measuring samples with 
Result on the Peak Pick tab set to Peak Pick.

Finding Value Level Crossings in Scan Data

Use Value Level Crossing in the Analyze screen to find the wavelengths where a spectrum 
crosses a specified ordinate value.

To locate value level crossings

1. Choose Analyze > Value Level Crossing.

2. Set the parameters and adjust the data display as desired.

Peak Pick results table Peak label

Note  Crossings can be found automatically after data acquisition. See Measurement Tab 
for Scan.



2 Insight Pro Software
Operation

94 Insight Pro Software User Guide Thermo Scientific

To adjust the data display, use the view finder. To zoom in or move the spectrum, use the 
selection tool:

The results appear in the data display pane and the table below it:

3. Click OK.

Parameter Description

Crossing Level Specifies the ordinate (Y) value. One can also drag the horizontal 
line in the data display.

Sort By Order for listing crossings in the value level crossings results table.

Wavelength Range Wavelength range in which to find crossings. To use the entire 
range, select Full. To limit the range, deselect Full and type the 
desired limits or use the region-threshold tool:

Sensitivity How readily small-amplitude crossings are detected. To optimize 
the sensitivity, select Auto. To set it manually, deselect Auto and 
drag the slider. A high sensitivity finds locations where the 
spectrum crosses the horizontal line only a short distance.

Value level crossing results table Crossing label
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The found crossings have labels, and the crossing results are listed at the right.

The settings are saved in the experiment and will be used for measuring samples with 
Result on the Peak Pick tab set to Value Level.

System Settings

Applications Tab
Reports Tab
Preferences Tab
Data Tab
Formulas & Units Tab
Diagnostics Tab (for our use only)

Applications Tab

To add a new group

Enter the desired group name in the Groups box and click Add.

To customize the current group

Drag the desired applications from the Applications list to the buttons at the right. To 
remove an application from the group, drag it from its button to the Applications list.

To delete the current group

Click Delete Group and then click Yes when prompted.

To reset the application buttons for the current group

Click Clear App Buttons and then click Yes when prompted.

To make custom templates available for groups other than Classic

Drag the List of Templates application to one of the top nine menu buttons.

The following tabs are available in Settings:

From the Insight Pro Window, click Settings > Applications. Use 
it to configure the home page by adding new user groups and 
giving them access to particular applications. The Group 
drop-down list box shows the name of the current group.
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Reports Tab

Preferences Tab

From the Insight Pro Window, click Settings > Reports.

Feature Description

Company name Enter a company name and press Enter. Select an orientation for the 
name, and use Font to specify the font.

Date Date of the report creation. Use Font to specify the font for Date and 
Time.

Time Time of the report creation. Use Font to specify the font for Time and 
Date.

Logo Select an orientation for the logo, and use Browse to locate and select a 
logo image file.

Footer text Text at the bottom of the report. Use Font to specify the font for the 
footer.

Page number Format for page numbers. Select None to not include page numbers.

From the Insight Pro Window, click Settings > Preferences.

Feature Description

Data Value Digits Specify the number of digits to the right of the decimal point to use 
for X and Y values for spectral data.

Triggering Starting data acquisition normally requires a response to a prompt 
(displayed by Measure or another action button). To start acquisition 
automatically a specified number of minutes after the prompt 
appears, select Auto Input Trigger and enter the number of minutes 
for the delay.

Use Output trigger to specify whether and when to produce a signal 
that triggers an installed accessory to begin an operation.
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Data Tab

Formulas & Units Tab

In the appropriate table, select in the Show column the items to be available.

To add an item, enter it (or the appropriate information) in the row that starts with a plus (+) 
sign.

To delete an item, right-click it and choose Delete Row. Items with a lock icon cannot be 
edited or deleted.

To return to the default selections, click Reset.

These formulas and units lists can be customized:

From the Insight Pro Window, click Settings > Data. Use it to 
specify how to save experiments.

Feature Description

Configure Select Configure from the Database list to view and specify the 
database configuration. The default selection is Local Database. 
To connect to a custom database, select the Remote database 
type, version, name, and port. You may also need to enter a 
username and password.

Convert Data Select Auto Export to automatically save acquired data using the 
selected format in the specified location. Available formats 
include .xml, .csv, .tsv, and .iwbk, a database for viewing in 
Insight Pro software. 
To change the location, type a new path or click Browse.

Database Backup & 
Restore

Define data backup and restore locations.

From the Insight Pro Window, click Settings > Formulas & 
Units. Use it to specify the default formulas, units and advanced 
equations for setting up quantitative analyses.

Feature Description

Default Formulas These formulas appear when you click Select on the 
Measurement tab in Quant Settings.
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Default Units These units appear in the Unit list box on the Measurement tab 
in Quant Settings.

Advanced Calibration 
Equations

These formulas appear when you click Build on the 
Measurement tab in Quant Settings.

Feature Description
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Dye List

Use the Dye List to select predefined dyes, modify existing dyes for protocols, or enter new 
dyes.

To enter a new dye, type its information in the appropriate cells of the bottom row of the table 
and select a unit. Refer to the dye manufacturer for appropriate correction factors. The 
260 nm corrections will be used for nucleic acid sample concentration calculations. Entered 
information is saved automatically.

To delete a user-defined dye, right-click its row and choose Delete Row. Predefined dyes, 
identified by the lock icon, cannot be edited or deleted.

Calibration

Alignment Tab
Calibrations

Alignment Tab 

To perform an alignment

1. To measure intensities using a green light (510 nm), select Green from the Filter 
drop-down menu. To use no filter, select White.

The correct setting depends on the installed accessory. For more information refer to the 
user guide for the accessory.

2. Set Bandwidth as desired.

The available settings depend on the instrument.

3. Click Start.

These are available in the Calibration tab, in the bottom ribbon of 
the Insight Pro Window:

From the Insight Pro Window, click Calibration. The Alignment 
tab will display by default. Use it to view sample and reference 
detector intensities while aligning an accessory.
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Every half second the sample and reference detector intensities are plotted and displayed 
by the Sample beam and Reference readouts.

To overlay the plots instead of stacking them, deselect Stack.

The Time readout shows the elapsed time. Intensities can be measured and plotted for up 
to 15 minutes without restarting the process.

If the plot of sample detector intensity is not at the desired position for viewing, adjust 
the detector gain by dragging the Gain slider up or down.

To adjust the display, use the view finder. To zoom in, draw a box and click inside it. To 
return to full display, double-click the pane.

4. Align the accessory to achieve the desired sample detector intensity. For more information 
refer to the user guide for the accessory.

5. When finished, click Stop.

Note  If the instrument has variable slit wheels, the start of intensity measurement is 
delayed while they move to their 2 nm position.
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Calibrations

To calibrate using a particular lamp, click its Calibrate button and follow the instructions that 
appear. See the Mercury Lamp user guide for instructions for using a mercury lamp safely.

Settings

Diagnostics tab (for our use only)

From the Insight Pro Window, click Calibration > Calibrations. 
Use it to calibrate the instrument wavelength or accessories.

Feature Description

Wavelength Calibration Calibrate available lamps.

Accessories Calibrate available accessories.

Click Settings to display the System tab. Use it to switch the 
instrument between local and computer control (applies to certain 
discontinued Evolution One Series models only) and to 
update firmware.
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Keyboard Shortcuts

These are available in Insight Pro software:

Feature Description

Firmware Update Click Load Update to install the selected instrument firmware. 
Follow the instructions that appear.

Instrument Boot 
Record

Click Display to view the instrument’s power-up boot record, which 
can be saved or copied.

Keyboard Shortcut Description

Alt+F4 Exits Insight Pro software.

Ctrl+F (from Home) Displays Fixed.

Ctrl+Q (from Home) Displays Quant.

Ctrl+R (from Home) Displays Rate.

F1 Displays Help.

F2 Displays Home.

F4 Displays the Measure screen for the current application.

F5 Acquires zero or baseline data.

F6 Chooses the Measure button.

F7 Prints the Measure screen.

F8 Prints the report.

F9 Displays My Data.

F10 Creates a new experiment.

F11 (from Home) Displays Performance Verification.

F12 Chooses the Stop button.
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3

Insight Pro Bio Applications 

About the Bio Applications
The Bio applications provide methods for measuring biological macromolecules including 
nucleic acids and proteins. The application type, settings and report layout for each Bio 
application are pre-configured but customizable. If you customize one of these applications, 
you can save the current settings as a template.

Nucleic Acid Assays

The nucleic acid assay methods include:

• Nucleic Acid

• Nucleic Acid Labels

• DNA Melting

Below are the default values for the nucleic acid methods. Wavelengths are in nanometers.

Method
Analytical 
Wavelength 
(Quant)

Reference 
Wavelength

Start 
(Scan)

Stop 
(Scan)

Bandwidth 
(nm)

Integration 
Time (sec) 
(Fixed, Scan)

Data 
Interval 
(Scan)

Scan 
Speed 
(nm/min)

Nucleic Acid 260 340 220 350 1.0 1.0, 0.08 0.50 375

Nucleic Acid 
Labels

260 340 220 850 1.0 1.0, 0.16 1.00 375

DNA Melting 260 340 n/a n/a 1.0 1.0 n/a n/a
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Protein Assays

There are two types of protein assay methods included, direct UV and colorimetric assays. 
The colorimetric assays include several assays that are similar. Likewise, the direct protein 
methods are also very similar. Use the table below to find the appropriate assay procedure. 
Click the links to access complete information about the assays.

Below are the default values for the protein methods. Wavelengths are in nanometers.

Direct UV Assays Colorimetric Assays

Protein A280 Protein A280

Proteins & Labels Pierce BCA

Protein Bradford

Pierce Modified Lowry

Pierce 660 nm Protein Assay

Protein Biuret

Method
Analytical 
Wavelength 
(Quant)

Reference 
Wavelength

Start 
(Scan)

Stop 
(Scan) Bandwidth

Integration 
Time (sec) 
(Fixed, Scan)

Data 
Interval 
(Scan)

Scan 
Speed 
(nm/min)

Protein A280 340 220 850 1.0 1.0, 0.08 0.5 375

Proteins & Labels 340 220 850 1.0 1.0, 0.16 1.0 375

Pierce BCA 562 340 750 450 1.0 1.0, 0.12 1.00 500

Protein Bradford 595 340 750 450 1.0 1.0, 0.12 1.00 500

Pierce Modified 
Lowry

750 405 900 600 1.0 1.5, 0.12 1.00 500

Pierce 660 nm 
Protein Assay

660 340 850 550 1.0 1.5, 0.12 1.00 500

Protein Biuret 550 340 750 450 1.0 1.0, 0.12 1.00 500
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Nucleic Acid

Overview

See Unique Screen Features for information about the results the application calculates. See 
Nucleic Acid Concentration Calculations for information about the calculations.

Nucleic Acid Concentration Calculations

The Nucleic Acid application is used for determining the concentration and purity of nucleic 
acid samples. The nucleic acid concentration is determined by multiplying the absorbance at 
260 nm by a factor (default, 50). This factor is essentially the extinction coefficient in units of 
ng-cm/ml. Using this coefficient gives the manipulated equation

where c is the nucleic acid concentration in ng/microliter, A is the absorbance in AU, ε is the 
wavelength-dependent extinction coefficient in ng-cm/microliter, and  is the pathlength in 
centimeters. 

The generally accepted extinction coefficients for nucleic acids are:

Nucleic Acid Purity Measurements

The 260/280 nm ratio assay determines the purity of nucleic acids based on the 
260/280 ratio.

The 260/230 ratio assay determines the purity of nucleic acids in the presence of phenol, 
which absorbs strongly at 230 nm.

A ratio of approximately 1.8 is generally accepted as “pure” for DNA, approximately 2.0 for 
RNA. If either ratio is appreciably lower, protein, phenol or other contaminants that absorb 
strongly near 280 nm may be present.

Use the Nucleic Acid application to measure nucleic acid samples for 
concentration and purity.

Coefficient Value

Double-stranded DNA 50 µg/ml
Single-stranded DNA 33 µg/ml
RNA 40 µg/ml

)/ *(A = c ε



3 Insight Pro Bio Applications
Nucleic Acid

106 Insight Pro Software User Guide Thermo Scientific

The 260/230 values for a “pure” nucleic acid are often higher than the respective 260/280 
values and are commonly in the range 1.8 to 2.2. If the ratio is appreciably lower, co-purified 
contaminants may be present.

Application Settings

The follow tabs of settings are available:
Type Tab for Nucleic Acid
Measurement Tab for Nucleic Acid
Instrument Tab for Nucleic Acid
Accessories Tab for Nucleic Acid
Samples Tab for Nucleic Acid

Type Tab for Nucleic Acid

These settings are available:

To set data acquisition parameters for a Nucleic Acid workbook, click Settings.

Click Settings in Nucleic Acid to display the Type tab.
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Measurement Tab for Nucleic Acid

Feature Description

Description (optional) Description of the template.

Nucleic Acid Type Type of analysis to perform.

ssDNA is for single-stranded DNA.

Oligo DNA and Oligo RNA use the appropriate extinction 
coefficient based on the DNA or RNA base sequence entered in the 
Advanced section. For a custom value, enter a factor (extinction 
coefficient) by which to multiply the measured absorbance. The 
factor used for other types cannot be changed.

DNA melting point is calculated using the Melting options.

Pathlength Distance the light travels through the sample.

Click Settings in Nucleic Acid to display the Measurement tab.
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These settings are available:

Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

• Single point. Enter a wavelength value to define the endpoint for 
the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the specified 
baseline point and calculating the absorbance value on the drawn 
baseline at the specified analytical wavelength. The software 
subtracts the calculated baseline absorbance value from the 
measured absorbance value and reports the corrected absorbance

• Sloping baseline. Enter two wavelength values to define the 
endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value from 
the measured absorbance value and reports the corrected 
absorbance.

• None. Uses uncorrected data. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, 
the calculated protein concentration may be higher than the true 
value.

Component name Component to quantify.
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Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate 
Additional Results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

Select a formula from the preset list, then click the Use for 
Additional Results button.

Hold down the Ctrl or Shift keys on the keyboard while making 
multiple selections. The available formulas depend on the Formulas 
& Units Tab settings in Options.

To define a formula

1. Click the Equation Builder tab.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it from the drop-down menu and enter values for the variables.

The available formulas depend on the Formulas & Units Tab  
settings in Options.

3. Click the Use for Additional Results button.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available formulas depend on the Formulas & Units tab 
settings.

Feature Description
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Instrument Tab for Nucleic Acid

These settings are available:

Click Settings in Nucleic Acid to display the Instrument tab.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data Mode Y-axis format for acquired data.

Start Wavelength and 
End Wavelength 
(Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Integration Time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time 
(Scan only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Accessories Tab for Nucleic Acid

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Samples Tab for Nucleic Acid

These settings are available:

Click Settings in Nucleic Acid to display the Accessories tab. The available 
parameters depend on the installed accessories.

Click Settings in Nucleic Acid to display the Samples tab.

Feature Description

Samples Group Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Click the  icon to load a previously saved sample group.

Base Name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Samples Number of samples in the analysis.



3 Insight Pro Bio Applications
Nucleic Acid

112 Insight Pro Software User Guide Thermo Scientific

Unique Screen Features

The spectral display shows data for the current sample. 

These features are to the right of the spectral display:

Averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use Correction 
Factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table, or click 
the toggle for Apply Factor to All Samples.

Control Limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Feature Description

Feature Description

Type Type of analysis to perform. To the right is the factor value from the 
Type tab.

Conc. Concentration determined by multiplying the absorbance at 260 nm 
by a factor (default, 50) after correction is applied. Beer’s law is used to 
calculate the nucleic acid concentration (see Nucleic Acid 
Concentration Calculations).

A260 Absorbance at 260 nm.

A280 Absorbance at 280 nm.
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Advanced calculations

For selecting predefined formulas for additional data processing, with the results appearing in 
a calculations table at the bottom of the right pane. Options include basic math and statistics. 
The formulas can be applied to specific samples and columns of data in the sample 
measurements table or to selected rows and columns in the calculations table for the current 
workbook or template. Calculations are applied to all subsequently acquired data. Custom 
calculations are saved with the workbook or template. Available for all applications except 
DNA Melting.

To import data from a .xlsx file, select Import from the  menu. Note that only the first 
sheet from the .xlsx file will be imported. The following .xlsx objects are not supported and 
will not be imported: 3D Charts, Shapes, Images, Charts, and Symbols.

To delete the contents of a cell in the calculations table, right-click the cell and choose Delete.

To define calculations based on the samples table

1. Click  (the Advanced Calculation icon).

2. The Data tab displays the same columns and data shown on the Measurements tab. 
Changes made to selected columns on the Measurements tab are reflected in the Data 
tab. Any additional sample measurements will be added to the Data tab as well. All data 
displayed in the Data tab are read-only, and cannot be edited.

3. To copy data, select the desired cells and press CTRL+C, or right click the area and 
select Copy.

4. To paste data into the Calculation tab, select the desired cells and press CTRL+V, or right 
click the area and select Paste.

260/280 Ratio of sample absorbance at 260 nm and 280 nm, used to assess the 
purity of DNA and RNA. A ratio of about 1.8 is generally accepted as 
“pure” for DNA, about 2.0 for RNA. If either ratio is appreciably 
lower, protein, phenol or other contaminants that absorb strongly 
near 280 nm may be present. See Nucleic Acid Purity Measurements 
for more information.

260/230 Ratio of absorbance at 260 nm and 230 nm, a secondary measure of 
nucleic acid purity.

Feature Description
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5. To access the Function Wizard, select a cell and click the fx button. The Function Wizard 
dialog will appear. Supported formulas will be displayed.

6. Select the desired formula. A text field will appear to the right of the fx button with the 
selected formula entered. To specify a data range, input a colon and cell range (e.g., 
A2:A5 or A1:AN) or commas for individual cells (e.g., A1,A3,A5). Please refer to the 
description of each formula.

Making Nucleic Acid Measurements

While performing this procedure, click here for information about features to the right of the 
spectral display.

To measure nucleic acids

1. From the Insight Pro Bio Methods Window, click Nucleic Acid.

2. A settings screen will appear. After configuring the sample run with the desired settings, 
click Continue.

3. Load a blank into the instrument, then click the  button to measure it.

Once the blank is measured, the  will become available. Click it to run the first sample.

Note  Run settings can be changed later, from the Display screen.
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More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To view previously saved experiments, click the History icon on the bottom strip of the 
Insight Pro Window.

4. If only one sample will be measured, insert it.

5. Click Continue.

6. Follow any instructions that appear, such as to install a specified sample.

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:

To copy this plot, right-click it and choose Copy to Clipboard.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation. See Data Display for more information.)

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

Oligo Calculator

Use the Advanced section in the Type tab of the Nucleic Acid Settings window to calculate 
molecular weight, extinction coefficients, concentration factors and melting points for specific 
nucleic acid sequences. Clicking this button displays:
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To use the Oligo Calculator 

1. Enter a base sequence on the Oligo Calculator tab by:

• Using the A, C, G, T and U buttons below the Oligo calculation field

• Using the A, C, G, T and U keys on the keyboard

• Copying and pasting a base sequence (A, C, G, T and U only) from another 
application into the Oligo calculation field

To clear the sequence, click Clear. Individual bases can be deleted only manually.

2. Select the nucleic acid type to analyze.

3. Select the degree of phosphorylation if applicable: Mono-Phosphate for DNA; Mono- or 
Tri-Phosphate for RNA.

4. Select Double-stranded if applicable. The complementary base sequence will be 
included in the analysis.

5. Enter the molecular weights of any additions to the base sequence under the 
Modification option.

The calculated results appear:

To calculate the melting point of a DNA sequence

1. Enter the base sequence into the Oligo calculation field.

Tab Description

Oligo Calculator For entering sequences of interest and selecting appropriate sample type 
variables.

Melting Displays the calculated melting points of a DNA strand. Available only 
for DNA sequences.

Result Description

Molecular Weight Calculated base sequence molecular weight.

Molar Extinction 
Coefficient

Calculated 260 nm extinction coefficient in ng-cm/microliter.

Concentration Factor Factor, based on the extinction coefficient, used to calculate the 
concentration of the base sequence.

Number of Bases Number of bases in the entered sequence.

%GC Percentage of the total number of bases made up by guanine 
and cytosine.
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2. Enter the appropriate values in the Melting section:

The calculated results appear:

Parameter Description

Oligo Molarity Concentration of the Oligo in molar units.

Cation Molarity Concentration of cations in the sample.

%Formamide Percentage concentration of formamide in the sample.

Result Description

Salt-Adjusted Calculated melting point of the base sequence, corrected for the 
concentration of cation in the sample. This method does not 
account for the effect of interaction between neighboring bases.

Nearest-Neighbor Melting point of the base sequence when the effect of interaction 
between neighboring bases is taken into account.
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Nucleic Acid Labels

Overview

Application Settings

The follow tabs of settings are available:
Type Tab for Nucleic Acid Labels
Measurement Tab for Nucleic Acid Labels
Instrument Tab for Nucleic Acid Labels
Accessories Tab for Nucleic Acid Labels
Samples Tab for Nucleic Acid Labels

Type Tab for Nucleic Acid Labels

These settings are available:

Use the Nucleic Acid Labels application to measure nucleic acid 
samples for concentration and purity.

To set data acquisition parameters for a Nucleic Acid Labels workbook, click 
Settings.

Click Settings in Nucleic Acid Labels to display the Type tab.
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Measurement Tab for Nucleic Acid Labels

Feature Description

Description (optional) Description of the template.

Nucleic Acid Labels 
Type

Type of analysis to perform.

ssDNA is for single-stranded DNA.

Oligo DNA and Oligo RNA use the appropriate extinction 
coefficient based on the entered DNA or RNA base sequence. The 
entry will appear on the Oligo Calculator tab.

For Custom, enter a factor (extinction coefficient) by which to 
multiply the measured absorbance. The factor used for other types 
cannot be changed.

Set Dye 1 and Dye 2 to the fluorescent dyes whose absorbance will 
be used in concentration correction calculations.

Pathlength Distance the light travels through the sample.

Click Settings in Nucleic Acid Labels to display the Measurement tab.
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These settings are available:

Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

• Single point. Enter a wavelength value to define the endpoint for 
the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the specified 
baseline point and calculating the absorbance value on the drawn 
baseline at the specified analytical wavelength. The software 
subtracts the calculated baseline absorbance value from the 
measured absorbance value and reports the corrected absorbance

• Sloping baseline. Enter two wavelength values to define the 
endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value from 
the measured absorbance value and reports the corrected 
absorbance.

• None. Uses uncorrected data. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, 
the calculated protein concentration may be higher than the true 
value.

Component name Component to quantify.
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Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

Select a formula from the preset list, then click the Use for 
Additional Results button.

Hold down the Ctrl or Shift keys on the keyboard while making 
multiple selections. The available formulas depend on the Formulas 
& Units Tab settings in Options.

To define a formula

1. Click the Equation Builder tab.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it from the drop-down menu and enter values for the variables.

The available formulas depend on the Formulas & Units Tab  
settings in Options.

3. Click the Use for Additional Results button.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available formulas depend on the Formulas & Units tab settings.

Feature Description
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Instrument Tab for Nucleic Acid Labels

These settings are available:

Click Settings in Nucleic Acid Labels to display the Instrument tab.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data Mode Y-axis format for acquired data.

Start Wavelength and 
End Wavelength (Scan 
only)

Starting and ending values of the wavelength range for acquiring 
data.

Integration Time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time 
(Scan only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Accessories Tab for Nucleic Acid Labels

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Samples Tab for Nucleic Acid Labels

These settings are available:

Click Settings in Nucleic Acid Labels to display the Accessories tab. The available 
parameters depend on the installed accessories.

Click Settings in Nucleic Acid Labels to display the Samples tab.

Feature Description

Samples Group Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Click the  icon to load a previously saved sample group.

Base Name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Samples Number of samples in the analysis.

Averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.
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Unique Screen Features

The spectral display shows data for the current sample. 

These features are to the right of the spectral display:

Control Limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Use Correction 
Factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table, or click 
the toggle for Apply Factor to All Samples.

Feature Description

Feature Description

Type Type of analysis to perform. To the right is the factor value from the 
Type tab.

Conc. Concentration based on absorbance at 260 nm, the default or 
user-defined extinction coefficient, and the specified pathlength. (The 
extinction coefficient is reported for a 10 mm pathlength.) Beer’s law 
is used to calculate the nucleic acid concentration (see Nucleic Acid 
Concentration Calculations).

The displayed A260 value is baseline corrected. The A260 value 
actually used to calculate the concentration takes into account the 
appropriate dye correction factors and any absorbance correction due 
to the selected analysis correction wavelength.

A260 Absorbance at 260 nm.
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Advanced calculations

For selecting predefined formulas for additional data processing, with the results appearing in 
a calculations table at the bottom of the right pane. Options include basic math and statistics. 
The formulas can be applied to specific samples and columns of data in the sample 
measurements table or to selected rows and columns in the calculations table for the current 
workbook or template. Calculations are applied to all subsequently acquired data. Custom 
calculations are saved with the workbook or template. Available for all applications except 
DNA Melting.

To import data from a .xlsx file, select Import from the  menu. Note that only the first 
sheet from the .xlsx file will be imported. The following .xlsx objects are not supported and 
will not be imported: 3D Charts, Shapes, Images, Charts, and Symbols.

To delete the contents of a cell in the calculations table, right-click the cell and choose Delete.

To define calculations based on the samples table

1. Click  (the Advanced Calculation icon).

2. The Data tab displays the same columns and data shown on the Measurements tab. 
Changes made to selected columns on the Measurements tab are reflected in the Data 
tab. Any additional sample measurements will be added to the Data tab as well. All data 
displayed in the Data tab are read-only, and cannot be edited.

3. To copy data, select the desired cells and press CTRL+C, or right click the area and 
select Copy.

4. To paste data into the Calculation tab, select the desired cells and press CTRL+V, or right 
click the area and select Paste.

260/280 Ratio of sample absorbance at 260 nm and 280 nm, used to assess the 
purity of DNA and RNA. A ratio of ~1.8 is generally accepted as 
“pure” for DNA, ~2.0 for RNA. If either ratio is appreciably lower, 
protein, phenol or other contaminants that absorb strongly near 
280 nm may be present. See Nucleic Acid Purity Measurements for 
more information.

Dye(s) Conc. Concentration of the user-selected dye(s).

The software automatically subtracts the value of a sloping baseline 
from 400 to 750 nm from the absorbance at the Dye wavelength. 
Only the corrected absorbance of the dye peak(s) and dye 
concentration(s) are reported.

Feature Description
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5. To access the Function Wizard, select a cell and click the fx button. The Function Wizard 
dialog will appear. Supported formulas will be displayed.

6. Select the desired formula. A text field will appear to the right of the fx button with the 
selected formula entered. To specify a data range, input a colon and cell range (e.g., 
A2:A5 or A1:AN) or commas for individual cells (e.g., A1,A3,A5). Please refer to the 
description of each formula.

Making Nucleic Acid Labels Measurements

While performing this procedure, click here for information about features to the right of the 
spectral display.

To make a Nucleic Acid Labels measurement

1. From the Insight Pro Bio Methods Window, click Nucleic Acid Labels.

2. A settings screen will appear. After configuring the sample run with the desired settings, 
click Continue.

3. Load a blank into the instrument, then click the  button to measure it.

4. Once the blank is measured, the  will become available. Click it to run the 
first sample.

Note  Run settings can be changed later, from the Display screen.
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More:

If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To view previously saved experiments, click the History icon on the bottom strip of the 
Insight Pro Window.

5. If only one sample will be measured, insert it.

6. Click Continue.

7. Follow any instructions that appear, such as to install a specified sample.

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:

To copy this plot, right-click it and choose Copy to Clipboard.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation. See Data Display for more information.)

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).

Note  Use a fresh aliquot of sample for each measurement.
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After the Measurement

• When using the cuvette option, remove the cuvette, rinse thoroughly and dry between 
samples.

Oligo Calculator

Use the Advanced section in the Type tab of the Nucleic Acid Settings window to calculate 
molecular weight, extinction coefficients, concentration factors and melting points for specific 
nucleic acid sequences. Clicking this button displays:

To use the Oligo Calculator 

1. Enter a base sequence on the Oligo Calculator tab by:

• Using the A, C, G, T and U buttons below the Oligo calculation field

• Using the A, C, G, T and U keys on the keyboard

• Copying and pasting a base sequence (A, C, G, T and U only) from another 
application into the Oligo calculation field

To clear the sequence, click Clear. Individual bases can be deleted only manually.

2. Select the nucleic acid type to analyze.

3. Select the degree of phosphorylation if applicable: Mono-Phosphate for DNA; Mono- or 
Tri-Phosphate for RNA.

4. Select Double-stranded if applicable. The complementary base sequence will be 
included in the analysis.

5. Enter the molecular weights of any additions to the base sequence under the 
Modification option.

The calculated results appear:

Tab Description

Oligo Calculator For entering sequences of interest and selecting appropriate sample type 
variables.

Melting Displays the calculated melting points of a DNA strand. Available only 
for DNA sequences.

Result Description

Molecular Weight Calculated base sequence molecular weight.

Molar Extinction 
Coefficient

Calculated 260 nm extinction coefficient in ng-cm/microliter.

Concentration Factor Factor, based on the extinction coefficient, used to calculate the 
concentration of the base sequence.



 3 Insight Pro Bio Applications
Nucleic Acid Labels

Thermo Scientific Insight Pro Software User Guide 129

To calculate the melting point of a DNA sequence

1. Enter the base sequence into the Oligo calculation field.

2. Enter the appropriate values in the Melting section:

The calculated results appear:

Number of Bases Number of bases in the entered sequence.

%GC Percentage of the total number of bases made up by guanine 
and cytosine.

Parameter Description

Oligo molarity Concentration of the Oligo in molar units.

Cation molarity Concentration of cations in the sample.

% Formamide Percentage concentration of formamide in the sample.

Result Description

Salt-adjusted Calculated melting point of the base sequence, corrected for the 
concentration of cation in the sample. This method does not 
account for the effect of interaction between neighboring bases.

Nearest-neighbor Melting point of the base sequence when the effect of interaction 
between neighboring bases is taken into account.

Result Description
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Protein A280

Overview

Tyrosine, tryptophan, phenylalanine and to a small extent lysine and Cys-Cys disulphide 
bonds have an absorbance peak around 280 nm. This method does not require generation of 
a standard curve and is ready for protein sample quantitation at software startup. Colorimetric 
assays such as Pierce BCA, Pierce 660 nm, Bradford and Lowry are more commonly used for 
uncharacterized protein solutions and cell lysates.

The Protein A280 application displays the UV spectrum, measures the protein’s absorbance at 
280 nm (A280), and calculates the concentration (mg/ml).

Application Settings

The follow tabs of settings are available:
Type Tab for Protein A280
Measurement Tab for Protein A280
Instrument Tab for Protein A280
Accessories Tab for Protein A280
Samples Tab for Protein A280

Type Tab for Protein A280

The Protein A280 method is used to quantify proteins on the basis of 
their absorbance at 280 nm.

To set data acquisition parameters for a Protein A280 workbook, click Settings.

Click Settings in Protein A280 to display the Type tab.
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These settings are available:

Measurement Tab for Protein A280

Feature Description

Description (optional) Description of the template.

Protein A280 Type Type of analysis to perform.

1 Abs = 1 mg / mL is a general reference setting based on a 0.1% 
(1 mg/ml) protein solution. It produces an absorbance of 1.0 A at 
280 nm (where the pathlength is 10 mm, or 1 cm).

BSA is a Bovine Serum Albumin reference. Protein concentrations 
are calculated using the mass extinction coefficient of 6.7 at 
280 nm for a 1% (10 mg/ml) BSA solution.

IgG is an IgG reference. Protein concentrations are calculated using 
the mass extinction coefficient of 13.7 at 280 nm for a 1% 
(10 mg/ml) IgG solution.

For Lysozyme, protein concentrations are calculated using the mass 
extinction coefficient of 26.4 at 280 nm for a 1% (10 mg/ml) 
Lysozyme solution.

Other protein (ε & MW) is the entered molar extinction 
coefficient (M-1 cm-1) and molecular weight (MW) in kilodaltons 
(kDa) for the respective protein reference. The maximum values are 
99999000 for ε and 9999000 for MW.

Other protein (ε 1%) is the mass extinction coefficient (l g-1 cm-1) 
for a 10 mg/ml (1%) solution of the respective reference protein. 
Enter an ε/1000 value.

Pathlength Distance the light travels through the sample.

Click Settings in Protein A280 to display the Measurement tab.
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These settings are available:

Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

• Single point. Enter a wavelength value to define the endpoint for 
the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the specified 
baseline point and calculating the absorbance value on the drawn 
baseline at the specified analytical wavelength. The software 
subtracts the calculated baseline absorbance value from the 
measured absorbance value and reports the corrected absorbance

• Sloping baseline. Enter two wavelength values to define the 
endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value from 
the measured absorbance value and reports the corrected 
absorbance.

• None. Uses uncorrected data. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, 
the calculated protein concentration may be higher than the true 
value.

Component name Component to quantify.
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Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

Select a formula from the preset list, then click the Use for 
Additional Results button.

Hold down the Ctrl or Shift keys on the keyboard while making 
multiple selections. The available formulas depend on the Formulas 
& Units Tab settings in Options.

To define a formula

1. Click the Equation Builder tab.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it from the drop-down menu and enter values for the variables.

The available formulas depend on the Formulas & Units Tab  
settings in Options.

3. Click the Use for Additional Results button.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available formulas depend on the Formulas & Units tab settings.

Feature Description
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Instrument Tab for Protein A280

These settings are available:

Click Settings in Protein A280 to display the Instrument tab.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data Mode Y-axis format for acquired data.

Start Wavelength and 
End Wavelength 
(Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Integration Time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time 
(Scan only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Accessories Tab for Protein A280

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Samples Tab for Protein A280

These settings are available:

Click Settings in Protein A280 to display the Accessories tab. The available 
parameters depend on the installed accessories.

Click Settings in Protein A280 to display the Samples tab.

Feature Description

Samples Group Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Click the  icon to load a previously saved sample group.

Base Name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Samples Number of samples in the analysis.
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Unique Screen Features

The spectral display shows data for the current sample. 

These features are to the right of the spectral display:

Averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Control Limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Use Correction 
Factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table, or click 
the toggle for Apply Factor to All Samples.

Feature Description

Feature Description

Type Type of analysis to perform.

ε/1000 and Molecular 
Weight (kDa)

ε/1000 and molecular weight for the Other protein 
(ε & MW) sample type.

Ext. Coeff, ε 1% (L/g-cm) Extinction coefficient and ε 1% for the Other protein 
(ε 1%) sample type.

Conc. Concentration based on absorbance at 280 nm, after 
correction is applied, and the selected extinction coefficient.
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Advanced calculations

For selecting predefined formulas for additional data processing, with the results appearing in 
a calculations table at the bottom of the right pane. Options include basic math and statistics. 
The formulas can be applied to specific samples and columns of data in the sample 
measurements table or to selected rows and columns in the calculations table for the current 
workbook or template. Calculations are applied to all subsequently acquired data. Custom 
calculations are saved with the workbook or template. Available for all applications except 
DNA Melting.

To import data from a .xlsx file, select Import from the  menu. Note that only the first 
sheet from the .xlsx file will be imported. The following .xlsx objects are not supported and 
will not be imported: 3D Charts, Shapes, Images, Charts, and Symbols.

To delete the contents of a cell in the calculations table, right-click the cell and choose Delete.

To define calculations based on the samples table

1. Click  (the Advanced Calculation icon).

2. The Data tab displays the same columns and data shown on the Measurements tab. 
Changes made to selected columns on the Measurements tab are reflected in the Data 
tab. Any additional sample measurements will be added to the Data tab as well. All data 
displayed in the Data tab are read-only, and cannot be edited.

3. To copy data, select the desired cells and press CTRL+C, or right click the area and 
select Copy.

4. To paste data into the Calculation tab, select the desired cells and press CTRL+V, or right 
click the area and select Paste.

A280 Absorbance at 280 nm for the protein sample being 
measured.

260/280 Ratio of absorbance at 260 nm and 280 nm.

Feature Description
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5. To access the Function Wizard, select a cell and click the fx button. The Function Wizard 
dialog will appear. Supported formulas will be displayed.

6. Select the desired formula. A text field will appear to the right of the fx button with the 
selected formula entered. To specify a data range, input a colon and cell range (e.g., 
A2:A5 or A1:AN) or commas for individual cells (e.g., A1,A3,A5). Please refer to the 
description of each formula.

Making Protein A280 Measurements

While performing this procedure, click here for information about features to the right of the 
spectral display.

To make a Protein A280 measurement

1. From the Insight Pro Bio Methods Window, click Protein A280.

2. A settings screen will appear. After configuring the sample run with the desired settings, 
click Continue.

3. Load a blank into the instrument, then click the  button to measure it.

4. Once the blank is measured, the  will become available. Click it to run the 
first sample.

More:

Note  Run settings can be changed later, from the Display screen.
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If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To view previously saved experiments, click the History icon on the bottom strip of the 
Insight Pro Window.

5. If only one sample will be measured, insert it.

6. Click Continue.

7. Follow any instructions that appear, such as to install a specified sample.

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:

To copy this plot, right-click it and choose Copy to Clipboard.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation. See Data Display for more information.)

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).
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Proteins & Labels

Overview

Application Settings

The follow tabs of settings are available:
Type Tab for Proteins and Labels
Measurement Tab for Proteins and Labels
Instrument Tab for Proteins and Labels
Accessories Tab for Proteins and Labels
Samples Tab for Proteins and Labels

Type Tab for Proteins and Labels

The Proteins & Labels application determines protein concentration 
using the protein’s intrinsic absorption at 280 nm as well as the 
concentration of a fluorescent dye modification (protein array 
conjugates). It can also measure the purity of metalloproteins (such as 
hemoglobin) using wavelength ratios.

To set data acquisition parameters for a Proteins & Labels workbook, click 
Settings.

Click Settings in Proteins & Labels to display the Type tab.
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These settings are available:

Feature Description

Description (optional) Description of the template.

Proteins & Labels Type Type of analysis to perform.

1 Abs = 1 mg / mL is a general reference setting based on a 0.1% 
(1 mg/ml) protein solution. It produces an absorbance of 1.0 A at 
280 nm (where the pathlength is 10 mm, or 1 cm).

BSA is a Bovine Serum Albumin reference. Protein concentrations 
are calculated using the mass extinction coefficient of 6.7 at 
280 nm for a 1% (10 mg/ml) BSA solution.

IgG is an IgG reference. Protein concentrations are calculated 
using the mass extinction coefficient of 13.7 at 280 nm for a 1% 
(10 mg/ml) IgG solution.

For Lysozyme, protein concentrations are calculated using the 
mass extinction coefficient of 26.4 at 280 nm for a 1% 
(10 mg/ml) Lysozyme solution.

Other protein (ε & MW) is the entered molar extinction 
coefficient (M-1 cm-1) and molecular weight (MW) in kilodaltons 
(kDa) for the respective protein reference. The maximum values 
are 99999 X 1000 for ε and 9999 X 1000 for MW

Other protein (ε 1%) is the mass extinction coefficient 
(l g-1 cm-1) for a 10 mg/ml (1%) solution of the respective 
reference protein.

Dye 1 and Dye 2 Fluorescent dyes whose absorbance will be used in concentration 
correction calculations.

Pathlength Distance the light travels through the sample.
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Measurement Tab for Proteins and Labels

Click Settings in Proteins & Labels to display the Measurement tab.
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These settings are available:

Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

• Single point. Enter a wavelength value to define the endpoint for 
the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the specified 
baseline point and calculating the absorbance value on the drawn 
baseline at the specified analytical wavelength. The software 
subtracts the calculated baseline absorbance value from the 
measured absorbance value and reports the corrected absorbance

• Sloping baseline. Enter two wavelength values to define the 
endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value from 
the measured absorbance value and reports the corrected 
absorbance.

• None. Uses uncorrected data. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, 
the calculated protein concentration may be higher than the true 
value.

Component name Component to quantify.
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Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

Select a formula from the preset list, then click the Use for 
Additional Results button.

Hold down the Ctrl or Shift keys on the keyboard while making 
multiple selections. The available formulas depend on the Formulas 
& Units Tab settings in Options.

To define a formula

1. Click the Equation Builder tab.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it from the drop-down menu and enter values for the variables.

The available formulas depend on the Formulas & Units Tab 
settings in Options.

3. Click the Use for Additional Results button.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available formulas depend on the Formulas & Units tab settings.

Feature Description
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Instrument Tab for Proteins and Labels

These settings are available:

Click Settings in Proteins & Labels to display the Instrument tab.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data Mode Y-axis format for acquired data.

Start Wavelength and 
End Wavelength 
(Scan only)

Starting and ending values of the wavelength range for acquiring 
data.

Integration Time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time 
(Scan only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.
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Accessories Tab for Proteins and Labels

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Samples Tab for Proteins and Labels

These settings are available:

Click Settings in Proteins & Labels to display the Accessories tab. The available 
parameters depend on the installed accessories.

Click Settings in Proteins & Labels to display the Samples tab.

Feature Description

Samples Group Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Click the  icon to load a previously saved sample group.

Samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.
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Unique Screen Features

The spectral display shows data for the current sample. 

These features are to the right of the spectral display:

Use Correction 
Factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result.Enter the desired factor for each sample in the table, or click the 
toggle for Apply Factor to All Samples.

Control Limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Feature Description

Feature Description

Type Type of analysis to perform.

ε/1000 and Molecular Weight 
(kDa)

ε/1000 and molecular weight for the Other protein 
(ε & MW) sample type.

Ext. Coeff, ε 1% (L/g-cm) Extinction coefficient and ε 1% for the Other protein 
(ε 1%) sample type.
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Advanced calculations

For selecting predefined formulas for additional data processing, with the results appearing in 
a calculations table at the bottom of the right pane. Options include basic math and statistics. 
The formulas can be applied to specific samples and columns of data in the sample 
measurements table or to selected rows and columns in the calculations table for the current 
workbook or template. Calculations are applied to all subsequently acquired data. Custom 
calculations are saved with the workbook or template. Available for all applications except 
DNA Melting.

To import data from a .xlsx file, select Import from the  menu. Note that only the first 
sheet from the .xlsx file will be imported. The following .xlsx objects are not supported and 
will not be imported: 3D Charts, Shapes, Images, Charts, and Symbols.

To delete the contents of a cell in the calculations table, right-click the cell and choose Delete.

To define calculations based on the samples table

1. Click  (the Advanced Calculation icon).

2. The Data tab displays the same columns and data shown on the Measurements tab. 
Changes made to selected columns on the Measurements tab are reflected in the Data 
tab. Any additional sample measurements will be added to the Data tab as well. All data 
displayed in the Data tab are read-only, and cannot be edited.

3. To copy data, select the desired cells and press CTRL+C, or right click the area and 
select Copy.

4. To paste data into the Calculation tab, select the desired cells and press CTRL+V, or right 
click the area and select Paste.

Conc. Concentration based on absorbance at 280 nm, after 
correction is applied, and the selected extinction 
coefficient.

Dye(s) Conc. Concentration of the user-selected dye(s).

The software automatically subtracts the value of a sloping 
baseline from 400 to 750 nm from the absorbance at the 
Dye wavelength. Only the corrected absorbance of the dye 
peak(s) and dye concentration(s) are reported.

Feature Description
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5. To access the Function Wizard, select a cell and click the fx button. The Function Wizard 
dialog will appear. Supported formulas will be displayed.

6. Select the desired formula. A text field will appear to the right of the fx button with the 
selected formula entered. To specify a data range, input a colon and cell range (e.g., 
A2:A5 or A1:AN) or commas for individual cells (e.g., A1,A3,A5). Please refer to the 
description of each formula.

Making Proteins and Labels Measurements

While performing this procedure, click here for information about features to the right of the 
spectral display.

To make a Proteins and Labels measurement

1. From the Insight Pro Bio Methods Window, click Protein & Labels.

2. A settings screen will appear. After configuring the sample run with the desired settings, 
click Continue.

3. Load a blank into the instrument, then click the  button to measure it.

4. Once the blank is measured, the  will become available. Click it to run the 
first sample.

More:

Note  Run settings can be changed later, from the Display screen.
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If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To view previously saved experiments, click the History icon on the bottom strip of the 
Insight Pro Window.

5. If only one sample will be measured, insert it.

6. Click Continue.

7. Follow any instructions that appear, such as to install a specified sample.

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:

To copy this plot, right-click it and choose Copy to Clipboard.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation. See Data Display for more information.)

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

The A280 value in the result table is the value using the absorbance at 750 nm as the 
baseline. The A280 value used to calculate the protein concentration takes into account 
the appropriate dye correction factors and any absorbance correction due to the selected 
analysis correction nm. Therefore, the displayed A280 value is not the value used to 
calculate the sample concentration.

To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).
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Pierce BCA

Overview

Application Settings

The follow tabs of settings are available:
Type Tab for Pierce BCA
Measurement Tab for Pierce BCA
Standards Tab for Pierce BCA
Instrument Tab for Pierce BCA
Accessories Tab for Pierce BCA
Samples Tab for Pierce BCA

Type Tab for Pierce BCA

The BCA Protein Assay, which was patented by Pierce Biotechnology, 
part of Thermo Fisher Scientific, remains a cornerstone for accurately 
measuring protein concentration in biological samples. The method 
uses bicinchoninic acid (BCA) as the detection reagent for Cu+, which 
is formed when Cu2+ is reduced by protein in an alkaline 
environment. A purple-colored reaction product is formed by the 
chelation of two molecules of BCA with one cuprous ion (Cu+). The 
resulting Cu-BCA chelate formed in the presence of protein is 
measured at 562 nm. While this assay is linear over a wide 
concentration range, the calibration curves are best represented as 
second order. Preformulated reagents of BCA and CuSO4 are available 
in kit form from us.

To set data acquisition parameters for a Pierce BCA workbook, click Settings.

Click Settings in Pierce BCA to display the Type tab.
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These settings are available:

Feature Description

Description (optional) Description of the template.

Quant Type Type of analysis to perform.

Manually entered Factor

Measure single standard

Standard Curve

Standard curve with two wavelengths

Advanced standard curve

Pathlength Distance the light travels through the sample.
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Measurement Tab for Pierce BCA

Click Settings in Pierce BCA to display the Measurement tab.
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These settings are available:

Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

• Single point. Enter a wavelength value to define the endpoint for 
the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the specified 
baseline point and calculating the absorbance value on the drawn 
baseline at the specified analytical wavelength. The software 
subtracts the calculated baseline absorbance value from the 
measured absorbance value and reports the corrected absorbance

• Sloping baseline. Enter two wavelength values to define the 
endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value from 
the measured absorbance value and reports the corrected 
absorbance.

• None. Uses uncorrected data. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, 
the calculated protein concentration may be higher than the true 
value.

Component name Component to quantify.
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Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

Select a formula from the preset list, then click the Use for 
Additional Results button.

Hold down the Ctrl or Shift keys on the keyboard while making 
multiple selections. The available formulas depend on the Formulas 
& Units Tab settings in Options.

To define a formula

1. Click the Equation Builder tab.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it from the drop-down menu and enter values for the variables.

The available formulas depend on the Formulas & Units Tab 
settings in Options.

3. Click the Use for Additional Results button.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available formulas depend on the Formulas & Units tab settings.

Feature Description
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Standards Tab for Pierce BCA

These settings are available:

Click Settings in Pierce BCA to display the Standards tab.

Feature Description

Standards Group Select the standards group or create a new group.

Curve Type Type of equation used to create the standard curve from 
standard concentration values.

Minimum r2 The r2 value indicates how well the standard curve fits the 
standard data points, with 1.0 a perfect fit. If Minimum r2 is 
selected, samples can be quantified only after that value is 
achieved for the standard curve.

Standard Averaging Whether and how to average concentration values from 
multiple measurements of the same standard or from multiple 
standards prepared under the same conditions. To average 
multiple measurements of the same standard, select Replicate 
and set Number of replicates to the total number of 
measurements. To average values from two or three similar 
standards, select Duplicate or Triplicate, respectively.

Calculate from 
weight/volume

If available for the current unit, calculates concentration when 
the weight and volume of material used to prepare each standard 
is known. Enter the weight and volume for each standard in the 
appropriate table cells, or enter it later as part of running an 
analysis.



 3 Insight Pro Bio Applications
Pierce BCA

Thermo Scientific Insight Pro Software User Guide 157

Instrument Tab for Pierce BCA

These settings are available:

Use Correction Factor If available and selected, specifies a multiplication factor for 
each standard. Can be used to correct for standard properties 
(percent purity, water content, etc.) or preparation steps that 
affect the measured result such as a dilution.

When this option is selected, two columns are added to the 
standards table: Correction Factor and Corrected 
Concentration. In the Correction Factor column, enter the 
desired factor for each standard in the table. The values in the 
Corrected Concentration column are used to create the 
calibration curve. If a report is generated that includes 
information about the standards, the report will also include the 
correction factors and corrected concentrations.

Standards Table Each standard and its concentration is listed in a user-defined 
table.

Feature Description

Click Settings in Pierce BCA to display the Instrument tab.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data Mode Y-axis format for acquired data.

Start Wavelength and 
End Wavelength 
(Scan only)

Starting and ending values of the wavelength range for acquiring 
data.
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Accessories Tab for Pierce BCA

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Samples Tab for Pierce BCA

Integration Time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time 
(Scan only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.

Feature Description

Click Settings in Pierce BCA to display the Accessories tab. The available 
parameters depend on the installed accessories.

Click Settings in Pierce BCA to display the Samples tab.
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These settings are available:

Feature Description

Samples Group Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Click the  icon to load a previously saved sample group.

Samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use Correction 
Factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table, or click 
the toggle for Apply Factor to All Samples.

Control Limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.
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Unique Screen Features

The spectral display shows data for the current sample. 

Advanced calculations

For selecting predefined formulas for additional data processing, with the results appearing in 
a calculations table at the bottom of the right pane. Options include basic math and statistics. 
The formulas can be applied to specific samples and columns of data in the sample 
measurements table or to selected rows and columns in the calculations table for the current 
workbook or template. Calculations are applied to all subsequently acquired data. Custom 
calculations are saved with the workbook or template. Available for all applications except 
DNA Melting.

To import data from a .xlsx file, select Import from the  menu. Note that only the first 
sheet from the .xlsx file will be imported. The following .xlsx objects are not supported and 
will not be imported: 3D Charts, Shapes, Images, Charts, and Symbols.

To delete the contents of a cell in the calculations table, right-click the cell and choose Delete.

To define calculations based on the samples table

1. Click  (the Advanced Calculation icon).

2. The Data tab displays the same columns and data shown on the Measurements tab. 
Changes made to selected columns on the Measurements tab are reflected in the Data 
tab. Any additional sample measurements will be added to the Data tab as well. All data 
displayed in the Data tab are read-only, and cannot be edited.

3. To copy data, select the desired cells and press CTRL+C, or right click the area and 
select Copy.

4. To paste data into the Calculation tab, select the desired cells and press CTRL+V, or right 
click the area and select Paste.
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5. To access the Function Wizard, select a cell and click the fx button. The Function Wizard 
dialog will appear. Supported formulas will be displayed.

6. Select the desired formula. A text field will appear to the right of the fx button with the 
selected formula entered. To specify a data range, input a colon and cell range (e.g., 
A2:A5 or A1:AN) or commas for individual cells (e.g., A1,A3,A5). Please refer to the 
description of each formula.

Making Pierce BCA Measurements

While performing this procedure, click here for information about features to the right of the 
spectral display.

To make a Pierce BCA measurement

1. From the Insight Pro Bio Methods Window, click Pierce BCA.

2. A settings screen will appear. After configuring the sample run with the desired settings, 
click Continue.

3. Load a blank into the instrument, then click the  button to measure it.

4. Once the blank is measured, the  will become available. Click it to run the 
first sample.

More:

Note  Run settings can be changed later, from the Display screen.
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If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To view previously saved experiments, click the History icon on the bottom strip of the 
Insight Pro Window.

5. After the Blank has been measured, the software will prompt for standards measurement.

6. Define the number of standards and load them.

7. Follow any instructions that appear for measuring standards and samples.

The Standard Curve(s) tab shows graphically the relationship between the standard curve, 
measured spectral intensity, and calculated concentration for the selected sample: A 
horizontal line connects the sample spectral intensity value on the Y-axis to the standard 
curve. A vertical line connects that point to the sample concentration value on the X-axis.

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:

To copy this plot, right-click it and choose Copy to Clipboard.
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The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation. See Data Display for more information.)

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

The A280 value in the result table is the value using the absorbance at 750 nm as the 
baseline. The A280 value used to calculate the protein concentration takes into account 
the appropriate dye correction factors and any absorbance correction due to the selected 
analysis correction nm. Therefore, the displayed A280 value is not the value used to 
calculate the sample concentration.

To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).
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Protein Bradford

Overview

This assay is commonly used for determining protein concentration. It is often used for more 
dilute protein solutions where lower detection sensitivity is needed and/or in the presence of 
components that also have significant UV (280 nm) absorbance. Like the other colorimetric 
assays, the Bradford assay requires generating a standard curve before measuring sample 
proteins. 

The Bradford procedure uses the protein-induced absorbance shift of Coomassie Blue dye to 
595 nm to measure protein concentration. The bound protein-dye complex is measured at 
595 nm and normalized at 750 nm. A single stabilized reagent mixture containing Coomassie 
Blue dye, alcohol, and surfactant in kit form is available from numerous manufacturers.

Application Settings

The follow tabs of settings are available:
Type Tab for Protein Bradford
Measurement Tab for Protein Bradford
Standards Tab for Protein Bradford
Instrument Tab for Protein Bradford
Accessories Tab for Protein Bradford
Samples Tab for Protein Bradford

Type Tab for Protein Bradford

The Protein Bradford assay measures absorbance at 595 nm; it 
determines concentration for either standard or micro sample 
concentrations.

To set data acquisition parameters for a Protein Bradford workbook, click Settings.

Click Settings in Protein Bradford to display the Type tab.



 3 Insight Pro Bio Applications
Protein Bradford

Thermo Scientific Insight Pro Software User Guide 165

These settings are available:

Feature Description

Description (optional) Description of the template.

Quant Type Type of analysis to perform.

Manually entered Factor

Measure single standard

Standard Curve

Standard curve with two wavelengths

Advanced standard curve

Pathlength Distance the light travels through the sample.
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Measurement Tab for Protein Bradford

Click Settings in Protein Bradford to display the Measurement tab.
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These settings are available:

Feature Description

Analysis wavelength Wavelength used for the analysis. Protein Bradford measurements are 
made at 595 nm.

Correction Specifies bichromatic normalization of the absorbance data.

• Single point. Enter a wavelength value to define the endpoint for 
the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the specified 
baseline point and calculating the absorbance value on the drawn 
baseline at the specified analytical wavelength. The software 
subtracts the calculated baseline absorbance value from the 
measured absorbance value and reports the corrected absorbance

• Sloping baseline. Enter two wavelength values to define the 
endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value from 
the measured absorbance value and reports the corrected 
absorbance.

• None. Uses uncorrected data. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, 
the calculated protein concentration may be higher than the true 
value.

Component name Component to quantify.
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Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

Select a formula from the preset list, then click the Use for 
Additional Results button.

Hold down the Ctrl or Shift keys on the keyboard while making 
multiple selections. The available formulas depend on the Formulas 
& Units Tab settings in Options.

To define a formula

1. Click the Equation Builder tab.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it from the drop-down menu and enter values for the variables.

The available formulas depend on the Formulas & Units Tab 
settings in Options.

3. Click the Use for Additional Results button.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available formulas depend on the Formulas & Units tab settings.

Feature Description
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Standards Tab for Protein Bradford

These settings are available:

Click Settings in Protein Bradford to display the Standards tab.

Feature Description

Standards Group Select the standards group or create a new group.

Curve Type Type of equation used to create the standard curve from 
standard concentration values.

Minimum r2 The r2 value indicates how well the standard curve fits the 
standard data points, with 1.0 a perfect fit. If Minimum r2 is 
selected, samples can be quantified only after that value is 
achieved for the standard curve.

Standard Averaging Whether and how to average concentration values from 
multiple measurements of the same standard or from multiple 
standards prepared under the same conditions. To average 
multiple measurements of the same standard, select Replicate 
and set Number of replicates to the total number of 
measurements. To average values from two or three similar 
standards, select Duplicate or Triplicate, respectively.

Calculate from 
weight/volume

If available for the current unit, calculates concentration when 
the weight and volume of material used to prepare each standard 
is known. Enter the weight and volume for each standard in the 
appropriate table cells, or enter it later as part of running an 
analysis.
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Instrument Tab for Protein Bradford

These settings are available:

Use Correction Factor If available and selected, specifies a multiplication factor for 
each standard. Can be used to correct for standard properties 
(percent purity, water content, etc.) or preparation steps that 
affect the measured result such as a dilution.

When this option is selected, two columns are added to the 
standards table: Correction Factor and Corrected 
Concentration. In the Correction Factor column, enter the 
desired factor for each standard in the table. The values in the 
Corrected Concentration column are used to create the 
calibration curve. If a report is generated that includes 
information about the standards, the report will also include the 
correction factors and corrected concentrations.

Standards Table Each standard and its concentration is listed in a user-defined 
table.

Feature Description

Click Settings in Protein Bradford to display the Instrument tab.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data Mode Y-axis format for acquired data.

Start Wavelength and 
End Wavelength 
(Scan only)

Starting and ending values of the wavelength range for acquiring 
data.
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Accessories Tab for Protein Bradford

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Samples Tab for Protein Bradford

Integration Time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time 
(Scan only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.

Feature Description

Click Settings in Protein Bradford to display the Accessories tab. The available 
parameters depend on the installed accessories.

Click Settings in Protein Bradford to display the Samples tab.



3 Insight Pro Bio Applications
Protein Bradford

172 Insight Pro Software User Guide Thermo Scientific

These settings are available:

Feature Description

Samples Group Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Click the  icon to load a previously saved sample group.

Samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use Correction 
Factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table, or click 
the toggle for Apply Factor to All Samples.

Control Limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.
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Unique Screen Features

The spectral display shows data for the current sample. 

Advanced calculations

For selecting predefined formulas for additional data processing, with the results appearing in 
a calculations table at the bottom of the right pane. Options include basic math and statistics. 
The formulas can be applied to specific samples and columns of data in the sample 
measurements table or to selected rows and columns in the calculations table for the current 
workbook or template. Calculations are applied to all subsequently acquired data. Custom 
calculations are saved with the workbook or template. Available for all applications except 
DNA Melting.

To import data from a .xlsx file, select Import from the  menu. Note that only the first 
sheet from the .xlsx file will be imported. The following .xlsx objects are not supported and 
will not be imported: 3D Charts, Shapes, Images, Charts, and Symbols.

To delete the contents of a cell in the calculations table, right-click the cell and choose Delete.

To define calculations based on the samples table

1. Click  (the Advanced Calculation icon).

2. The Data tab displays the same columns and data shown on the Measurements tab. 
Changes made to selected columns on the Measurements tab are reflected in the Data 
tab. Any additional sample measurements will be added to the Data tab as well. All data 
displayed in the Data tab are read-only, and cannot be edited.

3. To copy data, select the desired cells and press CTRL+C, or right click the area and 
select Copy.

4. To paste data into the Calculation tab, select the desired cells and press CTRL+V, or right 
click the area and select Paste.
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5. To access the Function Wizard, select a cell and click the fx button. The Function Wizard 
dialog will appear. Supported formulas will be displayed.

6. Select the desired formula. A text field will appear to the right of the fx button with the 
selected formula entered. To specify a data range, input a colon and cell range (e.g., 
A2:A5 or A1:AN) or commas for individual cells (e.g., A1,A3,A5). Please refer to the 
description of each formula.

Making Protein Bradford Measurements

While performing this procedure, click here for information about features to the right of the 
spectral display.

To make a Protein Bradford measurement

1. From the Insight Pro Bio Methods Window, click Protein Bradford.

2. A settings screen will appear. After configuring the sample run with the desired settings, 
click Continue.

3. Load a blank into the instrument, then click the  button to measure it.

4. Once the blank is measured, the  will become available. Click it to run the 
first sample.

More:

Note  Run settings can be changed later, from the Display screen.
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If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To view previously saved experiments, click the History icon on the bottom strip of the 
Insight Pro Window.

5. After the Blank has been measured, the software will prompt for standards measurement.

6. Define the number of standards and load them.

7. Follow any instructions that appear for measuring standards and samples.

The Standard Curve(s) tab shows graphically the relationship between the standard curve, 
measured spectral intensity, and calculated concentration for the selected sample: A 
horizontal line connects the sample spectral intensity value on the Y-axis to the standard 
curve. A vertical line connects that point to the sample concentration value on the X-axis.

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:

To copy this plot, right-click it and choose Copy to Clipboard.
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The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation. See Data Display for more information.)

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

The A280 value in the result table is the value using the absorbance at 750 nm as the 
baseline. The A280 value used to calculate the protein concentration takes into account 
the appropriate dye correction factors and any absorbance correction due to the selected 
analysis correction nm. Therefore, the displayed A280 value is not the value used to 
calculate the sample concentration.

To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).
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Pierce Modified Lowry

Overview

This assay is an alternative method for determining protein concentration based on the widely 
used and cited Lowry procedure for protein quantitation. Like the other colorimetric assays, 
the Lowry assay requires generating a standard curve before measuring sample proteins. 

The Pierce Modified Lowry procedure involves reaction of protein with cupric sulfate in 
alkaline solution, resulting in formation of tetradentate copper-protein complexes. The 
Folin-Ciocalteu Reagent is effectively reduced in proportion to the chelated copper 
complexes, resulting in a water-soluble blue product that is measured at 650 nm and 
normalized at 405 nm. Preformulated reagents, used in the assay, are available in kit form 
from numerous manufacturers.

Application Settings

The follow tabs of settings are available:
Type Tab for Pierce Modified Lowry
Measurement Tab for Pierce Modified Lowry
Standards Tab for Pierce Modified Lowry
Instrument Tab for Pierce Modified Lowry
Accessories Tab for Pierce Modified Lowry
Samples Tab for Pierce Modified Lowry

Type Tab for Pierce Modified Lowry

The Pierce Modified Lowry assay measures absorbance at 750 nm to 
determine concentration.

To set data acquisition parameters for a Pierce Modified Lowry workbook, click 
Settings.

Click Settings in Pierce Modified Lowry to display the Type tab.
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These settings are available:

Feature Description

Description (optional) Description of the template.

Quant Type Type of analysis to perform.

Manually entered Factor

Measure single standard

Standard Curve

Standard curve with two wavelengths

Advanced standard curve

Pathlength Distance the light travels through the sample.
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Measurement Tab for Pierce Modified Lowry

Click Settings in Pierce Modified Lowry to display the Measurement tab.
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These settings are available:

Feature Description

Analysis wavelength Wavelength used for the analysis. Modified Lowry measurements are 
made at 750 nm.

Correction Specifies bichromatic normalization of the absorbance data.

• Single point. Enter a wavelength value to define the endpoint for 
the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the specified 
baseline point and calculating the absorbance value on the drawn 
baseline at the specified analytical wavelength. The software 
subtracts the calculated baseline absorbance value from the 
measured absorbance value and reports the corrected absorbance

• Sloping baseline. Enter two wavelength values to define the 
endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value from 
the measured absorbance value and reports the corrected 
absorbance.

• None. Uses uncorrected data. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, 
the calculated protein concentration may be higher than the true 
value.

Component name Component to quantify.
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Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

Select a formula from the preset list, then click the Use for 
Additional Results button.

Hold down the Ctrl or Shift keys on the keyboard while making 
multiple selections. The available formulas depend on the Formulas 
& Units Tab settings in Options.

To define a formula

1. Click the Equation Builder tab.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it from the drop-down menu and enter values for the variables.

The available formulas depend on the Formulas & Units Tab 
settings in Options.

3. Click the Use for Additional Results button.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available formulas depend on the Formulas & Units tab settings.

Feature Description
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Standards Tab for Pierce Modified Lowry

These settings are available:

Click Settings in Pierce Modified Lowry to display the Standards tab.

Feature Description

Standards Group Select the standards group or create a new group.

Curve Type Type of equation used to create the standard curve from 
standard concentration values.

Minimum r2 The r2 value indicates how well the standard curve fits the 
standard data points, with 1.0 a perfect fit. If Minimum r2 is 
selected, samples can be quantified only after that value is 
achieved for the standard curve.

Standard Averaging Whether and how to average concentration values from 
multiple measurements of the same standard or from multiple 
standards prepared under the same conditions. To average 
multiple measurements of the same standard, select Replicate 
and set Number of replicates to the total number of 
measurements. To average values from two or three similar 
standards, select Duplicate or Triplicate, respectively.

Calculate from 
weight/volume

If available for the current unit, calculates concentration when 
the weight and volume of material used to prepare each standard 
is known. Enter the weight and volume for each standard in the 
appropriate table cells, or enter it later as part of running an 
analysis.
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Instrument Tab for Pierce Modified Lowry

These settings are available:

Use Correction Factor If available and selected, specifies a multiplication factor for 
each standard. Can be used to correct for standard properties 
(percent purity, water content, etc.) or preparation steps that 
affect the measured result such as a dilution.

When this option is selected, two columns are added to the 
standards table: Correction Factor and Corrected 
Concentration. In the Correction Factor column, enter the 
desired factor for each standard in the table. The values in the 
Corrected Concentration column are used to create the 
calibration curve. If a report is generated that includes 
information about the standards, the report will also include the 
correction factors and corrected concentrations.

Standards Table Each standard and its concentration is listed in a user-defined 
table.

Feature Description

Click Settings in Pierce Modified Lowry to display the Instrument tab.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data Mode Y-axis format for acquired data.

Start Wavelength and 
End Wavelength 
(Scan only)

Starting and ending values of the wavelength range for acquiring 
data.
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Accessories Tab for Pierce Modified Lowry

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Samples Tab for Pierce Modified Lowry

Integration Time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time 
(Scan only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.

Feature Description

Click Settings in Pierce Modified Lowry to display the Accessories tab. The 
available parameters depend on the installed accessories.

Click Settings in Pierce Modified Lowry to display the Samples tab.
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These settings are available:

Feature Description

Samples Group Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Click the  icon to load a previously saved sample group.

Samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use Correction 
Factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table, or click 
the toggle for Apply Factor to All Samples.

Control Limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.
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Unique Screen Features

The spectral display shows data for the current sample. 

Advanced calculations

For selecting predefined formulas for additional data processing, with the results appearing in 
a calculations table at the bottom of the right pane. Options include basic math and statistics. 
The formulas can be applied to specific samples and columns of data in the sample 
measurements table or to selected rows and columns in the calculations table for the current 
workbook or template. Calculations are applied to all subsequently acquired data. Custom 
calculations are saved with the workbook or template. Available for all applications except 
DNA Melting.

To import data from a .xlsx file, select Import from the  menu. Note that only the first 
sheet from the .xlsx file will be imported. The following .xlsx objects are not supported and 
will not be imported: 3D Charts, Shapes, Images, Charts, and Symbols.

To delete the contents of a cell in the calculations table, right-click the cell and choose Delete.

To define calculations based on the samples table

1. Click  (the Advanced Calculation icon).

2. The Data tab displays the same columns and data shown on the Measurements tab. 
Changes made to selected columns on the Measurements tab are reflected in the Data 
tab. Any additional sample measurements will be added to the Data tab as well. All data 
displayed in the Data tab are read-only, and cannot be edited.

3. To copy data, select the desired cells and press CTRL+C, or right click the area and 
select Copy.

4. To paste data into the Calculation tab, select the desired cells and press CTRL+V, or right 
click the area and select Paste.
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5. To access the Function Wizard, select a cell and click the fx button. The Function Wizard 
dialog will appear. Supported formulas will be displayed.

6. Select the desired formula. A text field will appear to the right of the fx button with the 
selected formula entered. To specify a data range, input a colon and cell range (e.g., 
A2:A5 or A1:AN) or commas for individual cells (e.g., A1,A3,A5). Please refer to the 
description of each formula.

Making Pierce Modified Lowry Measurements

While performing this procedure, click here for information about features to the right of the 
spectral display.

To make a Pierce Modified Lowry measurement

1. From the Insight Pro Bio Methods Window, click Pierce Modified Lowry.

2. A settings screen will appear. After configuring the sample run with the desired settings, 
click Continue.

3. Load a blank into the instrument, then click the  button to measure it.

4. Once the blank is measured, the  will become available. Click it to run the 
first sample.

More:

Note  Run settings can be changed later, from the Display screen.
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If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To view previously saved experiments, click the History icon on the bottom strip of the 
Insight Pro Window.

5. After the Blank has been measured, the software will prompt for standards measurement.

6. Define the number of standards and load them.

7. Follow any instructions that appear for measuring standards and samples.

The Standard Curve(s) tab shows graphically the relationship between the standard curve, 
measured spectral intensity, and calculated concentration for the selected sample: A 
horizontal line connects the sample spectral intensity value on the Y-axis to the standard 
curve. A vertical line connects that point to the sample concentration value on the X-axis.

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:

To copy this plot, right-click it and choose Copy to Clipboard.
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The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation. See Data Display for more information.)

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

The A280 value in the result table is the value using the absorbance at 750 nm as the 
baseline. The A280 value used to calculate the protein concentration takes into account 
the appropriate dye correction factors and any absorbance correction due to the selected 
analysis correction nm. Therefore, the displayed A280 value is not the value used to 
calculate the sample concentration.

To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).
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Pierce 660 nm Protein Assay

Overview

The proprietary dye-metal complex binds to protein in acidic conditions, causing a shift in 
the dye’s absorption maximum, which is measured at 660 nm. The complex is reddish-brown 
and turns green upon protein binding. This color change is produced by deprotonation of the 
dye at low pH facilitated by interactions with positively charged amino acid groups in the 
protein. Consequently, the complex interacts primarily with basic residues in the protein, such 
as histidine, arginine and lysine, and to a lesser extent tyrosine, tryptophan and phenylalanine.

Application Settings

The follow tabs of settings are available:
Type Tab for Pierce 660 nm Protein Assay
Measurement Tab for Pierce 660 nm Protein Assay
Standards Tab for Pierce 660 nm Protein Assay
Instrument Tab for Pierce 660 nm Protein Assay
Accessories Tab for Pierce 660 nm Protein Assay
Samples Tab for Pierce 660 nm Protein Assay

Type Tab for Pierce 660 nm Protein Assay

The Thermo Scientific Pierce 660 nm Protein Assay reagent is a 
ready-to-use formulation that offers rapid, accurate, and reproducible 
colorimetric detection of minute amounts of protein in solution. The 
reagent is ideal for measuring total protein concentration in samples 
containing reducing agents and/or detergents.

To set data acquisition parameters for a Pierce 660 nm Protein Assay workbook, 
click Settings.

Click Settings in Pierce 660 nm Protein Assay to display the Type tab.
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These settings are available:

Feature Description

Description (optional) Description of the template.

Quant Type Type of analysis to perform.

Manually entered Factor

Measure single standard

Standard Curve

Standard curve with two wavelengths

Advanced standard curve

Pathlength Distance the light travels through the sample.
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Measurement Tab for Pierce 660 nm Protein Assay

Click Settings in Pierce 660 nm Protein Assay to display the Measurement tab.
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These settings are available:

Feature Description

Analysis wavelength Wavelength used for the analysis. Pierce 660 measurements are made 
at 660 nm.

Correction Specifies bichromatic normalization of the absorbance data.

• Single point. Enter a wavelength value to define the endpoint for 
the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the specified 
baseline point and calculating the absorbance value on the drawn 
baseline at the specified analytical wavelength. The software 
subtracts the calculated baseline absorbance value from the 
measured absorbance value and reports the corrected absorbance

• Sloping baseline. Enter two wavelength values to define the 
endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value from 
the measured absorbance value and reports the corrected 
absorbance.

• None. Uses uncorrected data. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, 
the calculated protein concentration may be higher than the true 
value.

Component name Component to quantify.
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Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

Select a formula from the preset list, then click the Use for 
Additional Results button.

Hold down the Ctrl or Shift keys on the keyboard while making 
multiple selections. The available formulas depend on the Formulas 
& Units Tab settings in Options.

To define a formula

1. Click the Equation Builder tab.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it from the drop-down menu and enter values for the variables.

The available formulas depend on the Formulas & Units Tab 
settings in Options.

3. Click the Use for Additional Results button.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available formulas depend on the Formulas & Units tab settings.

Feature Description
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Standards Tab for Pierce 660 nm Protein Assay

These settings are available:

Click Settings in Pierce 660 nm Protein Assay to display the Standards tab.

Feature Description

Standards Group Select the standards group or create a new group.

Curve Type Type of equation used to create the standard curve from 
standard concentration values.

Minimum r2 The r2 value indicates how well the standard curve fits the 
standard data points, with 1.0 a perfect fit. If Minimum r2 is 
selected, samples can be quantified only after that value is 
achieved for the standard curve.

Standard Averaging Whether and how to average concentration values from 
multiple measurements of the same standard or from multiple 
standards prepared under the same conditions. To average 
multiple measurements of the same standard, select Replicate 
and set Number of replicates to the total number of 
measurements. To average values from two or three similar 
standards, select Duplicate or Triplicate, respectively.

Calculate from 
weight/volume

If available for the current unit, calculates concentration when 
the weight and volume of material used to prepare each standard 
is known. Enter the weight and volume for each standard in the 
appropriate table cells, or enter it later as part of running an 
analysis.
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Instrument Tab for Pierce 660 nm Protein Assay

These settings are available:

Use Correction Factor If available and selected, specifies a multiplication factor for 
each standard. Can be used to correct for standard properties 
(percent purity, water content, etc.) or preparation steps that 
affect the measured result such as a dilution.

When this option is selected, two columns are added to the 
standards table: Correction Factor and Corrected 
Concentration. In the Correction Factor column, enter the 
desired factor for each standard in the table. The values in the 
Corrected Concentration column are used to create the 
calibration curve. If a report is generated that includes 
information about the standards, the report will also include the 
correction factors and corrected concentrations.

Standards Table Each standard and its concentration is listed in a user-defined 
table.

Feature Description

Click Settings in Pierce 660 nm Protein Assay to display the Instrument tab.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data Mode Y-axis format for acquired data.

Start Wavelength and 
End Wavelength 
(Scan only)

Starting and ending values of the wavelength range for acquiring 
data.
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Accessories Tab for Pierce 660 nm Protein Assay

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Samples Tab for Pierce 660 nm Protein Assay

Integration Time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time 
(Scan only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.

Feature Description

Click Settings in Pierce 660 nm Protein Assay to display the Accessories tab. The 
available parameters depend on the installed accessories.

Click Settings in Pierce 660 nm Protein Assay to display the Samples tab.
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These settings are available:

Feature Description

Samples Group Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Click the  icon to load a previously saved sample group.

Samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use Correction 
Factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table, or click 
the toggle for Apply Factor to All Samples.

Use control limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.
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Unique Screen Features

The spectral display shows data for the current sample. 

Advanced calculations

For selecting predefined formulas for additional data processing, with the results appearing in 
a calculations table at the bottom of the right pane. Options include basic math and statistics. 
The formulas can be applied to specific samples and columns of data in the sample 
measurements table or to selected rows and columns in the calculations table for the current 
workbook or template. Calculations are applied to all subsequently acquired data. Custom 
calculations are saved with the workbook or template. Available for all applications except 
DNA Melting.

To import data from a .xlsx file, select Import from the  menu. Note that only the first 
sheet from the .xlsx file will be imported. The following .xlsx objects are not supported and 
will not be imported: 3D Charts, Shapes, Images, Charts, and Symbols.

To delete the contents of a cell in the calculations table, right-click the cell and choose Delete.

To define calculations based on the samples table

1. Click  (the Advanced Calculation icon).

2. The Data tab displays the same columns and data shown on the Measurements tab. 
Changes made to selected columns on the Measurements tab are reflected in the Data 
tab. Any additional sample measurements will be added to the Data tab as well. All data 
displayed in the Data tab are read-only, and cannot be edited.

3. To copy data, select the desired cells and press CTRL+C, or right click the area and 
select Copy.

4. To paste data into the Calculation tab, select the desired cells and press CTRL+V, or right 
click the area and select Paste.
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5. To access the Function Wizard, select a cell and click the fx button. The Function Wizard 
dialog will appear. Supported formulas will be displayed.

6. Select the desired formula. A text field will appear to the right of the fx button with the 
selected formula entered. To specify a data range, input a colon and cell range (e.g., 
A2:A5 or A1:AN) or commas for individual cells (e.g., A1,A3,A5). Please refer to the 
description of each formula.

Making Pierce 660 nm Protein Assay Measurements

While performing this procedure, click here for information about features to the right of the 
spectral display.

To make a Pierce 660 nm Protein Assay measurement

1. From the Insight Pro Bio Methods Window, click Pierce 660 nm Protein Assay.

2. A settings screen will appear. After configuring the sample run with the desired settings, 
click Continue.

3. Load a blank into the instrument, then click the  button to measure it.

4. Once the blank is measured, the  will become available. Click it to run the 
first sample.

More:

Note  Run settings can be changed later, from the Display screen.
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If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To view previously saved experiments, click the History icon on the bottom strip of the 
Insight Pro Window.

5. After the Blank has been measured, the software will prompt for standards measurement.

6. Define the number of standards and load them.

7. Follow any instructions that appear for measuring standards and samples.

The Standard Curve(s) tab shows graphically the relationship between the standard curve, 
measured spectral intensity, and calculated concentration for the selected sample: A 
horizontal line connects the sample spectral intensity value on the Y-axis to the standard 
curve. A vertical line connects that point to the sample concentration value on the X-axis.

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:

To copy this plot, right-click it and choose Copy to Clipboard.

The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation. See Data Display for more information.)
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The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

The A280 value in the result table is the value using the absorbance at 750 nm as the 
baseline. The A280 value used to calculate the protein concentration takes into account 
the appropriate dye correction factors and any absorbance correction due to the selected 
analysis correction nm. Therefore, the displayed A280 value is not the value used to 
calculate the sample concentration.

To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).
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Protein Biuret

Overview

Application Settings

The follow tabs of settings are available:
Type Tab for Protein Biuret
Measurement Tab for Protein Biuret
Standards Tab for Protein Biuret
Instrument Tab for Protein Biuret
Accessories Tab for Protein Biuret
Samples Tab for Protein Biuret

Type Tab for Protein Biuret

The Protein Biuret application is similar to the Pierce Modified Lowry 
application; however, it involves a single incubation and requires more 
protein for the analysis. The protein-dye complex that is formed in the 
assay has a deep purple color and is measured at 545 nm. The 
calibration curve for this assay is linear with standards that range in 
concentration from 0.5 mg/ml to 10 mg/ml.

To set data acquisition parameters for a Protein Biuret workbook, click Settings.

Click Settings in Protein Biuret to display the Type tab.
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These settings are available:

Measurement Tab for Protein Biuret

Feature Description

Description (optional) Description of the template.

Quant Type Type of analysis to perform.

Manually entered Factor

Measure single standard

Standard Curve

Standard curve with two wavelengths

Advanced standard curve

Pathlength Distance the light travels through the sample.

Click Settings in Protein Biuret to display the Measurement tab.
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These settings are available:

Feature Description

Analysis wavelength Wavelength(s) to use for the analysis.

Correction Specifies bichromatic normalization of the absorbance data.

• Single point. Enter a wavelength value to define the endpoint for 
the single point baseline.

This option generates a baseline correction for each sample 
measurement by drawing a straight line through the specified 
baseline point and calculating the absorbance value on the drawn 
baseline at the specified analytical wavelength. The software 
subtracts the calculated baseline absorbance value from the 
measured absorbance value and reports the corrected absorbance

• Sloping baseline. Enter two wavelength values to define the 
endpoints for the sloping baseline.

This option generates a baseline correction for each sample 
measurement by drawing a line between the two specified 
baseline points and calculating the absorbance value on the 
drawn baseline at the specified analytical wavelength. The 
software subtracts the calculated baseline absorbance value from 
the measured absorbance value and reports the corrected 
absorbance.

• None. Uses uncorrected data. Without baseline correction, 
spectra may be offset from the baseline. If this offset is significant, 
the calculated protein concentration may be higher than the true 
value.

Component name Component to quantify.
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Unit Component concentration unit. The available units depend on the 
Formulas & Units tab settings in Options.

Calculate additional 
results

For selecting or defining formulas for additional data processing, with 
the results appearing in the analysis report. The formulas are written 
in a form similar to that used in a command script language, with 
constants, mathematical functions, etc. All functions are not 
case-sensitive. Spaces are not allowed between a function name and 
“(”. After adding formulas, edit their information in the formula table 
as desired. To delete a table row, right-click it and choose Delete Row. 
Some information in the table cannot be modified or deleted.

Instructions:

To add one or more predefined formulas

Select a formula from the preset list, then click the Use for 
Additional Results button.

Hold down the Ctrl or Shift keys on the keyboard while making 
multiple selections. The available formulas depend on the Formulas 
& Units Tab settings in Options.

To define a formula

1. Click the Equation Builder tab.

2. To enter a formula in its entirety, set Equation type to User 
defined and type the equation. To use a provided formula, select 
it from the drop-down menu and enter values for the variables.

The available formulas depend on the Formulas & Units Tab 
settings in Options.

3. Click the Use for Additional Results button.

4. For selected provided formulas, enter a name and concentration 
unit in the table.

The available formulas depend on the Formulas & Units tab settings.

Feature Description
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Standards Tab for Protein Biuret

These settings are available:

Click Settings in Protein Biuret to display the Standards tab.

Feature Description

Standards Group Select the standards group or create a new group.

Curve Type Type of equation used to create the standard curve from 
standard concentration values.

Minimum r2 The r2 value indicates how well the standard curve fits the 
standard data points, with 1.0 a perfect fit. If Minimum r2 is 
selected, samples can be quantified only after that value is 
achieved for the standard curve.

Standard Averaging Whether and how to average concentration values from 
multiple measurements of the same standard or from multiple 
standards prepared under the same conditions. To average 
multiple measurements of the same standard, select Replicate 
and set Number of replicates to the total number of 
measurements. To average values from two or three similar 
standards, select Duplicate or Triplicate, respectively.

Calculate from 
weight/volume

If available for the current unit, calculates concentration when 
the weight and volume of material used to prepare each standard 
is known. Enter the weight and volume for each standard in the 
appropriate table cells, or enter it later as part of running an 
analysis.
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Instrument Tab for Protein Biuret

These settings are available:

Use Correction Factor If available and selected, specifies a multiplication factor for 
each standard. Can be used to correct for standard properties 
(percent purity, water content, etc.) or preparation steps that 
affect the measured result such as a dilution.

When this option is selected, two columns are added to the 
standards table: Correction Factor and Corrected 
Concentration. In the Correction Factor column, enter the 
desired factor for each standard in the table. The values in the 
Corrected Concentration column are used to create the 
calibration curve. If a report is generated that includes 
information about the standards, the report will also include the 
correction factors and corrected concentrations.

Standards Table Each standard and its concentration is listed in a user-defined 
table.

Feature Description

Click Settings in Protein Biuret to display the Instrument tab.

Feature Description

Mode Specifies Scan or Fixed data acquisition.

Data Mode Y-axis format for acquired data.

Start Wavelength and 
End Wavelength 
(Scan only)

Starting and ending values of the wavelength range for acquiring 
data.
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Accessories Tab for Protein Biuret

The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Samples Tab for Protein Biuret

Integration Time How long the system acquires and averages data at each data 
interval (for scanning measurements) or at each measured 
wavelength (for fixed-wavelength measurements). Increasing the 
integration time improves the signal-to-noise ratio but reduces 
the scan speed.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced spectral 
features.

Data interval (Scan only) Difference in wavelength between two consecutive data points.

Scan speed (Scan only) Wavelength range covered per unit time. Varies inversely with 
integration time. Increases as the data interval increases.

Estimated time 
(Scan only)

Estimated duration of data acquisition. Increases as integration 
time increases and as the data interval decreases. Varies inversely 
with scan speed.

Table of wavelengths 
(Fixed only)

Shows the analysis wavelength(s) entered on the Measurement 
tab.

Feature Description

Click Settings in Protein Biuret to display the Accessories tab. The available 
parameters depend on the installed accessories.

Click Settings in Protein Biuret to display the Samples tab.
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These settings are available:

Feature Description

Samples Group Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Click the  icon to load a previously saved sample group.

Samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Sample averaging Whether and how to average concentration values from multiple 
measurements of the same sample or from multiple samples. To 
average multiple measurements of the same sample, select Replicate 
and set Number of replicates to the total number of measurements. 
To average values from two or three samples, select Duplicate or 
Triplicate, respectively.

Use Correction 
Factor

If available and selected, specifies a multiplication factor for each 
sample result. Can be used to correct for sample properties and 
preparation steps such as a sample dilution that affects the measured 
result. Enter the desired factor for each sample in the table, or click 
the toggle for Apply Factor to All Samples.

Use control limits Displays high and low limit lines on the Run Chart tab to show 
whether sample concentrations are within the specified limits.

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.
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Unique Screen Features

The spectral display shows data for the current sample. 

Advanced calculations

For selecting predefined formulas for additional data processing, with the results appearing in 
a calculations table at the bottom of the right pane. Options include basic math and statistics. 
The formulas can be applied to specific samples and columns of data in the sample 
measurements table or to selected rows and columns in the calculations table for the current 
workbook or template. Calculations are applied to all subsequently acquired data. Custom 
calculations are saved with the workbook or template. Available for all applications except 
DNA Melting.

To import data from a .xlsx file, select Import from the  menu. Note that only the first 
sheet from the .xlsx file will be imported. The following .xlsx objects are not supported and 
will not be imported: 3D Charts, Shapes, Images, Charts, and Symbols.

To delete the contents of a cell in the calculations table, right-click the cell and choose Delete.

To define calculations based on the samples table

1. Click  (the Advanced Calculation icon).

2. The Data tab displays the same columns and data shown on the Measurements tab. 
Changes made to selected columns on the Measurements tab are reflected in the Data 
tab. Any additional sample measurements will be added to the Data tab as well. All data 
displayed in the Data tab are read-only, and cannot be edited.

3. To copy data, select the desired cells and press CTRL+C, or right click the area and 
select Copy.

4. To paste data into the Calculation tab, select the desired cells and press CTRL+V, or right 
click the area and select Paste.
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5. To access the Function Wizard, select a cell and click the fx button. The Function Wizard 
dialog will appear. Supported formulas will be displayed.

6. Select the desired formula. A text field will appear to the right of the fx button with the 
selected formula entered. To specify a data range, input a colon and cell range (e.g., 
A2:A5 or A1:AN) or commas for individual cells (e.g., A1,A3,A5). Please refer to the 
description of each formula.

Making Protein Biuret Measurements

While performing this procedure, click here for information about features to the right of the 
spectral display.

To make a Protein Biuret measurement

1. From the Insight Pro Bio Methods Window, click Protein Biuret.

2. A settings screen will appear. After configuring the sample run with the desired settings, 
click Continue.

3. Load a blank into the instrument, then click the  button to measure it.

4. Once the blank is measured, the  will become available. Click it to run the 
first sample.

More:

Note  Run settings can be changed later, from the Display screen.
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If Sample averaging on the Samples tab in Settings was set to Duplicate, “D” at the end of 
a sample name indicates the second measurement to be made of the sample. If Sample 
averaging was set to Triplicate, “D” and “T” at the end of sample names indicate the 
second and third measurements to be made, respectively.

To view previously saved experiments, click the History icon on the bottom strip of the 
Insight Pro Window.

5. After the Blank has been measured, the software will prompt for standards measurement.

6. Define the number of standards and load them.

7. Follow any instructions that appear for measuring standards and samples.

The Standard Curve(s) tab shows graphically the relationship between the standard curve, 
measured spectral intensity, and calculated concentration for the selected sample: A 
horizontal line connects the sample spectral intensity value on the Y-axis to the standard 
curve. A vertical line connects that point to the sample concentration value on the X-axis.

The Run Chart tab plots the concentration of the measured component versus sample 
number. If Use concentration limits was selected on the Samples tab, horizontal limit 
lines show whether the concentrations are within the specified limits:

To copy this plot, right-click it and choose Copy to Clipboard.
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The Data tab displays the acquired data (a fixed data point or scan spectrum) for the 
sample selected in the table. (Right-click the data to access commands for customizing the 
display, including adding annotation. See Data Display for more information.)

The table contains the columns of information specified on the Configuration tab in 
Reports. Examples include sample identification, user name, and the results of replicate, 
duplicate or triplicate measurements and their standard deviation.

The A280 value in the result table is the value using the absorbance at 750 nm as the 
baseline. The A280 value used to calculate the protein concentration takes into account 
the appropriate dye correction factors and any absorbance correction due to the selected 
analysis correction nm. Therefore, the displayed A280 value is not the value used to 
calculate the sample concentration.

To measure a sample again, right-click its row in the results table and choose Remeasure. 
After the remeasurement, the previous information for the sample is crossed out (but not 
removed from the table).
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DNA Melting

Overview

Application Settings

The follow tabs of settings are available:
Type Tab for DNA Melting
Measurement Tab for DNA Melting
Instrument Tab for DNA Melting
Accessories Tab for DNA Melting
Samples Tab for DNA Melting

Type Tab for DNA Melting

Use the DNA Melting application to determine the temperature at 
which a DNA sample denatures based on the change in absorbance as 
the temperature is increased.

As the temperature is increased, the electronic interactions between the 
DNA bases are modified and the entire absorption spectrum increases 
in intensity. This phenomenon is called the hyperchromic effect and 
the increase in absorption due to the abrupt change in structure is 
usually around 30–40%.

See Unique Screen Features for information about the DNA Melting 
data acquisition results. For information about the calculations, see 
DNA Melting Point Calculations.

To set data acquisition parameters for a DNA Melting workbook, click Settings.

Click Settings in DNA Melting to display the Type tab.
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These settings are available:

Measurement Tab for DNA Melting

Feature Description

Description Description of the template.

Rate Type Type of rate measurement to perform (see the table below). An 
image representing the selected type appears to the right. The 
required tabs also appear (click the Reset action button to step 
through them). These options are available:

• Single wavelength. For each sample, measures a specified 
wavelength at specified intervals of time.

• Multiple wavelengths. For each sample, measures multiple 
specified wavelengths at specified intervals of time. Up to 
40 wavelengths can be specified.

Mode Temperature is the only available option for the DNA Melting 
application. It performs rate measurements based on elapsed time 
and also records temperature settings.

Click Settings in DNA Melting to display the Measurement tab.
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These settings are available:

Feature Description

Integration Time How long the system acquires and averages data to obtain each data 
point at each measured wavelength for single and multicell 
experiments.

Dwell Time How long the sample remains in the light beam. Available for single 
and multicell experiments.

Use this setting to vary the number of data points collected per cell 
per cycle. Dwell time is always a multiple of integration time (see 
above). Dwell time can be very useful when performing multicell rate 
measurements. This is because the cell changer accessory will position 
a cell in the light beam for a specified period of time (dwell time), 
rather than moving back and forth between cells and increasing the 
time between measurements (when no sample is in the light beam).

For example, if the integration time is 0.1 second and dwell time is 
0.5 second, five data points will be recorded for each cell before the 
cell changer moves to the next cell. For fairly fast reactions, multiple 
samples can be measured, with over ten times as many data points 
acquired within a short time. This can improve the accuracy of rate 
calculations for faster multicell rate measurements.

Number of stages Defines the number of measurement cycles over which the frequency 
of data acquisition can be determined. For example, if a reaction has 
two components, the first component could be fast and require a high 
data density. The second component could be much slower and 
longer lived, therefore requiring a lower data density. Defining 
multiple stages enables the use of the proper data density over a given 
period of time.

Time Units Determines the time unit used in the stages table (see below).
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Temp Units Determines the temperature unit used in the stages table (see below).

Stages table Defines data acquisition for each stage of an experiment including the 
target temperature, ramp rate, hold type, hold time, interval and 
whether data collection will occur.

Note that the temperature in the final stage can be set to a value 
around 10 °C to simulate storage in a refrigerator. This feature allows 
proper storage conditions for the sample if DNA melting experiments 
will be completed when the instrument is unattended.

Target Temp: Enter a target temperature between 0.00 °C (32.00 °F 
or 273.15 K) and 110.00 °C (230.00 °F or 383.15 K).

Ramp Rate: Enter a ramp rate from 0.40 to 20.00 °C/min (0.72 to 
36.00 °F/min or 0.40 to 20.00 °K/min) up or down. Maximum ramp 
rate is 10 °C for both models.

Ramp rates are lower as the system approaches the hot or cold 
temperature limit.

Hold Type: Specify a pause at the target temperature before 
continuing to the next stage. Time holds for a specified time (see 
Hold Time below). Prompt holds until the operator responds to a 
message in the software. Trigger waits for an external trigger. 
Choosing Start in the trigger prompt will override the trigger.

Hold Time: When Hold Type is set to Time, enter the length of time 
to hold at the target temperature before continuing to the next stage.

Interval: Specifies how frequently a measurement is made. Must be 
equal to or greater than the specified Integration Time and less than 
the stage duration. Disabled when Collect Data (see below) is set to 
No.

Collect Data: Specifies whether to collect data during each stage.

Feature Description
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Instrument Tab for DNA Melting

These settings are available:

Accessories Tab for DNA Melting

Click Settings in DNA Melting to display the Instrument tab.

Feature Description

Data Mode Y-axis format for acquired data. Absorbance is the only available 
option for the DNA Melting application.

Bandwidth A larger spectral bandwidth increases the amount of energy that 
passes through the sample. Increasing the bandwidth can 
improve the signal-to-noise ratio; however, a larger spectral 
bandwidth decreases the ability to resolve closely spaced 
spectral features.

Reference Wavelength 
Correction

When selected, automatically acquires a reference measurement 
at a specified wavelength each time a sample measurement is 
taken. The reference measurement is then subtracted from the 
corresponding sample measurement to produce a corrected 
measurement result. Only the corrected result is reported.

Use the Reference wavelength box to specify a wavelength for 
the reference measurement.

Wavelength Summary Wavelengths to monitor during the reaction.

DNA Melting is typically performed at 260 nm for single 
wavelength measurements and at 260 nm and 280 nm for 
multi-wavelength experiments.

Click Settings in DNA Melting to display the Accessories tab. The available 
parameters depend on the installed accessories.
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The status of accessories can be monitored during measurements. See Instrument Status 
Monitors.

Samples Tab for DNA Melting

These settings are available:

Tm Calculations Tab for DNA Melting

Click Settings in DNA Melting to display the Samples tab.

Feature Description

Samples Number of samples in the analysis.

Base name Beginning of the name for sample spectra, to which a sequential 
number is appended. For example, the names of three sample spectra 
using the base name “dye” would be dye1, dye2 and dye3.

Load Samples For locating and selecting a .tsv (tab separated values) file or .csv 
(comma separated values) file containing sample names and 
descriptions, which are entered in the samples table.

Samples table Lists samples by their names and descriptions, up to a maximum of 
1000. To change a sample name, click its cell and edit the text. To 
enter or change text in a table cell, click it and type. To order the list 
by sample name or description, click the appropriate column heading.

If the table contains just one sample and data is acquired with an 
accessory that automatically changes samples, sample names are 
incremented.

Click Settings in DNA Melting to display the Tm Calculations tab.
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These settings are available:

Feature Description

Calculate Tm 
Values 
automatically at 
end of data 
acquisition

Calculates DNA melting point temperature (Tm) values automatically 
at the end of the experiment. When this option is selected, the entered 
temperature values are marked in the data display and the calculated 
Tm values appear in the sample measurements table after the 
measurement is completed. To modify the Tm settings, double-click 
the data display or choose Analyze (menu) > Tm Calculations.

When this option is cleared and Tm calculations have been entered, 
use the Modify Tm Calculations window to view, modify, update and 
accept the Tm calculation settings. After you accept the settings, the 
window closes and the temperature values are marked in the data 
display and the Tm values appear in the sample measurements table. 
See Making DNA Melting Measurements for more information.
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Tm Calculation Select a method for calculating DNA melting point temperature 
values. These options are available:

• Horizontal Intercept: Uses the absorbance at two specified 
temperature values and their horizontal intercepts to calculate 
Tm. Useful when absorbance does not vary with temperature 
outside the melting range.

• Sloping Intercept: Uses the absorbance at three specified 
temperature values and their sloped intercepts to calculate Tm. 
Select this option when the absorbance varies with temperature 
inside and outside the melting range.

• Inflection: Calculates the first derivative of the Absorbance vs 
Temperature curve. Tm is the temperature at which the first 
derivative curve has its maximum value (i.e., the slope).

For more information, see DNA Melting Point Calculations.

Temperature 1, 2, 3 Enter the temperatures required by the calculation method.

Horizontal Intercept. In the Temperature 1 box, enter a temperature 
value in °C from a horizontal section of the graph that occurs below 
the temperature range in which the DNA melting point occurs.

In the Temperature 3 box, enter a temperature value in °C from a 
horizontal section of the graph that occurs above the DNA melting 
range.

Sloping Intercept. In the Temperature 1 box, enter a temperature 
value in °C that occurs below the temperature range in which the 
DNA melting point occurs. (Choose a point where the slope is 
typical.)

In the Temperature 3 box, enter a temperature value in °C that occurs 
above the DNA melting range. (Again, choose a point where the slope 
is typical.)

In the Temperature 2 box, enter an intermediate temperature value in 
°C. (Choose a point that is close to t1 or t3).

Inflection. In the Temperature 1 box, enter a temperature value in °C 
that defines the start of the range used to calculate the derivative 
curve.

In the Temperature 3 box, enter the temperature value in °C that 
defines the end of the calculation range.

Feature Description
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Unique Screen Features

The spectral display shows data for the current sample. 

Making DNA Melting Measurements

DNA Melting measurements can be made at one wavelength or at up to 40 wavelengths in 
the same experiment. This includes multicell measurements, which allows running a 
fixed-wavelength measurement on several samples simultaneously using a sample changer.

Measurements are taken at specified intervals of time for each stage defined on the 
Measurements tab in Settings. Temperature settings and ramp rate are controlled and 
recorded for the duration of the experiment.

It may be helpful to display the following status monitors during your DNA Melting 
experiments:

• Cell Changer status

• Temperature Controller status

• Time status

• Temperature probe status

To make a DNA Melting measurement

1. From the Insight Pro Bio Methods Window, click DNA Melting.

2. A settings screen will appear. After configuring the sample run with the desired settings, 
click Continue.

3. Load a blank into the instrument, then click the  button to measure it.

4. Once the blank is measured, the  will become available. Click it to run the 
first sample.

Note  Run settings can be changed later, from the Display screen.
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More:

To view previously saved experiments, click the History icon on the bottom strip of the 
Insight Pro Window.

For each measured sample, the Data Display shows an absorption spectrum with the Y-axis in 
absorbance and the X-axis in either temperature or time. The data type can be toggled 
between Time and Temperature using the buttons above the right side of the data display.

Right-click in the data display to access commands for customizing the display, including 
adding annotation. See Data Display for more information.)

The samples table beneath the data display contains the columns of information specified on 
the Configuration tab in Reports.
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4

Insight Pro Software Database

Create an experiment
1. Select an application (Scan, for example) from the Insight Pro page.

2. The Settings screen will appear. Fill in the experimental parameters.

3. Click  to run a blank.

4. Click  to run a sample.

The experiment will be saved automatically and can be retrieved from History page

Open an experiment
Experiments are found under History in the Insight Pro Window - Bottom Ribbon. On the 
Experiments tab of the History page, the experiments can be sorted by Date, Experiment 
Name, Application, Created User, or Samples by clicking the title of the column.

The Search  feature allows search by experiment name, application and, time range.

Drop-down menus on the right allow sorting by time range or application type.
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1. On the Insight Pro page, select  from the bottom ribbon. The History page 
will open.

2. To open an experiment, double-click on the desired experiment row.

Sign a template
Templates are found under Templates in the Insight Pro Window - Bottom Ribbon. 
Templates can be sorted by Name, Group Name, Created User, Date, Application, or 
Description by clicking the title of the column. Templates can be sorted by time-range using 
the drop-down menu on the top right.

The Search  feature allows search by experiment name, application, and time range.
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1. On the Insight Pro page, select  from the bottom ribbon. The Templates 
page will open.

2. Select the template to be signed by marking the check-box in the leftmost column of the 
listed templates. 

3. With the desired template (or templates) checked, select Sign in  on the top right of 
the page.
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A dialog box will appear.

4. Under the Reason drop-down, select Authorship or Revision.

5. Enter the Password associated with your User Name, then click Save to sign the template 
or templates.

6. Select Cancel to close the dialog box without recording changes.
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Manage samples during measurement 

Save or load samples

Samples are saved automatically to History.

To load a previously run sample, go to History in the bottom ribbon of the Insight Pro page. 
Double-click on the sample you wish to load.

Manage samples within settings

In the application (Fixed, Scan, Quant, etc.) page, select  to bring up the Settings page for 
that application. Under the Samples tab, make desired changes. Click Continue to save the 
changes and return to the experiment.

Backup directories for templates, reports, and experiments 
Directories for Template Groups, PV reports, and experiments are not editable, but can be 
viewed in Settings under Preferences.

1. Select Settings from the bottom ribbon of the Insight Pro page.

2. Select the Preferences tab.

The Directories panel displays the default locations for storage. The locations are 
not editable.
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Manage standards during measurement
Save, load, or delete a standard during measurement.

Edit a standard

1. Choose an application (Quant for example) that supports Standard Setting from the 
Insight Pro page.

2. The Settings page will open. Choose the desired settings for the experiment.

3. Click Continue.

4. To access settings from within the data display screen, select  to bring up the 
Settings page.

5. Under the Standards tab, make desired changes.

6. Click Continue to save the changes and return to the experiment.

Load a standard

1. Choose an application (Quant for example) that supports Standard Setting from the 
Insight Pro page.

2. The Settings page will open. Choose the desired settings for the experiment.

3. Click Continue.

4. To load a standard curve from a previous experiment, select .

5. Select a standard to load from the list of standards. Use the search feature to find a 
specific standard.

6. Click Load to load the selected standard.
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Delete a standard

1. Choose an application (Quant for example) that supports Standard Setting from the 
Insight Pro page.

2. The Settings page will open. Choose the desired settings for the experiment.

3. Click Continue.

4. To access settings from within the data display screen, select  to bring up the 
Settings page.

5. Select the Standards tab.

6. To add or delete standards from a group, use the up and down arrows under the Standards 
heading in the Standards tab to increase or decrease the number of standards.

7. Enter the desired parameters for each standard, then click Continue.
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Manage baseline correction groups
1. Select the Scan application from the Insight Pro page.

1. Application Settings will open automatically.

2. Select the Measurement tab.

3. Select the Baseline Correction Type Standard reference correction with 0%R or 
0%T baseline.

A correction table displays.

4. Enter a Wavelength and Value. The table is saved automatically.

5. Enter the table name in the Name field. The new table name is automatically created.

6. Click  (kebab menu) that appears next to the group name when selected, then 
select Delete.



 4 Insight Pro Software Database
Import an experiment

Thermo Scientific Insight Pro Software User Guide 233

Import an experiment
To import an experiment: 

1. Select History from the Insight Pro page.

2. In the Experiments tab, select Import Experiments from  (kebab menu).

3. A file dialog window displays. Navigate to and select your file to import.

4. Select Open to import the experiment.

A dialog box confirms that the experiment imported successfully. If the experiment name 
is the same as an experiment already in use, the dialog box displays an error message. 
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Import a PV report
To import an experiment: 

1. Select History from the Insight Pro page.

2. In the PV Reports tab, select Import PV Reports from  (kebab menu).

3. A file dialog window displays. Navigate to and select your file to import.

4. Select Open to import the PV report.

A dialog box confirms that the report imported successfully. If the report name is the 
same as a report already in use, the dialog box displays an error message. 
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Import a template
To import a template: 

1. Select Templates from the Insight Pro page.

2. Select Import Templates from  (kebab menu).
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3. A file dialog window displays. Navigate to and select your file to import.

4. Select Open to import the template.

A dialog box confirms that the template imported successfully. If the template name is the 
same as a template already in use, the dialog box displays an error message. 
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Search experiments
Experiments are found under History in the Insight Pro Window - Bottom Ribbon. On the 
Experiments tab of the History page, the experiments can be sorted by Date, Experiment 
Name, Application, Created User, or Samples by clicking the title of the column.

The Search  feature allows search by experiment name, application and, time range.

Drop-down menus on the right allow sorting by time range or application type.

1. On the Insight Pro page, select  from the bottom ribbon. The History page 
will open.

2. To open an experiment, double-click on the desired experiment row.

Rename experiments
1. Select History from the Insight Pro page.

2. In the Experiments tab, double-click on the experiment you wish to change.

3. Enter a new name in the title field at the top of the page.
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Configure Your Database 
When you first install Insight Pro software, the default database is set up on the local device 
and ready to use. You can continue to use the local database or connect to a remote database 
in another location on your network. Use a remote database to easily share measurements, 
settings, and other data across devices.

Connect to a Remote Database 

Connect to a remote database to easily share measurements, settings, and other data across 
devices. Change your database configuration at any time to suit your work.

 To connect to a remote database 

1. Using the Insight Pro software, go to Settings and select the Data menu.

2. Select Configure from the Database list. The default selection is Local Database. To 
connect to a custom database, select the Remote database type, version, name, and port. 
You may also need to enter a username and password. 

Backup and restore the database

Backup

1. Select Settings from the bottom ribbon of the Insight Pro page.

2. Under the Data tab, select the Backup tab under Database Backup & Restore.
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3. Enter a storage location. Choose one of the following options. 

• Enter the file path of an empty folder into the Backup Location field.

• Browse to and select a storage location. 

i. Select Browse.

The Browse For Folder window displays.

ii. Navigate to the appropriate location.

iii. Select Make New Folder, then rename the folder.

Alternatively, select an existing empty folder. 

iv. Select OK. 

The file path displays in the Backup Location field in the Database Backup & 
Restore group.
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4. Select Backup.

A dialog box opens to indicate a successful backup. 

5. Select Continue.

Restore 

1. Select Settings from the bottom ribbon of the Insight Pro page.
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2. Under the Data tab, select the Restore tab under Database Backup & Restore.

3. Enter a storage location. Choose one of the following options. 

• Enter the file path of an empty folder into the Restore Location field.
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• Browse to and select a storage location. 

i. Select Browse.

The Browse For Folder window displays.

ii. Navigate to the appropriate location.

iii. Select Make New Folder, then rename the folder.

Alternatively, select an existing empty folder. 

iv. Select OK. 

The file path displays in the Restore Location field in the Database Backup & 
Restore group.

4. Select Restore.

A dialog box requests confirmation.



 4 Insight Pro Software Database
Software updates

Thermo Scientific Insight Pro Software User Guide 243

5. Select Continue to restore to your selected backup. 

Following restoration, a dialog box displays to indicate success.

6. Select Continue.

Software updates
The following features have been updated in the software. 

Feature Status

File > Save As Workbook… Removed

Active workbook library Removed from My Data  section

My favorite workbook library Removed from My Data  section

System default workbook library Removed from My Data  section

Example workbook library Removed from My Data  section
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Security Administration updates

The following security administration features have been updated in the software. 

Feature Status

Directory for workbooks Removed

Directory for template groups Removed

Directory for PV reports Removed

Prevent delete in file dialog boxes Removed

Prevent changing directories when saving files Removed

Prevent overwriting of files Replaced with Prevent 
overwriting 
Workbook\Template name

Ability to re-name workbooks Added

Ability to back up Database Added

Ability to restore Database Added

Signature verification when renaming a workbook Added a prompt

Audit log updates The following features are 
now tracked in Audit 
Manager software and added 
to the log file.

• Rename workbook

• Database backup

• Restore logs
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5

Performance Verification

Overview of PV

PV Test Descriptions
This section describes the performance tests that can be run manually if you have the required 
standards. The software supports two groups of tests:

• Thermo Scientific (PV tests recommended by Thermo Fisher Scientific for the 
Evolution One Series and Evolution Pro instruments)

• USP 2019 (United States Pharmacopeia, version 2019)

To run a PV test, select the test’s tab, enter any required information such as a wavelength or 
target value, then click Continue. Click the Run button to run the test. For some tests, the 
software may prompt for additional information after you click Run. Enter the information 
and click OK to start the test.

For descriptions of the PV tests in each test suite, see the table below.

Many of the tests described here may also be included in the CVC (Calibrated Validation 
Carousel) test suites. For information about the test samples included with each CVC and the 
corresponding test suite, the Calibrated Validation Carousels (CVCs) user guide refer to the to 
the CVC User Guide in the “Accessories” section or your documentation media.

Use Performance Verification to set up and run tests to check 
the performance of the instrument. Individual performance tests 
can be run manually or automatically using a compatible CVC 
(Calibrated Validation Carousel) accessory. For information about 
the available CVC configurations, refer to the CVC User Guide in 
the “Accessories” section or your documentation media.

Click here for information on running the performance tests. Test 
results are displayed in reports that are saved automatically and 
can be opened later.
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Test Name Thermo 
Scientific* USP**2019 EP Description

Wavelength 
Accuracy
(Hg lamp)

Locates the peaks from a mercury lamp accessory and 
displays their measured and allowed range of wavelengths. A 
mercury lamp has strong, fundamental lines throughout the 
UV-visible range. These emission lines are a property of the 
lamp and serve as a fundamental wavelength standard that 
does not require calibration. The wavelengths and tolerance 
values cannot be changed.

To run this test, use an empty cell holder and install the 
Mercury Lamp accessory properly in the instrument. For 
more information, refer to the documentation for the 
Mercury Lamp accessory.

Wavelength 
Repeatability
(Hg lamp)

Measures the ability of the spectrophotometer to return to an 
identical wavelength in a repeatable manner. The test uses a 
mercury lamp accessory, which has a strong, fundamental 
line near 546 nm. This emission line is an intrinsic property 
of the lamp and serves as a fundamental wavelength standard 
that does not require calibration. The wavelength and 
tolerance values cannot be changed.

To run this test, use an empty cell holder and install the 
Mercury Lamp accessory properly in the instrument. For 
more information, refer to the documentation for the 
Mercury Lamp accessory.

Spectral 
Bandwidth (1 nm, 
Hg Lamp)

This test scans across the 546.1 nm Hg emission line in 
intensity mode and computes the full width at half 
maximum (FWHM) of the peak. The FWHM of an atomic 
emission peak is the accepted measure of the spectral 
bandwidth of an instrument. It is called out explicitly in the 
United States Pharmacopoeia and is acceptable as a standard 
measurement under other regulatory regimes.

The test computes and reports the spectral bandwidth. To 
generate a pass/fail result, the measured value is compared to 
the tightest requirement for resolution found in a published 
pharmacopoeia. This is 1.8 nm, found in certain 
monographs of the Pharm. Eur. A Pass result in this test 
indicates that the instrument meets the resolution 
requirements of the United States, European and Chinese 
Pharmacopoeia.

There is no published specification for bandwidth accuracy 
for the Evolution spectrophotometers.
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Wavelength 
Accuracy
(Xe lamp)

Locates the peak near 542 nm of the internal xenon lamp 
and displays the measured and allowed range of wavelengths. 
A xenon lamp has strong, fundamental lines throughout the 
UV-visible range. These are an intrinsic property of the lamp 
and serve as a fundamental wavelength standard that does 
not require calibration. The wavelength and tolerance values 
cannot be changed.

To run this test, use an empty cell holder.

Wavelength 
Repeatability 
(Xe lamp)

Measures the ability of the spectrophotometer to return to an 
identical wavelength in a repeatable manner. The test uses 
the internal xenon lamp, which has a strong, fundamental 
emission line near 542 nm. This line is a property of the 
lamp and serves as a fundamental wavelength standard that 
does not require calibration. The wavelength and tolerance 
values cannot be changed.

To run this test, use an empty cell holder.

Wavelength 
Accuracy 
(Holmium glass, 
CP)

Locates the peaks of a holmium glass standard and displays 
their measured and allowed range of wavelengths as defined 
in the Chinese Pharmacopeia for this standard. The 
wavelengths and tolerance values are predefined and cannot 
be changed.

To run this test, install a holmium glass standard in the 
instrument.

Wavelength 
Accuracy
(Holmium oxide)

Locates the peaks of a holmium oxide standard and displays 
their measured and allowed range of wavelengths. A 
holmium oxide solution prepared in dilute perchloric acid 
has well defined absorption peaks throughout the UV-visible 
range. These peaks are a property of the material and serve as 
a wavelength standard. The wavelengths and tolerance values 
cannot be changed.

To run this test, install a holmium oxide liquid standard 
prepared in dilute perchloric acid.

Test Name Thermo 
Scientific* USP**2019 EP Description
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Wavelength 
Repeatability
(customized)

Measures the ability of the spectrophotometer to return to an 
identical wavelength in a repeatable manner using an 
appropriate standard. This test uses a standard of your 
choosing. For example, a holmium oxide solution prepared 
in dilute perchloric acid has well defined absorption peaks 
throughout the UV-visible range.

To run this test, install a wavelength repeatability standard 
and enter its wavelength, target absorbance and tolerance 
values in the boxes to the right of the test name. For more 
information, refer to the documentation that came with the 
standard.

Wavelength 
Accuracy and 
Repeatability 
(Holmium glass, 
Iterations #6)

Measures wavelength accuracy and repeatability using a 
holmium glass standard. The software detects the peaks that 
are called out in the USP standard six times. The mean and 
standard deviation values for each peak are calculated and 
reported.

To run this test, install a holmium glass standard in the 
instrument.

Wavelength 
Accuracy and 
Repeatability 
(Holmium 
solution, 
Iterations #6)

Measures wavelength accuracy and repeatability using a 
holmium solution standard. The software detects the peaks 
that are called out in the USP standard six times. The mean 
and standard deviation values for each peak are calculated 
and reported.

To run this test, install a holmium solution standard in the 
instrument.

Test Name Thermo 
Scientific* USP**2019 EP Description
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Wavelength 
Accuracy and 
Repeatability
(Didymium Glass
Iterations #6)

A wavelength accuracy test with a didymium standard is 
required under USP <857> only when the instrument will be 
used to measure samples at wavelengths greater that 640 nm. 
Both solution and glass standards are accepted and either 
may be used. It is never necessary to do both.

A calibrated didymium glass standard is supplied with the 
Validator IQ/OQ product available for purchase with the 
Evolution spectrophotometers.

This test requires an open cell position for the blank. It 
requests certificate values for four suitable peak positions to 
determine pass/fail.

Click in the box under each target wavelength and enter the 
position of the peak closest to this target value from the 
calibration certificate supplied with your standard.

Per the USP standard, the relevant wavelength range is 
scanned six times. The peaks are located and their positions 
are compared to the certificate locations entered by the user. 
The software then calculates the precision among these six 
measurements as the standard deviation.

The required margin of accuracy is ±2.0 nm in this 
wavelength range. The required precision is a standard 
deviation ≤0.5 nm.

Test Name Thermo 
Scientific* USP**2019 EP Description
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Wavelength 
Accuracy and 
Repeatability
(Didymium 
Solution,
Iterations #6)

A wavelength accuracy test with a didymium standard is 
required under USP <857> only when the instrument will be 
used to measure samples at wavelengths greater that 640 nm. 
Both solutions and glass standards are accepted and either 
may be used. It is never necessary to do both.

This test requires an open cell position for the blank. It uses 
literature values for the peak positions to determine pass/fail.

Per the USP standard, the relevant wavelength range is 
scanned six times. The peaks are located and their positions 
are compared to the expected locations published in USP 
<857>. The software then calculates the precision among 
these six measurements as the standard deviation.

The required margin of accuracy is ±2.0 nm in this 
wavelength range. The required precision is a standard 
deviation ≤0.5 nm.

Photometric 
Accuracy
(customized)

Automates the comparison of measured absorbance (or %T) 
of photometric accuracy standards with their certified values.

To run this test, install a photometric accuracy standard that 
has been calibrated to known absorbance values at specified 
wavelengths and enter its wavelength, target absorbance and 
tolerance values in the boxes to the right of the test name.

Test Name Thermo 
Scientific* USP**2019 EP Description
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Photometric 
Repeatability 
(customized)

Automates multiple absorbance measurements of a 
photometric repeatability standard at a user-entered 
wavelength and calculates the standard deviation of the 
measurements.

To run this test, obtain a photometric standard that has been 
calibrated to a known absorbance value at a specified 
wavelength. Enter the following in the boxes to the right of 
the test name:

• The wavelength at which you want to test (e.g., 440 nm)

• 0.000 as the Target (absorbance) value (no deviation is a 
perfect result)

• The specified tolerance value for photometric 
repeatability for the instrument and test:

– Thermo Scientific test suite: published 
instrument specification

– USP 2015 test suite: 0.005

Here is an example:

Photometric 
Accuracy
(K2Cr2O7)

Requires a potassium dichromate (K2Cr2O7) standard that 
has been calibrated to known absorbance values at specified 
wavelengths. The test automates the comparison of measured 
absorbance (or %T) of one or more K2Cr2O7 standards with 
their certified absorbance values.

After you start the test, the software prompts for the number 
of standards to be analyzed and, for each standard, the 
concentration value in mg/L and the certified absorbance 
value at each measured wavelength. Enter the information 
and then choose OK to continue the test.

Photometric 
Repeatability
(K2Cr2O7)

Uses the same test data as photometric accuracy test to 
deliver photometric repeatability.

Test Name Thermo 
Scientific* USP**2019 EP Description
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Photometric 
Accuracy 
(Visible). Multiple 
ND filters.

Requires a neutral density filter standard that has been 
calibrated to known absorbance values at specified 
wavelengths. This test automates the comparison of 
measured absorbance (or %T) of one or more neutral density 
standards with their certified absorbance values.

After you start the test, the software prompts for the number 
of standards to be analyzed and for each standard the 
certified absorbance value at each measured wavelength. 
Enter the information and then choose OK to continue the 
test. 

Photometric 
Repeatability 
(Visible). Multiple 
ND filters.

Uses the same test data as photometric accuracy test to 
deliver photometric repeatability.

Resolution
(Toluene/ 
Hexane), 1 nm

Measures the ability of the spectrophotometer to resolve 
adjacent features in a spectrum.

This test requires a 0.02% (v/v) solution of toluene in hexane 
and a hexane blank. The software prompts the operator to 
install the blank and test sample as needed to perform the 
test. The wavelengths and tolerance values cannot be 
changed.

Stray Light
• KCl, 198 nm
• KI, 220 nm
• NaI, 220 nm
• NaNO2, 

340 nm

Compares measured stray light at the indicated wavelength 
with the allowed range of values.

To run this test, install a stray light standard designed to 
measure stray light at one of the available wavelengths. The 
wavelength and tolerance values cannot be changed.

Stray Light
• Acetone, 

300 nm

Compares measured stray light at the indicated wavelength 
with the allowed range of values.

To run this test, install an acetone standard designed to 
measure stray light at 300 nm. The wavelength and tolerance 
values cannot be changed.

Test Name Thermo 
Scientific* USP**2019 EP Description
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Performing PV Tests
To perform PV tests

1. If using a CVC, install the CVC in the spectrophotometer sample compartment.

For information, the Calibrated Validation Carousels (CVCs) User Guide. refer to the to 
the CVC User Guide in the “Accessories” section or your documentation media

2. Click Performance in the Insight Pro Window - Bottom Ribbon.

Photometric 
Noise

• 0A (no filter)
• 1A filter
• 2A filter

Measures the amount of noise at a specific wavelength. The 
wavelength used depends on the instrument:

• Evolution One Series instruments: 260 nm

• Evolution Pro instrument: 500 nm

To run the 0A noise test, use an empty cell holder. For the 
latter two tests, use a 1A or 2A attenuation filter of the 
following type:

• For the Evolution One series instruments, use 
metal-on-quartz or screen filters that are suitable for the 
UV region.

• For the Evolution Pro model instrument, neutral density 
glass filters may be used.

Baseline Flatness
(Abs, 
800-200 nm)

Measures the flatness of a baseline scan over the region from 
800 nm to 200 nm with smoothing applied to the data.

To run this test, use an empty cell holder.

Photometric Drift Measures the absorbance drift of the instrument over a 
one-hour period.

To run this test, use an empty cell holder. Let the instrument 
warm up fully before initiating this test.

* Performance verification tests recommended by Thermo Fisher Scientific for these instruments
** United States Pharmacopeia

Test Name Thermo 
Scientific* USP**2019 EP Description

Note  Select the Classic group in Home if Performance Verification is not available 
for the current group.
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The available tests appear under three tab categories. If no CVC is installed, all of the tests 
described in the previous section will be available. If a compatible CVC is properly 
installed and a valid calibration file has been loaded, the Performance Verification screen 
will display the names of the performance tests that CVC is designed to run. Refer to the 
Calibrated Validation Carousels (CVCs) user guide for more information.

3. Select the tests to run.

To select or deselect all the available listed tests, click the Test Name checkbox above the 
column of check boxes.

4. For selected tests that require it, enter information such as wavelength, value, and 
tolerance in the provided boxes.

Heed the following precaution if using an accessory:

Languages

5. Click Continue.

Note  Tests that require the Mercury Lamp calibration accessory can be selected only 
after the accessory has been properly connected and installed in the instrument.

CAUTION  Avoid pinch hazard. If using a CVC accessory, keep hands and objects clear 
of the accessory during operation.

CAUTION  Évitez les risques de pincement. Éloignez les mains et les objets de l’accessoire 
pendant son fonctionnement.

CAUTION  Quetschungen sind zu vermeiden. Hände und Objekte sind während des 
Betriebs vom Zubehör fern zu halten.

CAUTION  Evitare il rischio di pizzicamento.Tenere mani e oggetti lontano dall’accessorio 
durante l’operazione.

CAUTION  Evite riesgos de atrapamiento. Mantenga manos y objetos alejados del accesorio 
durante el funcionamiento.

CAUTION  Evitare il rischio di pizzicamento. Le mani e altri oggetti devono essere tenuti 
lontani dagli accessori durante il funzionamento.

CAUTION  挟み込みの危険性を回避してください。操作中は手や物をアクセサリ
ーに近づけないようにしてください。
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6. Click the Run button to run the tests.

7. Follow the instructions that appear.

To end the tests before they are finished, click Stop. Alternatively, click Cancel when a 
prompt appears during a test.

The test results appear in a window. The test results can be printed or copied from the 
window. A signature block appears at the end.
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6

Insight Pro Security Software

Optional Insight Pro Security software adds features for Signing Experiments and Templates 
and verifying digital signatures, as explained in this document or Help system.

Insight Pro Security software, together with Thermo Security Administration software, also 
lets the system administrator set system policies and control user access to Insight Pro software 
features. See Access Control, System Policies, and Signature Meanings for complete 
information.

Getting Started with Insight Pro Security Software
The steps for setting up a secure system are outlined below. For more detailed instructions, 
read the indicated sections of the manuals on the documentation media for your 
spectrophotometer and Insight Pro software.

1. Set up Windows® administration including accounts, groups and other aspects of 
Windows administration—performed by the network administrator or system 
administrator. Include at least one user with full administrative rights and one with 
restricted rights. For more information, refer to the Getting Started with Security Suite 
Software guide.

2. Install Security Administration software and add Insight Pro Security software to the 
security database—performed by the system administrator or lab manager. Security 
Administration can be installed on the computer running Insight Pro Security software or 
on a computer that will be the server for Security Administration (recommended if 
multiple computers will run Insight Pro Security software).

To add the Insight Pro Security application to the security database:

a. Open the Security Administration program.

b. Choose File (menu) > Add Application.

c. Select the INSIGHT.XML file. The file is found on the Root directory of the 
software installation media.

NOTICE    You must install Security Administration software and associate Insight Pro 
Security software with it before running Insight Pro Security software for the first time.
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d. If you will be installing other add-on software such as CUE that require access 
control, repeat steps a through c to add their XML files (for example CUE.XML) to 
the security database.

e. Specify the location of the data storage folder. For more information, refer to the 
“Identify Data Storage Folder” of the Getting Started with Security Suite Software 
guide.

f. Restart the computer that has Insight Pro Security software installed, search for the 
server and then test the connection.

g. Start Insight Pro Security software and complete the hardware installation of the 
spectrophotometer. (If you are running workstation software, this step is not needed.)

3. Install Insight Pro Security Software on each computer that will be used to run Insight 
Pro software—performed by the system administrator or lab manager. Any other add-on 
software you purchased can also be installed at this time.

If you are using a network, after installing Insight Pro software, set the Thermo Fisher 
Scientific service accounts so that they are not running as local system accounts. Refer to 
the Getting Started with Security Suite Software guide for more information.

4. Set up Insight Pro software accounts and file permissions—performed by a system 
administrator or lab manager familiar with Insight Pro software. For more information, 
refer to the “Setting Security Features for Monitored Applications” chapter of the Security 
Administration User Guide and Access Control, System Policies, and Signature Meanings 
in this document.

Access Control, System Policies, and Signature Meanings
The Access Control features, System Policies and Signature Meanings described below are 
available in Security Administration for Insight Pro software when Insight Pro Security 
software is installed and added to the security database.

Use the Access Control and System Policy features to set the rights of individual users or 
groups of users to use the protected features of Insight Pro software (the features included in 
the security database). A protected feature will be available only if the logged-in user has the 
right to use it.

Use the Signature Meanings features to specify the meanings that will be available for 
electronic signatures for each user or user group. For example, the Signature Meanings can be 
set so that only a particular user—for instance, the lab manager—is allowed to sign a file with 
the “Approval” meaning.

To set access control features, system policies and signature meanings for Insight Pro

1. Start the Security Administration program.

2. Open the Access Control folder for Insight Pro by clicking its plus sign.
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A tree of folders and other items appears. Each item in the tree represents a protected 
function or group of functions for which access control is available.

3. Click a feature to display options for controlling access to that feature. For more 
information about a feature, see Table 1.

4. Open the System Policies folder for Insight Pro by clicking its plus sign.

A tree of icons appears. Each icon in the tree represents a system policy or group of 
policies; that is, operations for which access control is available.

5. If a check box appears to the left of a policy, you can specify whether it is selected or not 
selected for different “policy groups.” A policy group is a group of users for whom you can 
set system policies. For more information, refer to the “Set System Policies for Security 
Suite Application” chapter of the Security Administration User Guide. Other policies let 
you specify system attributes such as a default configuration or default directory.

6. Open the Signature Meanings folder for Insight Pro by clicking its plus sign.

The first time Security Administration is run, the default list of signature meanings 
appears. See Table 1 for descriptions of the default signature meanings for Insight Pro 
software.

7. Click a signature meaning in the list to display information about its access rights. If a 
check mark appears to the left of a listed user group, those users can select that signature 
meaning when signing a file.

If changes have been made to the list, the available meanings in Insight Pro software may 
be different. Refer to the “Assign Signature Meanings to Security Suite Applications” 
chapter of the Security Administration User Guide for more information.

8. When you are finished setting access options for all features and policies, choose File > 
Save to save the settings in the security database.

For more information, refer to the “Saving Your Security Settings” chapter of the Security 
Administration User Guide.

Note  If a client application was running while you used Security Administration to 
change its security policy settings, the new settings will not take effect until the 
application is exited and restarted.
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The table below describes Insight Pro access control features.

Table 1. Insight Pro Access Control Features

Feature Description

Ability to run Insight Pro Specifies which users can run Insight Pro software. (See 
“Controlling access to client application features” in the 
“Using Security Administration” chapter of the Security 
Administration User Guide for general instructions.) If a user 
has not been granted the ability to run the software, an error 
message appears when the user attempts to start it.

Ability to edit templates Specifies which users can set parameters in Settings.

Ability to edit samples on 
locked template

Specifies which users can edit parameters in Samples.

Ability to configure reports Specifies which users can change settings in Reports.

Ability to delete 
experiments

Specifies which users can delete experiment files using the 
Delete button in My Data.

Ability to delete PV reports Specifies which users can delete Performance Verification 
reports using the Delete button in My Data.

Ability to delete templates Specifies which users can delete template files using the Delete 
button in My Data. 

Ability to re-measure 
samples

Specifies which users can access the Remeasure command in 
the right-click menu for a list of measured samples in Insight 
Pro software.

Ability to edit sample name Specifies which users can edit the sample name in Insight Pro 
software.

Ability to use Live Display Specifies which users can access the controls in the 
Measure Live Display screen in Insight Pro software.

Ability to merge 
experiments

Specifies which users can access the Merge Experiments 
command in the File menu of Insight Pro software.

Ability to perform PV tests Specifies which users can run Performance Verification tests.

Ability to perform 
wavelength calibration

Specifies which users can use the Wavelength Calibration 
buttons on the Calibrations tab in System Settings.

Ability to calibrate Sipper Specifies which users can use the Sipper Calibrate button on 
the Calibrations tab in System Settings.

Ability to calibrate Linear 
Cell Changer

Specifies which users can use the Linear Cell Changer 
Calibrate button on the Calibrations tab in System Settings.

Ability to update CVC 
calibration

Specifies which users can use the Load CVC Calibration 
button in Performance Verification.
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The table below describes Insight Pro system policies.

Ability to select CVC tests 
to perform in PV

Specifies which users can select listed tests for the CVC in 
Performance Verification.

Math menu Specifies which users can use the commands in the Math 
menu.

Analyze menu Specifies which users can use the commands in the Analyze 
menu.

Accessory Settings
- Ability to edit 
temperature device settings

When an accessory that includes a heater that can be 
controlled by Insight Pro software is installed, this policy 
specifies which users can edit the temperature device settings 
on the Accessories tab.

Accessory Settings
- Ability to edit Sipper 
settings

When a Sipper accessory that can be controlled by Insight Pro 
software is installed, this policy specifies which users can edit 
the Sipper settings on the Accessories tab.

Accessory Settings
- Ability to edit cell changer 
settings

When a cell changer accessory that can be controlled by 
Insight Pro software is installed, this policy specifies which 
users can edit the cell changer settings on the Accessories tab.

Options tabs Specifies which users can change settings on the tabs in 
Options.

System Settings tabs Specifies which users can change settings on the tabs in 
System Settings.

Table 2. Insight Pro System Policies

Feature Description

Authenticate on startup Requires users in the specified policy groups to enter a valid 
name and password when starting Insight Pro software.

Prevent overwriting 
Experiment\Template 
name 

Ensures that existing files are not overwritten when users in 
the specified policy groups save experiment or template files.

If a user for whom this policy is selected attempts to save a file 
using the same file name as an existing file, a message says the 
file cannot be overwritten. The user can choose OK to close 
the message and then save the file using a different file name.

If a user saves a file while this policy is selected, the file will be 
set to read-only in its properties. In the future, users will not 
be able to overwrite this file, even when this policy is not 
selected.

Table 1. Insight Pro Access Control Features

Feature Description
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Prevent printing unsaved 
data

Prevents users in the specified policy groups from printing 
spectral data that has not been saved.

Prevent signature reason 
entry when signing file

Prevents users in the specified policy groups from entering a 
custom signature meaning when signing a file.

When this policy is selected, only the standard signature 
meanings are available for the affected users.

When this policy is not selected, the prompt requesting a 
signature lets the user type a meaning in the Reason For 
Signature text box.

Prevent cancellation of 
signature

Disables the Cancel button in the Sign File dialog box, which 
requires the user to sign the file in order to complete the 
previous operation.

Prompt for signature when 
saving experiment files

Requires users in the specified policy groups to provide a 
digital signature when saving experiments with Save 
Experiment or Save As Experiment in the File menu. If this 
policy is not selected, users in the specified policy group must 
use Security (menu) > Sign > Active Experiment or 
Experiment File to sign an experiment after it has been saved.

Prompt for signature when 
saving template files

Requires users in the specified policy groups to provide a 
digital signature when saving templates with Save Experiment 
Settings as Template in the File menu. If this policy is not 
selected, users in the specified policy group must use Security 
(menu) > Sign > Template File to sign an experiment after it 
has been saved.

Prompt for signature when 
saving PV reports

Requires users in the specified policy groups to provide a 
digital signature when saving Performance Verification results.

Require all samples to 
appear in report

Automatically selects results for all acquired samples in the 
sample list on the Samples tab in Reports.

Require all measurements 
to be saved

Before the first sample can be measured, prompts the operator 
to select or create an experiment where the data will be 
automatically saved. (Disables the Cancel button in the Enter 
Experiment Filename box.)

Table 2. Insight Pro System Policies

Feature Description
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The signature meanings in the default list for Insight Pro software are described below.

Prevent canceling a data 
collection

Disables the dialog box options that allow users to exit an 
operation without saving acquired data.

Allow access only to listed 
button groups (blank field 
allows access to all groups)

Specifies the Insight Pro software user groups that are available 
to users in the specified policy group. Selecting a user group in 
Home displays the application buttons for that group. See 
Applications Tab for more information.

Type the desired user groups in the text box in the Description 
box, with a comma and a space between them; for example:

Classic, Quality Control

In this example, these users would have access to the 
applications for the Classic group (Fixed, Scan, Quant, 
Kinetics, and Performance Verification) and the applications 
for the Quality Control group.

Leave the text box blank to give users in the specified policy 
group access to all applications.

Table 3. Insight Pro Signature Meanings

Signature Meaning Description

Authorship - signifies ownership Indicates that the user signing the file is the person who 
created it.

Approval - the record is 
approved for use

Indicates that the user signing the file has approved it for 
use.

Reviewed - record contents have 
been reviewed

Indicates that the user signing the file has reviewed it.

Revision - the record has been 
revised

Indicates that the user signing the file has changed it.

Note  Users can be allowed to enter custom signature meanings. See “Prevent signature 
reason entry when signing files” in Access Control, System Policies, and Signature 
Meanings for details.

Table 2. Insight Pro System Policies

Feature Description
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Event Logging
The Security Suite generates an audit trail of activities with your instruments and software. It 
records Security Administration and instrument application operations, or “events” in a secure 
database. Use the Audit Manager to view logged security events and create reports of specific 
event types or time frames or from specific users. Logged events include information like the 
data and time, the instrument application, the type of event, and the user. By recording this 
information, the Security Suite helps you support the audit trail requirements of 
21 CFR Part 11.

To start the Audit Manager, Click the Audit Manager program in the Windows Start menu. 
The Audit Manager main window contains a log of tracked events. You can easily configure 
the audit log to show specific event types or time frames or events from specific users, and 
then save, sign, and print the list as a report.

For more information see the Setting Up Audit Manager Software with Security Suite guide and 
the Audit Manager User Guide.

Audit log
1. Add new audit log for database records

2. Remove audit log related to files 

3. Update Security Suite application file for Insight Pro, 

Thermo Scientific File Monitor Service no longer monitors file changes in 
experiment\template\PV report folders.

Sample History Information
To access information about a data point or spectrum, open the experiment, right-click its 
row in the sample measurements table and choose Properties. Click the tabs along the top of 
the Sample Properties window to see information about the sample, the instrument and any 
accessories that were used to collect the data, and any electronic signatures that were applied.



 6 Insight Pro Security Software
Insight Pro Security Software Icons

Thermo Scientific Insight Pro Software User Guide 265

Insight Pro Security Software Icons

To see information about the signature status of the current experiment, click any of these 
icons.

When Insight Pro Security software is installed...

• The root directory for template groups shown on the Preference tab in Options is set 
using Thermo Security Administration.

• A Sign button appears in the Performance Verification report window. Use it to sign the 
displayed report.

Signing Experiments and Templates
If Insight Pro Security Software is installed, use the following procedures to digitally sign 
experiment and template files. The visible portion of a digital signature consists of a user 
name, a date and a stated reason for signing. A digital signature also contains encrypted 
information used to detect whether the file has changed since it was signed.

Sign an experiment
1. Select Security > Sign > Workbook….

This icon at the bottom of the Insight Pro window indicates that the current 
experiment is signed.

This icon indicates that current experiment has not been signed since it was last 
changed.

This icon indicates that current experiment has not been saved (or signed).
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A dialog box displays a list of experiments.

2. Select an experiment item, then click OK to perform an electronic signature.

3. Select Cancel to close the dialog box.

Sign a template
1. Select Security > Sign > Template….
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A dialog box displays a list of templates.

2. Select a template item, then select OK to perform a signature.

3. Select Cancel to close the dialog box.



6 Insight Pro Security Software
Sign a template

268 Insight Pro Software User Guide Thermo Scientific

This page is intentionally blank.


	Contents
	Introduction
	Overview
	Setting Up the Instrument
	About This Document
	Organization
	Conventions Used in this Document

	Insight Pro Software
	The Insight Pro Window - Classic View
	Applications
	Fixed
	Scan
	Quant
	Live Display
	Kinetics

	The Insight Pro Window - Bio Methods
	Insight Pro Window - Bottom Ribbon
	Settings Page
	Application Window
	Instrument Status Monitors

	Thermo Software IQ
	Operation
	Acquiring Data using Live Display
	Performing Fixed Measurements
	Performing Scan Measurements
	Performing a Quantitative Analysis
	Performing a Kinetics Measurement
	Adding Custom Calculations
	Using the Palette Tools and View Finder
	Setting Application Parameters
	Configuring a Report
	Exporting Data
	Managing Data
	Math and Analysis Operations

	System Settings
	Applications Tab
	Reports Tab
	Preferences Tab
	Data Tab
	Formulas & Units Tab
	Dye List

	Calibration
	Alignment Tab
	Calibrations
	Settings

	Keyboard Shortcuts

	Insight Pro Bio Applications
	About the Bio Applications
	Nucleic Acid Assays
	Protein Assays

	Nucleic Acid
	Overview
	Nucleic Acid Concentration Calculations
	Application Settings
	Unique Screen Features
	Making Nucleic Acid Measurements
	Oligo Calculator

	Nucleic Acid Labels
	Overview
	Application Settings
	Unique Screen Features
	Making Nucleic Acid Labels Measurements
	Oligo Calculator

	Protein A280
	Overview
	Application Settings
	Unique Screen Features
	Making Protein A280 Measurements

	Proteins & Labels
	Overview
	Application Settings
	Unique Screen Features
	Making Proteins and Labels Measurements

	Pierce BCA
	Overview
	Application Settings
	Unique Screen Features
	Making Pierce BCA Measurements

	Protein Bradford
	Overview
	Application Settings
	Unique Screen Features
	Making Protein Bradford Measurements

	Pierce Modified Lowry
	Overview
	Application Settings
	Unique Screen Features
	Making Pierce Modified Lowry Measurements

	Pierce 660 nm Protein Assay
	Overview
	Application Settings
	Unique Screen Features
	Making Pierce 660 nm Protein Assay Measurements

	Protein Biuret
	Overview
	Application Settings
	Unique Screen Features
	Making Protein Biuret Measurements

	DNA Melting
	Overview
	Application Settings
	Unique Screen Features
	Making DNA Melting Measurements


	Insight Pro Software Database
	Create an experiment
	Open an experiment
	Sign a template
	Manage samples during measurement
	Save or load samples
	Manage samples within settings

	Backup directories for templates, reports, and experiments
	Manage standards during measurement
	Edit a standard
	Load a standard
	Delete a standard

	Manage baseline correction groups
	Import an experiment
	Import a PV report
	Import a template
	Search experiments
	Rename experiments
	Configure Your Database
	Connect to a Remote Database

	Backup and restore the database
	Backup
	Restore

	Software updates
	Security Administration updates


	Performance Verification
	Overview of PV
	PV Test Descriptions
	Performing PV Tests

	Insight Pro Security Software
	Getting Started with Insight Pro Security Software
	Access Control, System Policies, and Signature Meanings
	Event Logging
	Audit log
	Sample History Information
	Insight Pro Security Software Icons
	Signing Experiments and Templates
	Sign an experiment
	Sign a template


